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General Information
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ror [
"g_b-t The information on these pages also is located in the Universal Controller 7.2.x General Information.pdf and the Universal Controller 7.2.x Troubleshooting and Tutorials.pdf.
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Universal Controller - Overview

Introduction

Application Container

Database

Universal Message Service (OMS)
Command Line Interface (CLI)

Introduction

Universal Controller, a Java web application running in a Tomcat web container, is the enterprise job scheduler and workload automation broker solution of Universal Automation Center. The Controller presents
a user interface for creating, monitoring, and configuring Controller information; handles the scheduling logic; processes all messages to and from Universal Agents; and synchronizes much of the High
Availability operation of Universal Automation Center.

Each instance of a Controller in a Universal Automation Center environment is referred to as a cluster node. A High Availability (redundant system) environment contains two or more cluster nodes.

Application Container

The application container is third-party software that serves as a container for the Controller. Universal Controller uses Apache Tomcat as the application container.

Database

The database management component supports SQL queries to a set of tables in the Controller database.
The following databases are supported:

® Oracle 12c (Release 2), 18c, 19c, and 21c
® MS SQL Server 2012, 2014, 2016, 2017, 2019
® MySQL 5.7.x, 8.0.x

Universal Message Service (OMS)
Universal Message Service (OMS) is the network communications provider between the Controller and Agent(s).

Note
1
OMS replaces the Message Hub and Transporter components of pre-5.2.0 releases of the Universal Automation Center.

OMS is installed as a component of Universal Agent for Windows and UNIX.

Command Line Interface (CLI)
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https://docs.stonebranch.com/confluence/display/UAC72/Universal+Automation+Center+7.2.x
https://docs.stonebranch.com/confluence/display/UA72/Universal+Command+Overview
https://docs.stonebranch.com/confluence/display/UC73/High+Availability
https://docs.stonebranch.com/confluence/display/UC73/High+Availability
https://docs.stonebranch.com/confluence/display/UC73/Cluster+Nodes
https://docs.stonebranch.com/confluence/display/UC73/Installing+Apache+Tomcat
https://docs.stonebranch.com/confluence/display/UC73/Installing+a+Database
https://docs.stonebranch.com/confluence/display/UA72/Universal+Message+Service+%28OMS%29+7.2.x+Reference+Guide
https://docs.stonebranch.com/confluence/display/UA72/Universal+Agent+7.2.x+Installation%2C+Upgrade%2C+and+Applying+Maintenance
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The Universal Controller Command Line Interface (CLI) is implemented as a set of commands that perform specific actions in a Controller. The CLI commands can execute on any system that has TCP/IP
connectivity to OMS. The results of the action are printed to the CLI commands standard output.

The CLI is installed as a component of Universal Agent for z/OS, Windows, and UNIX.
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Universal Controller - Directory Structure

Directory Structure

Shown below is the directory structure of Universal Controller.

UNIX

$CATALI NA_HOVE/

$CATALI NA_HOVE/ bi n

$CATALI NA_HOVE/ conf

$CATALI NA_HOVE/ | i b

$CATALI NA_HOVE/ | ogs

$CATALI NA_HOVE/ uc_backup/ Syst em Backups

$CATALI NA_HOME/ uc_backup/ Syst em Backups/ Activity
$CATALI NA_HOMWE/ uc_backup/ Syst em Backups/ Audi t
$CATALI NA_HOVE/ uc_backup/ Syst em Backups/ Hi story
$CATALI NA_HOVE/ uc_export

$CATALI NA_HOME/ uc_i mages

$CATALI NA_HOMVE/ uc_| ogs

$CATALI NA_HOVE/ webapps

$CATALI NA_HOVE/ webapps/ uc

Windows

$CATALI NA_HOVE\

$CATALI NA_HOVE\ bi n

$CATALI NA_HOME\ conf

$CATALI NA_ HOVE\ | i b

$CATALI NA_HOVE\ | ogs

$CATALI NA_HOME\ uc_backup\ Syst em Backups

$CATALI NA_HOME\ uc_backup\ Syst em Backups\ Activity
$CATALI NA_HOME\ uc_backup\ Syst em Backups\ Audi t
$CATALI NA_HOME\ uc_backup\ Syst em Backups\ Hi story
$CATALI NA_HOME\ uc_expor t

$CATALI NA_HOME\ uc_i nages

$CATALI NA_HOME\ uc_| ogs

$CATALI NA_HOME\ webapps

$CATALI NA_HOVE\ webapps\ uc
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Setting up Universal Controller

The following table provides a guideline for setting up Universal Controller. It is a checklist of features and functions, including links to the detailed information and instructions on this website.

Perform Pre-installation Procedure
Download Universal Controller Distribution File

Install Universal Controller

Configure Universal Controller

Log in to Universal Controller

Configure Password Settings

Set up Security

LDAP and SAML

Define Resources

Create Tasks and Workflows

Create Universal Templates and Universal Tasks

Create Task Triggers

Manually Run and Control Tasks
Create and Run Reports

Monitor Operations
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Perform the pre-installation procedure that is required before installing the Controller.
Download the appropriate Universal Controller distribution file from the Stonebranch Customer Portal.

Install the Controller package from the downloaded Controller distribution file. See Universal Controller Installation for help in getting the Controller
installed and verified.

After installation, check the Universal Controller properties. If you will be running the Controller in a High Availability environment, you must configure
the Controller for High Availability.

Once the Controller is installed and configured, we recommend that you log in and familiarize yourself with the basic features of the user interface. All
Controller functions are accessed from the Services. Within the user interface, you will create all your records (for example: users, tasks, and triggers)
by entering information into record Details. (See Naming Tips for information on organizing your records.) The records are then displayed in lists of
each type, which you can sort and filter and perform a wide variety of other functions.

Before you create users for Universal Controller, configure the settings for all user passwords.

Use the Controller Security feature to create users and user groups and assign them roles and permissions. You can also define credentials that are
used by the Controller to log in to remote machines. You can create Business Services that represent your organization and assign Controller records
to them, and assign permission only to users and/or user groups that belong to a specific Business Services. A complete audit history of all Controller
activity also is available for regulatory compliance.

Specify LDAP Settings, which allow you to enable the LDAP bridge for both UNIX and Windows operating systems, and Single Sign-On Settings,
which allow you to pre-authenticate users to a third-party identity provider.

Define the types of resources that you will need in your operational database. If you have installed Universal Agent on any machines, records for

each of them are automatically created when they connect to the Controller. You also may need to define one or more resources, such as email, data
base, PeopleSoft, and SAP connections, as well as SNMP Managers. You also can create status-based notifications for Agent, Cluster Node, and OM
S Server resources. You can set up a throttling scheme for your machines using Virtual Resources and create scripts that you can execute on remote
machines.

Once you have your resources in place, you can begin creating tasks. Supported task types are Workflows, Linux/Unix, Windows, z/OS, Universal
Command, SAP, PeopleSoft, File Transfer, Manual, Timer, SQL, Stored Procedure, Email, Web Service, Recurring, Task Monitor, Agent File Monitor,
Remote File Monitor, FTP File Monitor, System Monitor, Variable Monitor, Email Monitor, Application Control, and Universal.

In order to design your own Integrations, you first must create the Universal Templates on which the Universal Tasks are based.

To run your tasks outside of workflows, you can create task triggers, which define events, conditions, or dates/times that the tasks will run. Trigger
types include Cron, Time, Temporary, Manual, File Monitor, Task Monitor, Variable Monitor, Email Monitor, Application Monitor, and Composite. You
may also need to set up one or more customized calendars that reflect your fiscal year and holiday schedules, and custom days for those calendars.

You also may need to manually run and control tasks, either from the user interface, the command line, or the API.
The Report Details feature lets you create reports from a variety of Universal Controller database tables. You can use a report to create a Widget.

You will monitor your automated operations from the Activity Monitor, which you can customize using Filters.


https://docs.stonebranch.com/confluence/display/UC73/Pre-Installation+Procedure
https://docs.stonebranch.com/confluence/display/UC73/Downloading+Universal+Controller+Software
https://stonebranch.zendesk.com/hc/en-us
https://docs.stonebranch.com/confluence/display/UC73/Universal+Controller+Installation
https://docs.stonebranch.com/confluence/display/UC73/Properties
https://docs.stonebranch.com/confluence/display/UC73/High+Availability
https://docs.stonebranch.com/confluence/display/UC73/High+Availability#HighAvailability-HighAvailabilityConfiguration
https://docs.stonebranch.com/confluence/display/UC73/Records#Records-NamingTips
https://docs.stonebranch.com/confluence/display/UC73/Users+and+Groups#UsersandGroups-AddingUsers
https://docs.stonebranch.com/confluence/display/UC73/Password+Settings
https://docs.stonebranch.com/confluence/pages/createpage.action?spaceKey=UC72x&title=Security
https://docs.stonebranch.com/confluence/display/UC73/Users+and+Groups#UsersandGroups-AddingUsers
https://docs.stonebranch.com/confluence/display/UC73/Users+and+Groups#UsersandGroups-AddingGroups
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-AssigningRolestoUsersorGroups
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-AssigningPermissionstoUsersorGroups
https://docs.stonebranch.com/confluence/display/UC73/Credentials
https://docs.stonebranch.com/confluence/display/UC73/Business+Services
https://docs.stonebranch.com/confluence/display/UC73/Audits
https://docs.stonebranch.com/confluence/display/UC73/LDAP+Settings
https://docs.stonebranch.com/confluence/display/UC73/Single+Sign-On+Settings
https://docs.stonebranch.com/confluence/pages/createpage.action?spaceKey=UC72x&title=Resources
https://docs.stonebranch.com/confluence/display/UC73/Agents+Overview
https://docs.stonebranch.com/confluence/display/UC73/Email+Connections
https://docs.stonebranch.com/confluence/display/UC73/Database+Connections
https://docs.stonebranch.com/confluence/display/UC73/Database+Connections
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Connections
https://docs.stonebranch.com/confluence/display/UC73/SAP+Connections
https://docs.stonebranch.com/confluence/display/UC73/SNMP+Managers
https://docs.stonebranch.com/confluence/display/UC73/Agents+Overview#AgentsOverview-SendingNotificationsonStatusofanAgent
https://docs.stonebranch.com/confluence/display/UC73/Cluster+Nodes#ClusterNodes-SendingNotificationsonStatusofaClusterNode
https://docs.stonebranch.com/confluence/display/UC73/OMS+Servers#OMSServers-SendingNotificationsonStatusofanOMSServer
https://docs.stonebranch.com/confluence/display/UC73/OMS+Servers#OMSServers-SendingNotificationsonStatusofanOMSServer
https://docs.stonebranch.com/confluence/display/UC73/Virtual+Resources
https://docs.stonebranch.com/confluence/display/UC73/Scripts
https://docs.stonebranch.com/confluence/display/UC73/Creating+Tasks
https://docs.stonebranch.com/confluence/display/UC73/Creating+and+Maintaining+Workflows
https://docs.stonebranch.com/confluence/display/UC73/Linux+Unix+Task
https://docs.stonebranch.com/confluence/display/UC73/Windows+Task
https://docs.stonebranch.com/confluence/pages/viewpage.action?pageId=95696823
https://docs.stonebranch.com/confluence/display/UC73/Universal+Command+Task
https://docs.stonebranch.com/confluence/display/UC73/Universal+Command+Task
https://docs.stonebranch.com/confluence/display/UC73/SAP+Task
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Task
https://docs.stonebranch.com/confluence/display/UC73/File+Transfer+Task
https://docs.stonebranch.com/confluence/display/UC73/Manual+Task
https://docs.stonebranch.com/confluence/display/UC73/Timer+Task
https://docs.stonebranch.com/confluence/display/UC73/SQL+Task
https://docs.stonebranch.com/confluence/display/UC73/Stored+Procedure+Task
https://docs.stonebranch.com/confluence/display/UC73/Email+Task
https://docs.stonebranch.com/confluence/display/UC73/Web+Service+Task
https://docs.stonebranch.com/confluence/display/UC73/Recurring+Task
https://docs.stonebranch.com/confluence/display/UC73/Task+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Agent+File+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Remote+File+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Remote+File+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/System+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Variable+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Email+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Application+Control+Tasks
https://docs.stonebranch.com/confluence/display/UC73/Integrations
https://docs.stonebranch.com/confluence/display/UC73/Integrations
https://docs.stonebranch.com/confluence/display/UC73/Universal+Templates
https://docs.stonebranch.com/confluence/display/UC73/Triggers+Overview
https://docs.stonebranch.com/confluence/display/UC73/Cron+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Time+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Temporary+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Manual+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Agent+File+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Task+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Variable+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Email+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Application+Monitor+Triggers
https://docs.stonebranch.com/confluence/display/UC73/Composite+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Calendars+Overview
https://docs.stonebranch.com/confluence/display/UC73/Creating+Custom+Days
https://docs.stonebranch.com/confluence/display/UC73/Manually+Running+and+Controlling+Tasks
https://docs.stonebranch.com/confluence/pages/viewpage.action?pageId=95694562
https://docs.stonebranch.com/confluence/display/UC73/RESTful+Web+Services+API
https://docs.stonebranch.com/confluence/display/UC73/Report+Details
https://docs.stonebranch.com/confluence/display/UC73/Widgets#Widgets-ReportWidgets
https://docs.stonebranch.com/confluence/display/UC73/Monitoring+Activity+from+the+Activity+Monitor
https://docs.stonebranch.com/confluence/display/UC73/Filters
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Dashboards

Monitor and Control Applications

Command Line Interface (CLI) and API

Manage Data and Audit Records

Help and Support
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The Home Dashboard, a system-defined Dashboard that displays when you log in to the Controller, provides details about the Controller system and
status information on active task instances, Agents Overview, Cluster Nodes, and OMS Servers]. You also can create your own Dashboard Details
that display information about the Controller, its environment, and the jobs it is running as defined in system-provided and user-defined Widgets.

The Controller lets you to monitor and control all of the applications that you may have running in your entire network.

In addition allowing you to manually run and control tasks, you also can monitor and control your operations and perform basic administrative
functions from the command line or the API.

Comprehensive utilities are provided that allow you to manage your Controller records. You can view, restore, and purge old versions of Controller
records, bundle and promote records from one Controller server to another, and export and import records when performing a Controller upgrade.
You also can configure the automatic backup and purge of Controller data.

This documentation website provides information to help you install, configure, and use the Controller; see Documentation Help for information on
documentation layout and usage. Step-by-step tutorials are available for many of the features and functions described here. Troubleshooting provides
a description of error messages that you could encounter, as well as potential problems and solutions. Technical Support for critical and non-critical
problems is always available.


https://docs.stonebranch.com/confluence/display/UC73/Home+Dashboard
https://docs.stonebranch.com/confluence/display/UC73/Dashboard+Details
https://docs.stonebranch.com/confluence/display/UC73/Displaying+Task+Instance+Status
https://docs.stonebranch.com/confluence/display/UC73/Agents+Overview
https://docs.stonebranch.com/confluence/display/UC73/Cluster+Nodes
https://docs.stonebranch.com/confluence/display/UC73/Dashboard+Details
https://docs.stonebranch.com/confluence/display/UC73/Widgets
https://docs.stonebranch.com/confluence/display/UC73/Application+Monitoring+and+Control
https://docs.stonebranch.com/confluence/display/UC73/Application+Resources
https://docs.stonebranch.com/confluence/pages/viewpage.action?pageId=95694562
https://docs.stonebranch.com/confluence/display/UC73/RESTful+Web+Services+API
https://docs.stonebranch.com/confluence/display/UC73/Records#Records-RecordVersioning
https://docs.stonebranch.com/confluence/display/UC73/Bundles+and+Promotion+Overview
https://docs.stonebranch.com/confluence/display/UC73/Records#Records-ImportingandExportingRecords
https://docs.stonebranch.com/confluence/display/UC73/Data+Backup+-+Purge
https://docs.stonebranch.com/confluence/display/SMLRI/Documentation+Help
https://docs.stonebranch.com/confluence/display/SMLRI/Stonebranch+Product+Technical+Support

Universal Controller 7.3.x General Information

Licensing

System Details Widget
® System Details Widget Categories
® Flagged Categories
Expiry Date
Distributed Agents and z/OS Agents
Tasks
Number of Monthly Executions
High Availability Licensed Cluster Nodes
® Number of Nodes within the Licensed Amount (No Violation)
® Number of Nodes exceeds or will exceed the Licensed Amount (Violation)
® Unlicensed Node Processing
® Unlicensed Node Ul
Universal Connector for PeopleSoft
® PeopleSoft Connections
® PeopleSoft Task Instances
Universal Connector for SAP
® SAP Connections
® SAP Task Instances
Reports

System Details Widget

The System Details widget displays Universal Controller system information in the following categories:

Cluster Node
Release
Memory
License
Database

The License category has been enhanced to display:

® Universal Agent-defined limits for the number of:

® Universal Connector for PeopleSoft (UPPS) connections.
® Universal Connector for SAP (USAP) connections.

® Universal Agent for SOA protocols that are licensed for use.

Note
1

For details on all Universal Agent license information, see Universal Agent Licensing.
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System Details

~ Cluster Node { Active }

MNode Id

MNode Mode Active

Mode Uptime & Days 0 Hour 20 Minutes 21 Seconds

MNode Time 2 6:04:45-0500 (US/Eastern

v Release {7

~ Memaory { ¢
v License { *Stenebranch Internal® } [l

~ Database { Microscft SOL Server }

System Details Widget Categories
This new design has the following categories, along with their respective attributes, defined within the widget.

® Cluster Node { Node Mode }
® Node Id
® Node Mode
* Node Uptime
® Node Time
®* Release { ReleaseBuild }
® Release
® Build
® Build Date
® Memory { Memory Used / Memory Maximum }
® Memory Maximum
®* Memory Used
® Memory Free
® License { Customer}
® Expiry Date
® Cluster Nodes
Distributed Agents
z/OS Agents
Tasks
Monthly Executions
UPPS
USAP
Exclude Source Recurring
UPPS Connections
USAP Connections
JMS
IBM WebSphere MQ
SOAP
XD SOAP
HTTP
® Customer
® Database { Database Type }
® Database Type
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® Database Name
® Database URL
® Database Connections

By default, all categories will be collapsed with the exception of the Cluster Node category.
While the dashboard remains open, any change to the expanded categories will be preserved between widget/dashboard refreshes.

To change the category expansion default, see the System Details Expanded Categories Universal Controller system property.

Note
1
Clicking the License category bar chart icon runs the UAC - Licensed Monthly Task Instance Executions built-in system report.

Flagged Categories
If an attribute under a category is flagged, the category will be expanded automatically and appear in red. Likewise, the flagged attribute will also appear in red.

For example:
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Mode 1d

Tasks

UPPS
USAR

4 Cluster Node { Active }

Mode Mode
Mode Uptime
Mode Time
b Release {6.8.0.0 build.development }

P Memory { 554 45 MB (30.46%) / 1820.50 MB }
4 License { **Unlicensed Trial™ }

Expiry Date
Distributed Agents
z/05 Agents

Monthly Executions
Cluster Modes

System Details w

SBUS26:7080-0pswise

Active

11 Seconds

2020-06-12 12:59:37 -0400 (America/New York)

2020-03-28 [Days: 45]
0/4

01

Unlimited

Unlimited

1/2

true

true

The following attributes can be flagged.

Cluster Node
Memory
License
License
License
License

License
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Node Mode
Memory Used
Expiry Date
Distributed Agents
z/0OS Agents
Tasks

Monthly Executions

Flagged when this cluster node is Unlicensed.

Flagged when percentage of memory used is greater than or equal to 90%.

Flagged when current date is past the expiry date.

Flagged when number of registered distributed agents (Windows/Linux) exceeds licensed distributed agents.
Flagged when number of registered z/OS agents exceeds licensed z/OS distributed agents.

Flagged when number of task definitions exceeds licensed number of tasks.

Flagged when number of monthly task instance executions exceeds licensed number of monthly executions.
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License Cluster Nodes Flagged when number of registered cluster nodes exceeds licensed number of cluster nodes.

Expiry Date
The license has an explicit expiry date, regardless of when the license is applied.

In prior releases, the expiry date was always based on the number of days relative from the date the license was applied.

Distributed Agents and z/OS Agents

Distributed Agents (Windows, Linux/Unix) and z/OS Agents are licensed separately.
A z/OS agent with secondary Agents requires a license for the primary Agent and one license for each secondary Agent.
In prior releases, agents were licensed under a single Agents component.

For information on how licenses are migrated from a prior release, see Product Licensing in the Universal Controller 6.8.0.0 Release Notes.

Tasks

The Controller license can enforce a fixed number of Task definitions or allow an Unlimited number of Task definitions.

Number of Monthly Executions

The Controller is licensed by the number of monthly executions; specifically, the number of task instances that run to Success or Finished over a period of one month.
The following task types are excluded from the monthly execution count.

Workflow

Timer

Agent File Monitor
Manual

Remote File Monitor
Task Monitor
System Monitor
Application Control
Variable Monitor
Email Monitor
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Note
1
Universal Monitors also are excluded from Monthly Executions.
The Type filter for the following built-in reports were updated.
® UAC - Licensed Monthly Task Instance Executions
® UAC - Completed Task Counts : Grouped by Month
® UAC - Completed Task Counts : Grouped by Month / Stacked by Type

Extension-based Universal Tasks that are Launched by a Universal Monitor as a configured Universal Task Publisher will be excluded from license instance history collection using the Launch Source. These
instances will have a Launch Source of Universal Monitor or Universal Monitor Trigger.

Additionally, task instances with Launch Source = Recurring are excluded from monthly execution count if their Exclude Source Recurring licensing attribute is enabled.

The Controller will capture execution statistics on a daily basis, commencing immediately after midnight in the server timezone, and store those statistics in the License Instance History
(ops_license_exec_history) table.

If you are licensed for an Unlimited number of monthly executions, then there is no limit on the number of task instances you can run.

High Availability Licensed Cluster Nodes

When a Universal Controller has restrictions on the Cluster Nodes within its License, the following behavior may be experienced when a new or existing Cluster Node is started up:

Number of Nodes within the Licensed Amount (No Violation)

If a new Cluster Node starts up and adding this new Cluster Node will not violate the License:
® The usual process occurs where the Cluster Node is created and starts up as Passive.
If an existing Cluster Node starts up and the License is not in violation with respect to Cluster Nodes:

® The usual process takes place with the Cluster Node starting up as Passive.

Number of Nodes exceeds or will exceed the Licensed Amount (Violation)

If a new Cluster Node starts up and adding this new Cluster Node will violate the License, or the License is already in violation for Cluster Nodes:
® The new Cluster Node will be added but it will run as a new status of "Unlicensed".

If an existing Cluster Node starts up and there are more Cluster Nodes than the License allows; that is, the License already is in violation for Cluster Nodes:
® A count of running Cluster Nodes is taken:

® |f the number of running Cluster Nodes is less than the licensed amount, the Cluster Node starts up normally as Passive.
® |f the number of running Cluster Nodes exceeds the licensed amount, the Cluster Node starts up as Unlicensed.

Unlicensed Node Processing

When a Cluster Node starts up as Unlicensed, it can only transition out of this mode for the following conditions:

®* Anew License is applied to the system that no longer makes the amount of Cluster Nodes in violation of the License.
® Deletion of Cluster Node(s) occurs, thereby removing the Cluster Node violation of the License.
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A user can connect to an Unlicensed Cluster Node from the User Interface; however, limited interaction is allowed:

® Activity Monitoring is not allowed.

Warning

son Activity monitor cannet be started since the Cluster
i ! % MNode you are logged into iz Unlicensed.

0K

® Commands are not allowed to be executed.

Universal Automation Center Console

@ 2020-02-13 10:49:54 AM  The Universal Controller Mode is currently Unlicensed and cannot run command Promote.
@ 2020-02-1310:49:36 AM The Universal Controller Mode is currently Unlicensed and cannot run command Launch.
@ 2020-02-1310:49:22 AM The Universal Controller Mode is currently Unlicensed and cannot run command Trigger Mow.

® Create/Update/Delete are NOT allowed of Tasks/Triggers/Calendars/Custom Days/.....
® Cluster Nodes can be deleted (as long as they are marked offline, as usual).
® Properties can be updated, in order to allow a new license to be applied.

Unlicensed Node Ul

The Cluster Node Status widget will show Unlicensed Cluster Nodes as seen below:
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L

Cluster Node Status

Unlicensed = 1 (25%)

B oOffline (1) B Active (1) | Passive (1) | Unlicensed (1)

Cluster Node List:

% 4 Cluster Nodes

Node d - Mode
WorkLaptop: 7 080-0pswise Unlicensed
HO1-opswise Passive
WY 2-opswise Offline
7773 ppswise Active

When connected to an Unlicensed Cluster Node, The License under the System Details will recognize it as:
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System Details

4 Cluster Node { Unlicensed ]

Mode Id WorklLaptop:7T080-o0pswise

Mode Mode Unlicensed

Mode Uptime 1 Hour 14 Minutes 0 Seconds

Mode Time 2020-02-13 11:59:27 -0500 (America/Mew _York)

I Release { 6.8.0.0 build development }
P Memory { 204 89 MB (5.63%) / 3641.00 MB }

Universal Connector for PeopleSoft

The License will have a new boolean (True/False) attribute for Universal Connector for PeopleSoft (UPPS) to control whether or not UPPS is allowed.
The following will be prohibited if not licensed for UPPS:

1. Creating PeopleSoft Connections.
2. Executing PeopleSoft Task Instances.

PeopleSoft Connections
Creating a new PeopleSoft Connection will only be allowed if licensed for UPPS.

The following error message will be logged if not licensed for UPPS.
Peopl eSoft Connecti on cannot be created because of License restriction.
If system notifications are enabled, a license notification email also will be sent with the following message in the email body.

Uni versal Controller node 'l ocal host:8080-uc'is not |icensed forUPPS.
User 'ops.adnin'was prohibited fromcreating Peopl eSoft Connection ' PPSCL'.

Pl ease contact Stonebranch custoner support.

Note

® PeopleSoft Connections will not be hidden in the Ul if not licensed for UPPS.
® Creating PeopleSoft Connections will not be prohibited by Promotion, List Import, or Bulk Import.
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PeopleSoft Task Instances

Creating new PeopleSoft Tasks will not be prohibited if not licensed for UPPS. Likewise, launching a PeopleSoft Task will not be prohibited; however, PeopleSoft Task Instances will transition to a Start FailureS
tatus with the following Status Description:

Execution prohibited due to License restriction.
If system notifications are enabled, a license notification email also will be sent with the following message in the email body.

Uni versal Controller node 'l ocal host:8888-uc'is not |icensed forUPPS.
Execution of Peopl eSoft task instance 'PPST1' was prohi bited.

Pl ease contact Stonebranch customer support.

Note

1
PeopleSoft Tasks/Task Instances will not be hidden in the Ul if not licensed for UPPS.

Universal Connector for SAP

The License will have a new boolean (True/False) attribute for Universal Connector for SAP (USAP) to control whether or not USAP is allowed.
The following will be prohibited if not licensed for USAP:

1. Creating SAP Connections.
2. Executing SAP Task Instances.

SAP Connections

Creating a new SAP Connection will only be allowed if licensed for USAP.

The following error message will be logged if not licensed for USAP.
SAP Connection cannot be created because of License restriction.
If system notifications are enabled, a license notification email also will be sent with the following message in the email body.

Uni versal Controller node 'l ocal host:8080-uc'is not |icensed forUSAP.
User 'ops.adn n'was prohibited fromcreating SAP Connection ' SAPC1'.
Pl ease contact Stonebranch custoner support.
Note
® SAP Connections will not be hidden in the Ul if not licensed for USAP.

® Creating SAP Connections will not be prohibited by Promotion, List Import, or Bulk Import.
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SAP Task Instances

Creating new SAP Tasks will not be prohibited if not licensed for USAP. Likewise, launching an SAP Task will not be prohibited; however, SAP Task Instances will transition to a Start FailureStatus with the
following Status Description:

Execution prohibited due to License restriction.
If system notifications are enabled, a license notification email also will be sent with the following message in the email body.

Uni versal Controller node 'l ocal host:8080-uc'is not |icensed forUSAP.
Execution of SAP task instance ' SAPT1' was prohi bited.

Pl ease contact Stonebranch custoner support.

Note

1
SAP Tasks/Task Instances will not be hidden in the Ul if not licensed for USAP.

Reports

A new built-in report, UAC - Licensed Monthly Task Instance Executions, visually display the number of monthly executions.
The report is driven by data in the License Instance History (ops_license_exec_history) table, which also is available as a Table for selection for custom-built reports.

The report shows the average number of monthly executions, and the licensed number of monthly executions if not Unlimited, as shown in the following example.
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Licensed Monthly Task Instance Executions | |
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Furthermore, when viewing the report definition, the Show Threshold, Threshold Color, Threshold Value, and Threshold Label will be dynamically populated with values in-line with the applied license.

— Chart Qptions
Chart Size : Large Bar Thickness : |150
. - Group i
Group By : |F'enod End Threshold - |Un||m|ted
Stack By : | Group Order : |Lahe|
— Group Date/Timea
Sum Field : |Number Format - |y_mr—rnm
Show Average Average Color: |#000000 HE
Show Threshold : Threshold Color: |#FF0000
Threshold Threshold Label : |Licensed |
Value :

21 /| uc-73x-uext



Universal Controller 7.3.x General Information

22 | uc-73x-uext



Universal Controller 7.3.x General Information

Agent-Only Licensing

® Overview
® User Interface
® Automation Center Navigation
® Bundles and Promotion
® Reporting Navigation
® Agents and Connections Navigation
® Administration Navigation
® System Details Widget

Overview

With the introduction of the Universal Agent 6.9.0.0, Universal Controller became the central location for the management of all licensing.

If you do not use Universal Controller as your enterprise job scheduler and workload automation broker solution, the Controller has an Agent-only license mode that allows you to manage licensing for Universal
Agent 7.2.x deployments.

User Interface

If an Agent-only license is applied to the Controller, logging into the Controller user interface presents restricted navigation.

Automation Center Navigation

The Automation Center navigation pane which normally is the default navigation pane in the Controller user interface, is not relevant in the context of an Agent-only license, and is hidden from view.

Bundles and Promotion

The Bundles & Promotion navigation pane is not relevant in the context of an Agent-only license and is hidden from view; the Bundles & Promotion icon is not available for selection.

Reporting Navigation

Under the Reporting navigation pane, the following menu options are available:
® Dashboards
® Reports
® Widgets

The Colors menu option is hidden.

Restrictions
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Reports = You can create reports only on Report tables that are permitted in Agent-Only licensing mode:

® Agents
® Cluster Nodes
® Connections
® Email Connections
® OMS Servers
®* SNMP Managers
® Security
® Widgets

Widgets | You cannot create Activity Widgets in Agent-Only licensing mode.

You cannot create Report Widgets for Reports that are not permitted in Agent-Only licensing mode.

Note
1

You can create Report Widgets for all Built-In Reports in Agent-Only licensing mode.

Agents and Connections Navigation

Under the Agents & Connections navigation pane, the following menu options are available:

® Agents
® Linux/Unix Agents
® Windows Agents
® 7/OS Agents
® System
® OMS Servers
Cluster Nodes
Email Connections
SMNP Managers

Administration Navigation

Under the Administration navigation pane, the following menu options are available:
® Configuration

Properties

Password Settings
LDAP Settings

Single Sign-On Settings
Server Operations
Filters

® Security

Users

Groups

Business Services
Audits

® Support

® Support Portal
® Video Classroom
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Note
!
In the Agent-only license mode, the Administration navigation pane is the default navigation pane.

System Details Widget

If the License is for a normal Universal Controller system (that is, not Agent-Only), no changes to the License Information are displayed; no mention of Agent-Only will be presented if the -AGENTONLY attribute
is set to False.

4 License { Junit } gy

Expiry Date 2025-10-13
Distributed Agents 515

z/05 Agents 0N

Cluster Nodes 213

Tasks 166/500
Monthly Executions 0/5000
UPPS true

USAP true

UPPS Connections 3
USAP Connections 0

JMS true
IEM WebSphere MQ true
SOAP true
XD S0AFP true
HTTP true
Customer Junit
Environment Test

If the License is for Agent Only set-up, the icon to display Licensed Monthly Task Instance Executions will not be displayed, nor will any information about Tasks or Monthly Executions.
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4 License { Mark } gl
Expiry Date
Distributed Agents
z/05 Agents

Cluster Nodes
Agent Only

UPPS Connections
USAP Connections
JMS

IBEM WebSphere MQ
SOAP

XD SOAP

HTTP

Customer

Environment

2021-10-13
5/5
0N
213
true
2

0
true
true
true
true
true
Mark
Test
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Logging In

® Login Methods
® Standard Login
® Changing Your Password
® Password Expiration
Single Sign-On Login
User Lockout
User Restriction
License Expiration
Login Disclaimer
Login Notification
Logging Out
® Exiting without Logging Out
® SAML Single Logout
® Log File and Audits
® Log File Messages
® Audit Messages
® User Sessions
® Send an Email to Logged In Users
® Expire User Sessions

Login Methods

Universal Controller provides a Login Method option at the user account level that allows you to select the following login methods:
® Standard
® Single Sign-On
® Both Standard and Single Sign-On

The default login method for a user depends on the user account type.

Account Type Login Method
Local User Account Local user accounts, by default, are designated with the Standard login method.

Any user account created prior to Universal Controller 6.4.6.0 is, by default, designated with the Standard login method; for example, after an upgrade, or after importing
users from an earlier release.

Any attempt by a user to use the Standard login for an account that is not designated to use Standard login method will receive the following error:

User nane and/or password invalid.

LDAP-Provisioned User Account Any user provisioned through LDAP synchronization will be designated, by default, with the login method(s) configured in the LDAP Settings.

The designation of the login method only applies at user creation time.
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Single Sign-On-Provisioned User Any user provisioned through SAML Single Sign-On will be designated, by default, with the Single Sign-On login method only.

Account
The designation of the login method only applies at user creation time.

Note

1
The local administrator account, ops.admin, is configured to allow only the Standard login method. Modification of the ops.admin account Login Method is not permitted.

For additional details on login method enforcement, see Single Sign-On Troubleshooting.

Standard Login

The Universal Automation Center Login page displays automatically when you bring up the Universal Controller system and browse to its URL.
The Standard login URL is:
http(s)://<server:port>/uc/login.jsp (or simply, http(s)://<server:port>/uc/).

All Local account and AD/LDAP-authenticated accounts authenticate through this standard login URL.
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e stonebranch

Username

Password

Universal Controller 7.4.0.0 build.25
Copyright © 2022 Stonebranch, Inc.

User Name @ The default login User name is ops.admin.

Password For your initial login to the Controller, no password is required; the Controller prompts you to create a password.

Changing Your Password
Note

1
Changing your password is not applicable to users that log in using LDAP authentication.

To change your password at any time after you have logged in:
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Step 1 On the User task bar, click the User Actions drop-down list arrow to display a menu of user actions.

Admin ~ @ O ®

Edit Profile
Change Password
User Sessions
Preferences

Logout

Step 2  Click Change Password. The Change Password dialog pops up.

Change Password X
Enter your current password and specify a new password.

Username *
Admin

Current Password *

MNew Password *

Confirm Mew Password *

Change Password

Step 3 Enter your Current Password and a New Password, and reenter your new password in Confirm New Password.

Step 4 Click the Change Password button.
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Note

1
If aﬁy Password Settings have been defined for user passwords, the hint for the New Password and Confirm New Password fields, as well as the information icon pop-up for either field, will display those
settings.

For example:

Password Settings - 1 X

Password Must Include All of the following:

* 1 Uppercase Letter [4-Z]
* 1 Lowercase Letter [a-z]
* 1 Numeric Character [0-9]

Password Restrictions:
s Password must be at least 5 character(s) in length

* Password cannot be longer than 20 character(s) in length
* Password cannot contain the previous 2 passwords

Password Expiration

Note
!
Password expiration is not applicable to users that log in using LDAP authentication.

If the Password Expiration Enabled field in Password Settings has been enabled, and you reach the maximum number of days that a user password can remain unchanged, as specified by the Password
Expiration in Days field in Password Settings, the following dialog displays when you enter your password on the Standard Login page:
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Lsername: jdoe
Current Password: |uuuu.
Mew Password: |

Caonfirm Mew Passward: |

Change Password

The system administrator requires you to change your passwaord. Your
password has expired.

Note
!
Below the Change Password button, the Change Password dialog will displays any characteristics and restrictions defined in Password Settings.

For example:

Password Settings - o X

Password Must Include All of the following:

* 1 Uppercase Letter [4-Z]
* 1 Lowercase Letter [a-z]
* 1 Numeric Character [0-9]

Password Restrictions:

* Password must be at least 5 character(s) in length
» Password cannot be longer than 20 character(s) in length
* Password cannot contain the previous 2 passwords

You must enter a new password, one that is different than your currently expired password. (To maintain a high level of security, you should never use a password that you have used before.)
1. In Current Password, enter your password that has just expired.

2. In New Password and Confirm New Password, enter a new, previously unused password.
3. Click Change Password.
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If you try to enter your currently expired password as your new password, the following error message displays on the Password Expired dialog:

Your new password cannot be the sane as your current password.

Single Sign-On Login

For information on Single Sign-On Login method and the Single Sign-On Login URL, see Single Sign-On Login on the Single Sign-On Settings page.

User Lockout

If the Lock Account After Maximum Login Attempts field in Password Settings has been enabled, and you reach the maximum number of successive login attempts that is allowed, as specified by the Maximum
Failed Login Attempts field in Password Settings, your user account in Universal Controller will be locked.

(Whenever Lock Account After Maximum Login Attempts is reset from enabled to disabled, the current number of login attempts for all users is reset to 0.)

If you attempt to log in to a locked account, the following message displays:

User account <Usernane> is | ocked. Please check with your administrator."

To unlock a locked account, your Controller system administrator must uncheck the Locked out field ion the User Details for that user account.

User Restriction

You can be restricted from logging in to the Universal Controller user interface either of two ways:
1. The system level default for web browser access, specified by the System Default Web Browser Access Universal Controller system property, has been set to No, and the Web Browser access field
in the User Details for your user account is set to -- System Default --."
2. The Web Browser access field is set to No, which overrides the System Default Web Browser Access value (Yes or No).

If either restriction is in place, the following error message will display when you enter your user name at the User name prompt:

User <Usernane> not pernmitted to login through the web browser. Please check with your adm nistrator.

To remove the restriction, the system administrator must either:

® Set the System Default Web Browser Access property to Yes and set the Web Browser access field in the User Details for your user account to -- System Default --.
® Setthe Web Browser access field in the User Details for your user account to Yes.
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License Expiration

If you log in to the Controller and your Controller license is about to expire within one week, the following informational message displays in the Console:

Uni versal Controller license for node <node_id> will expire in N days.

Pl ease contact Stonebranch custoner support to avoid service interruption.

If you log in to the Controller and your Controller license already has expired, the following error message displays in the Console:

Uni versal Controller license for node <node_i d> has expired and the Controller has been suspended.

Li censed Nunber of Days: N
Actual Nunber of Days: N

Pl ease contact Stonebranch customer support to restore services.

In each case, the Console will remain open until you manually close it.
Additionally, if you have configured the Controller for System Notifications, system notifications are sent when the Controller license will expire in seven days and if the license already has expired.

Note

1
If your license expires, you will not be able to run any tasks.

Login Disclaimer

The Login Disclaimer Universal Controller system property lets you define multi-lines of free-form text that will display at the bottom of the Universal Automation Center Login page when you attempt to login.

Note
1
HTML is not permitted and will be escaped accordingly.

For example:
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stonebranch
Username

Password

Universal Controller 7.4.0.0 build.25
Copyright © 2022 Stonebranch, Inc.

This is a sample login disclaimer.

Login Notification

The Login Notification Universal Controller system property lets you define a message that displays in the Console when you login to the Controller.
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Dashboards ¥ x

Active Task Instances By Status

Agent Status

Console

® 2022-11-04 12:04:14 PM This is a sample Login Notification

e _ :

System Details
~ Cluster Node { Active }
Node Id ga-opswise6:8080-qa_opswised
Node Mode Active
Node Uptime 2 Days 19 Hours 17 Minutes 19 Seconds
Node Time 2022-11-04 12:01:43-0400 (US/Eastern)
« Release {7400 build 25}
~ Memory {827.33 MB (15.15%) / 5451 50 VB }
~ License { *Stonebranch Intemal* } [

~ Database { Microsoft SQL Server }

Cluster Node Status

e}

'OMS Server Status

o

<

Logging Out

To log out of your Universal Controller session:
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Step 1 On the User Task Bar, click the User Actions drop-down list arrow to display a menu of user actions.

Admin ~ @ O &

Edit Profile
Change Password
User Sessions
Preferences

Logout

Step 2  Click Logout. You are logged out of this session, and the Universal Automation Center Login page displays.

Exiting without Logging Out
As a best practice, we recommend that you always end your Universal Controller session by logging out before closing the browser or navigating away from the user interface.

If you attempt to close the browser or navigate away from the user interface before logging out, and the Confirm Exit Universal Controller system property is set to true, the following pop-up dialog displays:

Leave site?

Changes you made may not be saved.

Prevent this page from creating additional dialogs

Leave Cancel

® Click Leave Page to navigate away from the Universal Controller user interface.
® Click Stay on Page to remain in the Universal Controller user interface.
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Note

1
This dialog may differ from browser to browser.

SAML Single Logout

For information on SAML Single Logout, see Single Logout in Single Sign-On Settings.

Log File and Audits

All user login and logout activity, whether via the user interface or a Universal Controller remote interface, is logged and audited (as a single audit type: User Login).

Log File Messages

Log file messages for login activity are in the following format:

tinmestanp(internal)login activity<user=user nane, ipaddr=IP address>

For example:

2015- 04- 16-11: 16: 26: 391 - 0400 I NFO [ ht 't p- bi 0- 8080- exec-5] Login OK <user=ops. adm n, ipaddr=192.55. 44, 123>
2015-04-16-11: 17: 20: 208 - 0400 I NFO [ ht't p- bi 0- 8080- exec-10] Login Fail ed <user=ops.adnin, ipaddr=192.55.44. 123>
2015-04- 16-11: 16: 57: 442 - 0400 I NFO [ htt p- bi 0- 8080- exec-11] Logout OK <user=ops.adnin, ipaddr=192.55.44. 123>

Audit Messages

Audit messages for login activity are in the following format:

login activity<user=user nane, ipaddr=IP address>

For example:

LOA N <user =st onebranch-user-01, ipaddr=192.55. 44.123>

Note

1
The IP Address of the user is not logged or audited for login activity via the Command Line Interface (CLI).
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User Sessions

Note
!
This action requires the ops_admin role or the ops_user_admin role.

To display a list of currently authenticated user sessions (logged in users):

Step 1 | Onthe User task bar, click the User Actions drop-down list arrow to display a menu of user actions.

Admin ~ @ O @
Edit Profile

Change Password

ser Sessions

Preferences

Logout

Step 2 | Click User Sessions to display the User Sessions list of currently authenticated user sessions.

User Sessions

User © Remote Address Creation Time Last Accessed Time
Admin 10.253.0.13 2022-11-04 16:04:14 -0400 2022-11-04 16:09:10 -0400
) Refresh B Email All X Close
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For each logged in the user, the User Sessions list provides the following columns of information:

Column Description
User User Id of the user. (You can click a User Id to display the User Details for that user.)
Remote Address Address of the machine from where the user logged in.
Creation Time Date and time that the user initially logged in; in other words, when the user session was created.

Last Accessed Time = Last date and time that the client (browser) sent a request associated with this user session..
Note
!
If you have configured Tomcat for never timing out sessions or for an exceptionally long session timeout - neither of which is recommended - this can result in a large number of lingering sessions if users are

not logging out of the web application prior to closing their browser. As a precaution, if the Universal Controller detects more than 1,000 authenticated sessions, only those sessions with a Last Accessed Time
of less than 24 hours ago will be displayed.

To view an up-to-date list of the currently logged in users, click the Refresh button; to close the list, click the Close button.

From the Users Sessions list, you also can:
® Send an Email to one or more (or all) logged in users.
® Expire the user session of one or more users.

Note

1
If the following error appears in the Console while you are using the User Sessions feature, you may need to manually configure the opswise.mbean.catalina.manager.name Universal Controller start-up
property:

Uni versal Controller not configured for user session operations.

Send an Email to Logged In Users

From the User Sessions list, you can send an Email to:

® All users on the list.
® One or more users on the list.

The Controller will auto-generate the email Subject in the following format:
Message from system.identifier Universal Controller Adm nistrator (user_id@l uster_node_id)
The Reply-To address for the email will be the email address of the sender.

An administrator must ensure that an Email Connection exists with the Use for System Notifications option enabled. The Email Address specified in the Email Connection Details will appear as the From email
address.
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Note
!
For local user accounts, each user must have assigned a valid email address.

For AD/LDAP synchronized user accounts, each synchronized user must have a valid email address mapped to their user record. (By default, this should be true.)

Send an Email to All Logged In Users

Step 1 | Click the Email All button on the User Sessions list. An Email pop-up dialog displays.

Email

Message *

E2 send ® Cancel

Step 2 | Enter a Message and click the Send button.

Send an Email to One or More Logged In Users

Step 1 | Select one or more users on the User Sessions list and right-click any of the selected users. The User Sessions actions menu displays:

Email

Expire Session
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Step 2 | Click Email to display an Email pop-up dialog.

Email

Message *

E2 send ® cancel

Step 3 = Enter a Message and click the Send button.

Expire User Sessions

Note
!
This action requires the ops_admin role or the ops_user_admin role.

To expire (log out) one or more currently authenticated user sessions (logged in users):

Click User Sessions in the User Actions drop-down list on the User Task Bar. The User Sessions list then displays a list of currently authenticated user sessions.

Step 1

Step 2 | Select one or more users on the list and right-click any of the selected users. The User Sessions actions menu displays:
Email
Expire Session

Step 3 | Click Expire Session to expire the user sessions of the selected users. A confirmation pop-up then displays.

Step 4 | Click OK to confirm that you want to expire the selected user sessions.
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User Interface

® Overview
® Home Page
® User Interface Details
® Available Services
® Global Search
® Performing a Global Search:
® Customizing the Banner
® Changing the Banner Background Color
® Changing the Banner Logo
® Drop-Down Lists
® Console
® Console Actions
® Tabs
® Pinning Tabs
® Tab Picker
® Record Details as Tabs
® Additional Information

Overview

The Universal Controller 7.2.x user interface is comprised of two basic elements:

®* Home page
® Services

Home Page

When you log in to the Universal Controller 7.2.x user interface, your Universal Controller home page displays.

The home page contains the Home Dashboard and a panel on the left side of the page that lists any Services that you had selected for easy access.
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e Services ~ b Administrater v @ A @
Dashboards Dashboards *
Activity Active Task Instances By Status (] System Details (]
~ Cluster Node { Active }
Node Id STBUS21:8080-0pswise
Node Mode Active
Node Uptime 4 Hours 27 Minutes 30 Seconds
Node Time 2022-10-10 13:40:46 -0400 (America/New_York)
v Release{7.3.0.0build.156 }
v Memory {82.94 MB (36.38%) / 228.00 M8 }
~ License { **Unlicensed Trial* } [
~ Database { MySQL }
|
Agent Status (] Cluster Node Status (] OMS Server Status (]
W Active (1)
I 20221010 1341 0400 - 2 Administrator's Home @ Refresh Customize ¥

User Interface Details

In addition to the Home Dashboard and user-selected links to areas in Services, the Home Page - and all pages accessed via Services - contains the following information (except where noted).

Section

Services v
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Link to the Stonebranch website.

Link to the Universal Controller Services available in the user interface.
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Search field that enables you to search for a Name, Description, and
@ Member of Business Services across multiple record types.

The Search icon lets you select which field types to search for.

o User-specific information for the logged in user.

Administrator v | 1o
® Edit Profile
User Details for this user.
; ® Change Password
L Edit Profile Change Password dialog for this user.
I ® User Sessions
List of currently authenticated user sessions.
Change Password * Preferences

: List of User Preferences for this user.
I ® Logout
. Logs out this user from the user interface.
. User Sessions

Preferences

Logout
Links to:

ﬁ D ® ® Home Dashboard

— ® Console
® Universal Controller user documentation
Time and node status (System Details).
I 2022-10-11 11:47 -0400 W

Home page only; Refreshes the information displayed on this page.

) Refresh
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Customize v

Available Services

All of the record types are under Available Services
To add a record type to the home page navigation panel, click the star icon ( U) next to the record type in Available Services

To create a record for a record type while in Available Services, click the new icon ( +) next to that record type
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Home page only:

New

Creates a new Dashboard.

Edit

Edits the Dashboard

Delete

Delete the Dashboard

Set As Default

Set the Dashboard as the default Dashboard.
Copy

Creates a copy of the Dashboard.
Visibility

Sets the visibility of the Dashboard.

Note

You cannot Edit or Delete the Home Dashboard.
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Available Services

* Dashboards

K Activity

v Workflows

Instances

¢ Task Instances

Y History
Tasks

¥ All Tasks

¥r Linux/Unix Tasks
Windows Tasks
z/0S Tasks

Universal Command Tasks
File Transfer Tasks
Manual Tasks
Timer Tasks
5QL Tasks
Stored Procedure Tasks
Email Tasks
Web Service Tasks

Recurring Tasks

o r X $ % 3 % L 3

Application Control Tasks
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Integrations
Integration Hub

Import Integration Template

¢ PeopleSoft Tasks

¢ SAP Tasks

Triggers

r ¥ X o I X X X I I X N I

All Triggers

Active Triggers

Cron Triggers

Time Triggers

Manual Triggers
Temporary Triggers

Agent File Monitor Triggers
Task Monitor Triggers
Variable Monitor Triggers
Email Monitor Triggers
Universal Monitor Triggers
Application Monitor Triggers

Composite Triggers

Monitors

w
w
w
w
w
w
w

Task Monitors

Agent File Monitors
Remote File Monitors
System Monitors
Variable Monitors
Email Monitors

Universal Monitors

Calendars

w
w

Calendars

Custom Davys

Forecasts

w
w

Forecasts

Forecast Calendar

Other

w

r

Credentials

Fmail Temnlates

Reports
Y¢ Reports

Yr Widgets

Yr Colors

Lifecycle Management

¥¢ Bundles

Y¢ Promotion Targets

¥¢ Promotion History

¥ Promotion Schedules
Agents

¢ All Agents

Y Linux/Unix Agents

¥ Linux/Unix Agent Clusters
Yr Windows Agents

¢ Windows Agent Clusters
Y& z/0S Agents
Connections

Y¢ Email Connections

Y¢ Database Connections
Y& SAP Connections

Y¢ PeopleSoft Connections
System

Yr Applications

3 Cluster Nodes

¥ OMS Servers

¢ SNMP Managers

Y& OAuth Clients
Administration

Y Audits

¥r Business Services

¥ DNata Rackun / Puroe
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S ey e
Y& Scripts Y7 Filters

Y7 Variables Y7 Groups

¥¥ Virtual Resources Y7 LDAP Settings

Y7 Password Settings

Y7 Properties

¥¢ Server Operations

Y7 Single Sign-On Settings

¥ Universal Templates

¥¥ Universal Event Templates
¢ Users

Support

¥¢ Support Portal

¥¢ Video Classroom

Global Search

Global Search enables you to search the user interface for Name, Description, and/or Member of Business Services for the following record types:

Agent

Agent Cluster
Application

Bundle

Bundle Target
Calendar

Credentials
Database Connection
Email Connection
Email Template

OMS Server
PeopleSoft Connection
SAP Connection
Script

SNMP Manager
Task

Trigger

Variable
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® Virtual Resource
You can search for:

® Exact field:
Enter a specific record name.
® Partial field:
Enter partial text and use a question mark ( ? ) to replace any single character.
® Wildcard:
Use a wildcard ( * ) to match one or more matching values (for example: t*, Test*, *est*.

Note
!
You can receive search results only for records for which you have read access.

Performing a Global Search:

1. Click the Settings icon on the User Task Bar to configure which fields to search. By default, the Name and Description fields are selected.

Search Settings x
MName
.v’
Description
[+

hember of Business Services

2. In the Search field, enter the text to search for. (Search text is not case sensitive.)

op* Q g

3. Click the Search icon to perform the search.

A list of any search results then displays.

2 Matches (7
Name “  Description Type Updated By Updated -

[E Opswise - Default Linux/Unix Cluster Agent Cluster  ellen.ulster 2015-12-06 16:42:21 -0500

[E Opswise - Default Windows Cluster Agent Cluster  ops.system 2009-06-10 14:08:41 -0400
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Customizing the Banner

You can customize the Universal Automation Center banner that displays across the top of the page by changing the banner logo.

Changing the Banner Background Color

To change the background color of the banner, enter a new hexadecimal value in the Banner Background Color Universal Controller system property.

Changing the Banner Logo

Step1 | Copy the logo file that you want to use in the banner to the uc_i nages directory directly under your Tomcat hone/ i nst al | ati on directory: . . / t ontat / uc_i nages. Valid logo file extensions
are .png, .jpg, and .gif. The logo should be a maximum 298px x 48px. Any logo larger than these dimensions will be scaled automatically; however, it is recommended that keep the logo within
these dimensions.

® |fthe uc_i mages directory does not exist, create it.
® |f you have a High Availability system, you must copy the logo to the uc_i mages directory for each Universal Controller cluster node in the system.

Step 2 | Login to the Universal Controller (or any Controller cluster node in a High Availability system) and update the Banner Logo Universal Controller system property to the name of the logo file
(excluding path) that you copied to the uc_i mages directory. The logo will be deployed automatically to the Controller. In a High Availability system, where an updated property on one cluster
node applies to all cluster nodes (since they share the same database), the logo file will be deployed automatically on initial application request.

Step 3 | If you want the logo to link to a web resource, enter the URL for the web resource in the Banner Logo URL Universal Controller system property.

Note

1
If you update the currently configured banner logo file in the uc_i mages folder, as long as the banner logo file size has changed, it will be redeployed automatically. If you do not see the updated banner logo
from the user interface, try running the Clear Server Cache server operation and/or clearing your browser cache.

Drop-Down Lists

Many record Details contain drop-down lists of available values for specific fields.

For example, the record Details for a User contains a drop-down list of titles that can be assigned to the User:
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User Details
B~
User

Details

User Id (Username) *
stonebranch-user-01

Password *

First Name *
Stone

Middle Name
Last Name
Email

Password Requires Reset

Locked Out

Login Method *

Sndard |8

Single Sign-On -

Time Zone
Server (America/New_York)

Title

System Administrator

Vice President

Director

Senior Developer

Junicr Developer
Administrative Assistant
Chief Financial Officer
Chief Technology Officer
Chief Executive Officer
Solution Consultant

P DR L

— Systemn Default —

To select a value from a drop-down list, either:

® Click the drop-down list arrow and then click a value.

® Begin entering the name of a value in the drop-down list field. A list of values that match your entry then displays. Click a displayed value.

Console

The Console contains informational and error messages regarding recent Controller activity.

For example:
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Console

opied task “stonebranch-linux/unixtask-01" to

w task "stonebranch-linux

01 - Copy

o o

ceessfully launched the Linux/Unix task “stonebranch-linu sk-01" with task instan ys_id 1665157255511287639GMH1A227Z

The Console opens automatically to display error ( x ) messages, and you can set the Console to open automatically to display information (i ) messages (via one of four user preferences that allow you to
control the Console display).

Note
1
Error messages related to specific fields are displayed next to the fields themselves in the record Details, not in the Console.

You also can open the Console manually at any time by clicking the Universal Automation Center Console icon on the User Task Bar.

Console Actions

Action Icon Description

Select and Copy  n/a Select message text either of three ways:
® Drag your cursor across any of the text.
* Double-click a single entry in the text to select only that entry.
® Triple-click anywhere in the message text to select all of the text.
Use Ctrl+C and Ctrl+V to copy and paste the selected text.

You also can select and copy text this way from the Print Preview pop-up (see Print in this table).

Print @ Click the Print icon at the top of the Console to display a Print Preview pop-up, and then click the Print button.

Trash Click the Trash icon at the top of the Console to empty the contents of the Console.

Close Close the Console either by:

O
X

® Clicking the Close icon at the top of the Console.
® Double-clicking the Console header.

Tabs

Every page in the user interface displays, when selected, under a tab at the top of the page. The tab for the page currently being viewed is white; all other tabs are gray.

When you log in to the Controller, the Home dashboard displays under a Dashboards tab. The Home dashboard - as well as the Activity Monitor and Dashboard Details - remain open throughout your session
unless you manually close them by clicking the x icon in the tab itself. The tabs for those pages otherwise remain at the top of the screen so that you can quickly return to them at any time.

For example:
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Linux/Unix Tasks # % Windows Tasks X

“|T | Qoo | + © 2 B + 0 8 [ LaunchTesk @ Vie ()
e Description  Command or Script  Updated By  Updated ~ Linux(Unix Task Variables Actions Virtual Resources Mutually Exclusive nste 4 by
B stonebranch-linux/unixtask-01 Command opsadmin  2022-10-10 09:18:20 -0400 [ - -
[ stonebranch-linux/unixtask-02 Command opsadmin  2022-10-1009:47:11 -0400
B stonebranch-linux/unixtask-03 Command opsadmin 202 09:47:27-0400 Linux/Unix Details
[ stonebranch-linux/unixtask-04 Command opsadmin  2022-10-10 09:47:45 -0400 C
[ stonebranch-linux/unixtask-05 Command ops.admin  2022-10-10 09:47:59 -0400

c

Parameters

Runtime Directory

Environment Variables

Name Value

No items to show,

Result Processing Details

Retry Options

Retry Exit Codes

Maximum Retries Retry Indefinitely

5 Linux/Unix Tasks

If you select a page in the Services while viewing Dashboards, Activity Monitor, or Server Operations, a new tab will open for that page. The Dashboards, Activity Monitor, and Server Operations tabs are pinned
automatically to the top of the page and will remain open if you navigate from them.

If you select a page in the Services while viewing any other page, the Tabs Pinned Automatically user preference specifies whether or not that page is pinned.

Note

1
When you close the tab for the page currently being viewed, you return to the tab for the previous page that you viewed, not the tab for the page that you last opened.

Pinning Tabs
You can pin tabs to the top of the page so that the pinned page displays even if you select other pages to display. You also can unpin any pinned tabs at any time (see the Tabs action menu).
The following tabs are pinned automatically and will not close unless you manually close them either by clicking the x icon on the tab or close them via the Tabs action menu.

® Dashboards

® Activity

® Server Operation

Pinned tabs are identified with a pin icon next to the tab name.

Any tab pinned during the current user session will display as pinned when the tab is opened again in a future user session, until the tab is unpinned.

Tab Picker
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If you open more tabs that can be displayed on your screen, tab picker icons display that let you scroll back and forth among the tabs and select any tab from a drop-down list

< | Scroll left through the tabs.
> Scroll right through the tabs.

v | Display a drop-down list of all open tabs.

For example:
B + [0 B & LaunchTask [@ view Parents o o
Linux/Unix Task Variables Actions Virtval Resources Mutually Exclusive Instz 4 4 -
General +  Linux/Unix Task
Mame * Version Variables
stonebranch-linux/unixtask-01 1
Description aChons

Virtual Resources

Mutually Exclusive

Time Zone Ereference Instances
- Systemn Default - -
Triggers
Hold on Start 99
| I Notes
Virtual Resource Pricrity Hald Rescurces on Failure
10 . | 1 Versions

Mutually Exclusive With Self

Record Details as Tabs

You also can display record Details as tabs at the top of a page

Step 1 | Fromarecord list, either:

® Right-click a record in the list.
® Open a record and right-click in the record Details.

Step 2 | Inthe Action menu, click Open in Tab. The record Details display under a tab at the top of the page.

If you click Open in Tab for an open record, the record is closed and displays only under the tab.
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Step 3 | If you want to open the same record or another record under another tab, repeat Steps 1 and 2.

You can open any number and combination of tabs from one or more lists in the user interface.

For example:

Dashboards ¥ X Linux/UnixTasks # % Linux/Unix Task Details: stonebranch-linuxfunixtask-01 ¥ % Linux/Unix Task Details: stonebranch-linusjunixtask-02 %

® B B B teunchTask @ ViewParents
Linux/Unix Task: Variables Actions. Virtual Resources Mutually Exclusive Instances

General
N:

ranch-linux/unixtask-02

Description

Member of Busine:

Mutually Exclusive With Seff

Versions

Additional Information

The following pages provide additional information for the Universal Controller user interface:

Home Dashboard

Services

Records

Record Lists

Filters

Action Menus

User Preferences

Wildcards and Regular Expressions
Access Keys
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Services

® Overview
® Available Services
® Adding a Service to the Favorites
® Recently Visited
® Available Services
® Available Services Refresh

Overview

The Services area of the user interface provides access to all areas of the user interface.
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Available Services

* Dashboards

K Activity

v Workflows

Instances

¢ Task Instances

Y History
Tasks

¥ All Tasks

¥r Linux/Unix Tasks
Windows Tasks
z/0S Tasks

Universal Command Tasks
File Transfer Tasks
Manual Tasks
Timer Tasks
5QL Tasks
Stored Procedure Tasks
Email Tasks
Web Service Tasks

Recurring Tasks

o r X $ % 3 % L 3

Application Control Tasks
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Integrations
Integration Hub

Import Integration Template

¢ PeopleSoft Tasks

¢ SAP Tasks

Triggers

r ¥ X o I X X X I I X N I

All Triggers

Active Triggers

Cron Triggers

Time Triggers

Manual Triggers
Temporary Triggers

Agent File Monitor Triggers
Task Monitor Triggers
Variable Monitor Triggers
Email Monitor Triggers
Universal Monitor Triggers
Application Monitor Triggers

Composite Triggers

Monitors

w
w
w
w
w
w
w

Task Monitors

Agent File Monitors
Remote File Monitors
System Monitors
Variable Monitors
Email Monitors

Universal Monitors

Calendars

w
w

Calendars

Custom Davys

Forecasts

w
w

Forecasts

Forecast Calendar

Other

w

r

Credentials

Fmail Temnlates

Reports
Y¢ Reports

Yr Widgets

Yr Colors

Lifecycle Management

¥¢ Bundles

Y¢ Promotion Targets

¥¢ Promotion History

¥ Promotion Schedules
Agents

¢ All Agents

Y Linux/Unix Agents

¥ Linux/Unix Agent Clusters
Yr Windows Agents

¢ Windows Agent Clusters
Y& z/0S Agents
Connections

Y¢ Email Connections

Y¢ Database Connections
Y& SAP Connections

Y¢ PeopleSoft Connections
System

Yr Applications

3 Cluster Nodes

¥ OMS Servers

¢ SNMP Managers

Y& OAuth Clients
Administration

Y Audits

¥r Business Services

¥ DNata Rackun / Puroe
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e ey e
Y& Scripts Y7 Filters

Y7 Variables Y7 Groups

¥¥ Virtual Resources Y7 LDAP Settings

1 Password Settings

Y7 Properties

¥¢ Server Operations

17 Single 5ign-On Settings

¢ Universal Templates

¥¥ Universal Event Templates
¢ Users

Support

1 Support Portal

¥¢ Video Classroom

Available Services

The Available Services area displays all services available to the logged in user.

Adding a Service to the Favorites

To add a Service to the Favorites list on the user interface home page, click the white star next to the name of that Service. The star turns blue to signify that it has been added to the Favorites list.

To remove a service from the Favorites list, click the blue star next to the service in Available Services. The star turns from blue to white to signify that the service has been removed from the Navigator.
Note

1
If the Dashboards and Activity services are available to the logged in user, they will automatically be added to the Favorites list.

Recently Visited

The Recently Visited list identifies items in Available Services that you have recently visited.

The most recently visited items are at the top of the list.

59 / uc-73x-uext



Universal Controller 7.3.x General Information

The Services Recently Visited Limit user preference specified how many recently visited items will display on the list.

Available Services

Available Services provides access to all areas of the user interface.

Each navigation pane provides links to specific pages in the user interface, such as a record type or list. When you hover you cursor over a link, it is highlighted in gray. When you click a link, the highlight is

removed.

The following tables provide a quick reference and links for each item in the Available Services.

Area Menu
Options
Dashboards
Activity
Workflows

Task Instances
Task Insta

nces

History

Tasks

All Tasks

Workflow
Tasks

Linux
/Unix Tasks

Windows
Tasks

z

/OS Tasks
Universal

Command
Tasks
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Description and Links

Access to all Dashboards.

Access to the Activity Monitor, which lists all active task instances; the data is automatically refreshed. From this list, you can view and edit any task instance. For non-
Workflow task instances, you also can view output or rerun the task.

Lists all Workflow tasks in the Controller.

Multiple task instance lists.

Lists the same task instances as the Activity Monitor, but only for task instances for which there has been a status change or a modification to the task instance record
within the last 7 days (an Updated on Last 7 Days filter has been pre-selected for this display). Also, unlike the Activity Monitor, the data is not automatically refreshed.
Task Instances also allows you to view details about workflow instances — information that is not available from the Activity Monitor.

Lists a history of completed task instances with a status in an "end state" (SUCCESS, FINISHED, FAILED, CANCELLED, START FAILURE, SKIPPED). This allows you to
track information about a specific task instance, including multiple runs. For example, Task A may have failed and was then re-run by a user. This task instance will appear
twice on the History list, first for the time that it ran and failed and again for the time it was re-run to success.

From the History list, you can display read-only details about any task instance on the list.

Lists of tasks for all task types; list of all tasks.

Lists all existing tasks of all types. From this list, you can view, edit, or launch any task on the list, or create a new task of any type.

Lists all Workflow tasks. From this list, you can view, edit, or launch any Workflow, or create a new Workflow.

Lists all Linux/Unix tasks. From this list, you can view, edit, or launch any Linux/Unix task, or create a new Linux/Unix task.

Lists all Windows tasks. From this list, you can view, edit, or launch any Windows task, or create a new Windows task.

Lists all z/OS tasks. From this list, you can view, edit, or launch any z/OS task, or create a new z/OS task.

Lists all Universal Command tasks. From this list, you can view, edit, or launch any Universal Command task, or create a new Universal Command task.


https://docs.stonebranch.com/confluence/display/UC73/User+Preferences#UserPreferences-ServicesRecentlyVisitedLimit
https://docs.stonebranch.com/confluence/display/UC73/Dashboards
https://docs.stonebranch.com/confluence/display/UC73/Monitoring+Activity+from+the+Activity+Monitor
https://docs.stonebranch.com/confluence/display/UC73/Monitoring+Activity+from+the+Activity+Monitor
https://docs.stonebranch.com/confluence/display/UC73/Workflows
https://docs.stonebranch.com/confluence/display/UC73/Monitoring+Activity+from+the+Task+Instances+List
https://docs.stonebranch.com/confluence/display/UC73/Monitoring+Activity+History
https://docs.stonebranch.com/confluence/display/UC73/Creating+Tasks
https://docs.stonebranch.com/confluence/display/UC73/Creating+and+Maintaining+Workflows
https://docs.stonebranch.com/confluence/display/UC73/Linux+Unix+Task
https://docs.stonebranch.com/confluence/display/UC73/Windows+Task
https://docs.stonebranch.com/confluence/pages/viewpage.action?pageId=95696823
https://docs.stonebranch.com/confluence/display/UC73/Universal+Command+Task
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Integrations

Triggers
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File Transf
er Tasks

Manual Ta
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Timer Tas
ks

SQL Tasks

Stored Pr
ocedure T
asks

Email Tas
ks

Web Servi
ce Tasks

Recurring
Tasks

Applicatio
n Control
Tasks

Integration
Hub

Import
Integration
Template

PeopleSof
t Tasks

SAP
Tasks

All Triggers

Active Trig
gers

Cron Trigg
ers

Time Trig
gers

Lists all File Transfer tasks. From this list, you can view, edit, or launch any File Transfer task, or create a new File Transfer task.

Lists all Manual tasks. From this list, you can view, edit, or launch any Manual task, or create a new Manual task.

Lists all Timer tasks. From this list, you can view, edit, or launch any Timer task, or create a new Timer task.

Lists all SQL tasks. From this list, you can view, edit, or launch any SQL task, or create a new SQL task.

Lists all Stored Procedure tasks. From this list, you can view, edit, or launch any Stored Procedure task, or create a new Stored Procedure task.

Lists all Email tasks. From this list, you can view, edit, or launch any Email task, or create a new Email task.

Lists all Web Service tasks. From this list, you can view, edit, or launch any Web Service task, or create a new Web Service task.

Lists all Recurring tasks. From this list, you can view, edit, or launch any Recurring task, or create a new Recurring task.

Lists all Application Control tasks. From this list, you can view, edit, or launch any Application Control task, or create a new Application Control task.

Lists all Integrations, categorized by Universal Task type. Each Universal Task type is based on an administrator-defined Universal Template.

(The area for Universal Tasks displays only if one or more Universal Templates - which the Controller lists as Universal Task types - have been created with one or more
defined fields.)

Provides access to the Stonebranch Integration Hub.

Provides ability to import lvnNtegration Templates to the Controller.

Lists all PeopleSoft tasks. From this list, you can view, edit, or launch any PeopleSoft task, or create a new PeopleSoft task.Lists all PeopleSoft tasks. From this list, you can
view, edit, or launch any PeopleSoft task, or create a new PeopleSoft task.

Lists all SAP tasks. From this list, you can view, edit, or launch any SAP task, or create a new SAP task.

List of triggers for each trigger type; list of all trigger triggers; forecast information.

Lists all existing triggers of all types. From this list, you can view and edit any trigger on the list, or create a new trigger of any type.

Lists all active (enabled) triggers. From this list, you can view and edit any trigger on the list, or create a new trigger of any type.

Lists all Cron triggers. From this list, you can view or edit any Cron trigger, or create a new Cron trigger.

Lists all Time triggers. From this list, you can view or edit any Time trigger, or create a new Time trigger.


https://docs.stonebranch.com/confluence/display/UC73/File+Transfer+Task
https://docs.stonebranch.com/confluence/display/UC73/Manual+Task
https://docs.stonebranch.com/confluence/display/UC73/Timer+Task
https://docs.stonebranch.com/confluence/display/UC73/SQL+Task
https://docs.stonebranch.com/confluence/display/UC73/Stored+Procedure+Task
https://docs.stonebranch.com/confluence/display/UC73/Email+Task
https://docs.stonebranch.com/confluence/display/UC73/Web+Service+Task
https://docs.stonebranch.com/confluence/display/UC73/Recurring+Task
https://docs.stonebranch.com/confluence/display/UC73/Application+Control+Tasks
https://docs.stonebranch.com/confluence/display/UC73/Integrations
https://docs.stonebranch.com/confluence/display/UC73/Creating+a+Universal+Template
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Task
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Task
https://docs.stonebranch.com/confluence/display/UC73/SAP+Task
https://docs.stonebranch.com/confluence/display/UC73/Triggers+Overview
https://docs.stonebranch.com/confluence/display/UC73/Enabling+and+Disabling+Triggers
https://docs.stonebranch.com/confluence/display/UC73/Cron+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Time+Trigger
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Monitors
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Lists all Manual triggers. From this list, you can view or edit any Manual trigger, or create a new Manual trigger.

Lists all Temporary triggers. From this list, you can view or edit any Temporary trigger, or create a new Temporary trigger.

Lists all Agent File Monitor triggers. From this list, you can view or edit any Agent File Monitor trigger, or create a new Agent File Monitor trigger.

Lists all Task Monitor triggers. From this list, you can view or edit any Task Monitor trigger, or create a new Task Monitor trigger.

Lists all Variable Monitor triggers. From this list, you can view or edit any Variable Monitor trigger, or create a new Variable Monitor trigger.

Lists all Email Monitor triggers. From this list, you can view or edit any Email Monitor trigger, or create a new Email Monitor trigger.

Lists all Application Monitor triggers. From this list, you can view or edit any Application Monitor trigger, or create a new Application Monitor trigger.

Lists all Composite triggers. From this list, you can view or edit any Composite trigger, or create a new Composite trigger.
Lists information about every task in the Forecast Calendar, including tasks within a workflow launched by a trigger. See Forecast List.

For Time, Temporary and Cron triggers: Lists a Forecast Calendar of all scheduled task instances for the next N days. The number (N) of days displayed in the forecast is
specified using the Forecast Period in Days Universal Controller system property (see Forecast Calendar).

List of all Monitor task types.

Lists all Task Monitor tasks. From this list, you can view, edit, or launch any Task Monitor task, or create a new Task Monitor task.

Lists all Agent File Monitor tasks. From this list, you can view, edit, or launch any Agent File Monitor task, or create a new Agent File Monitor task.

Lists all Remote File Monitor tasks. From this list, you can view, edit, or launch any Remote File Monitor task, or create a new Remote File Monitor task.

Lists all System Monitor tasks. From this list, you can view, edit, or launch any System Monitor task, or create a new System Monitor task.

Lists all Variable Monitor tasks. From this list, you can view, edit, or launch any Variable Monitor task, or create a new Variable Monitor task.

Lists all Email Monitor tasks. From this list, you can view, edit, or launch any Email Monitor task, or create a new Email Monitor task.


https://docs.stonebranch.com/confluence/display/UC73/Manual+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Temporary+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Agent+File+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Task+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Variable+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Email+Monitor+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Application+Monitor+Triggers
https://docs.stonebranch.com/confluence/display/UC73/Composite+Trigger
https://docs.stonebranch.com/confluence/display/UC73/Displaying+Trigger+Forecast+Information#DisplayingTriggerForecastInformation-ForecastList
https://docs.stonebranch.com/confluence/display/UC73/Properties#Properties-ForecastPeriodinDays
https://docs.stonebranch.com/confluence/display/UC73/Displaying+Trigger+Forecast+Information#DisplayingTriggerForecastInformation-ForecastCalendar
https://docs.stonebranch.com/confluence/display/UC73/Task+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Agent+File+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Remote+File+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/System+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Variable+Monitor+Task
https://docs.stonebranch.com/confluence/display/UC73/Email+Monitor+Task
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Universal Lists all Universal Monitor tasks. From this list, you can view, edit, or launch any Universal Monitor task, or create a new Universal Monitor task.
Monitors

Calendars Lists of all Calendars and Custom Days.
Calendars | Lists all Calendars Overview. From this list, you can view or edit any Calendar, create a new Calendar, and assign Custom Days to any Calendar.

Custom D | Lists all global Custom Days. From this list, you can view or edit any Custom Day, create a new Custom Day, and assign any Custom Day to any Calendar.

ays
Note
!
Custom Days displays in the Automation Center navigation pane only if the Custom Day Global Permitted Universal Controller system property is set to true.
Forecasts Lists of all Forecasts and Forecast Calendars.

Forecasts | Lists all Forecasts.

Forecast Displays a Forecast Calendar for enabled Time, Temporary, and Cron Triggers.
Calendar

Other Lists of task- and trigger-related information.

Credentials ' Lists all Credentials. From this list, you can view or edit any Credential, or create a new Credential.

Email Lists all Email Templates, which allow you to construct commonly-used information that can be copied to create Email tasks.
Templates
Scripts Lists all Scripts, which have been stored in the Controller database for execution by Windows, Linux/Unix, and SAP tasks. From this list, you can create and edit Script

records containing a script, and specify which tasks can use the script.
Variables | List all user-defined Global variables. From this list, you can view or edit any Global variable, or create a new Global variable.

Virtual Re | Lists all virtual resources defined in your system, which allow you to set up "throttling" schemes that will manage the number of specific tasks that can run at one time. From

sources this list, you can view, edit, and create a virtual resources, as well as assign tasks to a virtual resource.
Reports
Reports Lists all Report Details. From this list, you can view or edit any Report, or create a new Report.
Widgets Lists all Widgets. From this list, you can view or edit any Widget, or create a new Widget.
Colors Lists all Colors. From this list, you can view and edit the color assigned by default to any task instance status.
Lifecycle
Management
Bundles Lists all Bundles, which are groups of user-selected records that can be promoted from one Controller server to another.

Available if the user has the ops_bundle_admin or ops_promotion_admin role, or at least one Bundle Read permission assigned.

Promotion | Lists all Promotion Targets, which are the cluster nodes to which you can promote a Bundle.
Targets
Available if the user has the ops_promotion_admin or ops_bundle_admin role, or at least one Promotion Target Read permission assigned.

Promotion | Lists a history of all promoted Bundles.

History
Available if the user has the ops_promotion_admin or ops_bundle_admin role.
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https://docs.stonebranch.com/confluence/display/UC73/Calendars+Overview
https://docs.stonebranch.com/confluence/display/UC73/Creating+Custom+Days
https://docs.stonebranch.com/confluence/display/UC73/Creating+Custom+Days
https://docs.stonebranch.com/confluence/display/UC73/Calendars+Overview
https://docs.stonebranch.com/confluence/display/UC73/Properties
https://docs.stonebranch.com/confluence/display/UC73/Forecasts
https://docs.stonebranch.com/confluence/display/UC73/Displaying+Trigger+Forecast+Information#DisplayingTriggerForecastInformation-ForecastCalendar
https://docs.stonebranch.com/confluence/display/UC73/Credentials
https://docs.stonebranch.com/confluence/display/UC72x/Email+Task
https://docs.stonebranch.com/confluence/display/UC73/Scripts
https://docs.stonebranch.com/confluence/display/UC73/User-Defined+Variables
https://docs.stonebranch.com/confluence/display/UC73/Virtual+Resources
https://docs.stonebranch.com/confluence/display/UC73/Report+Details
https://docs.stonebranch.com/confluence/display/UC73/Widgets
https://docs.stonebranch.com/confluence/display/UC73/Colors
https://docs.stonebranch.com/confluence/display/UC73/Bundles+and+Promotion+Overview#BundlesandPromotionOverview-CreatingaBundle
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_bundle_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_promotion_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-BundlePermissions
https://docs.stonebranch.com/confluence/display/UC73/Bundles+and+Promotion+Overview#BundlesandPromotionOverview-CreatingaPromotionTarget
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_promotion_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_bundle_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-PromotionTargetPermissions
https://docs.stonebranch.com/confluence/display/UC73/Bundles+and+Promotion+Overview#BundlesandPromotionOverview-PromotionHistoryandtheRestoreOption
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_promotion_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_bundle_admin
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Agents

Connections

System
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Lists all scheduled Bundle promotions.

Available if the user has the ops_bundle_admin or ops_promotion_admin role, or at least one Bundle Read permission assigned.
Lists of Agent and Agent Clusters for each Agent type.

Lists all Agents Overview. From this list, you can view or edit any Agent resource record. You also can suspend/resume any Agent.

Lists all Linux/Unix Agents. From this list, you can view or edit any Linux/Unix Agent resource record, as well as suspend/resume any Linux/Unix Agent.

Lists all Linux/Unix agent clusters. From this list, you can view or edit any Linux/Unix agent cluster record, as well as suspend/resume any Linux/Unix agent cluster.

Lists all Windows Agents. From this list, you can view or edit any Windows Agent resource record, as well as suspend/resume any Windows Agent.

Lists all Windows agent clusters. From this list, you can view or edit any Windows agent cluster record, as well as suspend/resume any Windows agent cluster.

Lists all z/OS Agents. From this list, you can view or edit any z/OS Agent resource record, as well as suspend/resume any z/OS Agent.

Lists of all Connection types.

Lists all Email Connections, which provide all of the email server information necessary for the Controller to send emails. From this list, you can view, edit, and create Email
Connections, as well as specify the Email tasks that will use the server specified in the Email Connection.

Lists all Database Connections, which provide all the database server information necessary for the Controller to execute a SQL task or Stored Procedure task. From this
list, you can view, edit, and create Database Connections, as well as specify the SQL and Stored Procedure tasks that can use this Database Connection.

Lists all SAP Connections that have been defined in your system, which provide the SAP server information necessary for the Controller to execute an SAP task on an SAP
system.

Lists all PeopleSoft Connections that have been defined in your system, which provide the PeopleSoft server information necessary for the Controller to execute a PeopleSof
t task on a PeopleSoft system.

Lists of Universal Controller system-related records.

Lists all Applications that have been defined in your system and which can be monitored and controlled.

Lists all cluster nodes in your system. From this list, you can view Details of any cluster node and create Cluster Node Notifications.

Lists all Universal Message Service (OMS) servers. From this list, you can create a new OMS Server record and view Details of any existing OMS Server record. From
OMS Server Details, you can edit the record and display the list of Agents using this OMS Server.

Lists all SNMP Managers, to which SNMP notifications are sent.

Lists all OAuth Clients, which are used to integrate with an external application registered with an authentication server such as Azure AD or Google.


https://docs.stonebranch.com/confluence/display/UC73/Promotion+Schedules
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_bundle_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-ops_promotion_admin
https://docs.stonebranch.com/confluence/display/UC73/Roles+and+Permissions#RolesandPermissions-BundlePermissions
https://docs.stonebranch.com/confluence/display/UC73/Agents+Overview
https://docs.stonebranch.com/confluence/display/UC73/Linux+Unix+Agent
https://docs.stonebranch.com/confluence/display/UC73/Agent+Clusters
https://docs.stonebranch.com/confluence/display/UC73/Windows+Agent
https://docs.stonebranch.com/confluence/display/UC73/Agent+Clusters
https://docs.stonebranch.com/confluence/pages/viewpage.action?pageId=95697306
https://docs.stonebranch.com/confluence/display/UC73/Email+Connections
https://docs.stonebranch.com/confluence/display/UC73/Email+Task
https://docs.stonebranch.com/confluence/display/UC73/Database+Connections
https://docs.stonebranch.com/confluence/display/UC73/SQL+Task
https://docs.stonebranch.com/confluence/display/UC73/Stored+Procedure+Task
https://docs.stonebranch.com/confluence/display/UC73/SAP+Connections
https://docs.stonebranch.com/confluence/display/UC73/SAP+Task
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Connections
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Task
https://docs.stonebranch.com/confluence/display/UC73/PeopleSoft+Task
https://docs.stonebranch.com/confluence/display/UC73/Application+Resources
https://docs.stonebranch.com/confluence/display/UC73/Cluster+Nodes
https://docs.stonebranch.com/confluence/display/UC73/Cluster+Nodes#ClusterNodes-SendingNotificationsonStatusofaClusterNode
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Administration
Audits Lists all Audits that have been created for user interaction with the Controller.

Business Lists all Business Services. From this list, you can view or edit any Business Service, or create a new Business Service.
Services

Data Back | Lists all Data Backup/Purge records in your system, which specify the automatic back-up and purge of Controller activity data. From this list, you can view, edit, and create
up/Purge Data Backup / Purge records.

Filters Lists all record Filters for which the logged in user has permission. List filters are created using the filtering fields on the record list itself. Note that this feature is used only
for record lists, not the Activity Monitor. This feature allows you to update or delete existing filters.

Groups Lists all user groups that have been defined in your system.

LDAP Sett = Allows you to configure Lightweight Directory Access Protocol (LDAP) settings. See LDAP Settings.
ings

Password | Allows you to configure password specifications. See Password Settings.
Settings

Properties | Lists all Universal Controller system properties.

Server Op | Lists all Server Operations, which you can run to help maintain and administer your Controller installation.
erations

Single Sig | Allows you to configure SAML Single Sign-On settings. See Single Sign-On Settings.
n_
On Settings
Universal | Lists all Universal Templates, from which Universal Task types are created.
Templates
Available if the user has the ops_universal_template_view, ops_universal_template_admin, ops_admin, or ops_service role.
Universal Lists all global Universal Event Templates,
Event
Templates | For any global Universal Event, the Universal Template administrator must declare the Universal Event here to allow the event to be monitored by an Universal Monitor.
Users Lists all users that have been defined in your system.
Support

Support P Links to the Support page on the Stonebranch website.
ortal

Video Cla | Links to the Universal Controller Video Classroom, which provides demos of Controller features.
ssroom

Available Services Refresh

You can refresh the Navigation tree for any navigation pane at any time in order to refresh the displayed items in that tree. Refreshing the Navigation tree reloads the tree as if you were logging out and logging
in.

If you change the navigation visibility to one or more areas of a navigation pane for a user group, refreshing the navigation tree for that navigation pane will show those changes for any user in that group.
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Additionally, for the Automation Center navigation pane, any new Universal Task types that were created since user login, as well as any modifications made to the System Default Navigation pane by an
Administrator, will be displayed on the Automation Center navigation pane when the navigation tree is refreshed.

To refresh a navigation tree, right-click anywhere in the navigation pane and, in the Action menu that displays, click Refresh Navigation Tree. Any changes to the navigation pane will display.
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Records

® Introduction
® Naming Tips
Creating a Record
Opening a Record
Record Details
Record Details Fields
® Selecting Field Values
® Details Icon
® Field Hints
® Record Details Tabs
® Color-Coding of Tabs
® Re-Ordering of Tabs
® Complete Database Details
® Record Details Metadata
® Metadata Field Descriptions
® Performing Actions on a Record
® Updating a Record
® Copying a Record
® Printing a Record
® Deleting a Record
® Record Versioning
® Viewing Old Versions of Records
® Restoring Old Versions of Records
® Purging Old Versions of Records
® Enabling/Disabling Versioning
® Exporting and Importing Records
® Bulk Export/Import
® List Export/Import
® Updating Multiple Records
® Updating Manually Selected Records
® Updating Records That Match the Current Filter
® Update / Update Filtered Dialog Columns
® Update / Update Filtered Dialog Variable Fields for Tasks
® Uploading Records
® Downloading Records
® Download Manually Selected Records from a List
® Download Records That Match the Current Filter
® Download a Single Record from its Record Details

Introduction

A record is an entry in the Universal Controller database. Most records are created by the user via the user interface, but others (such as Agent records) are created by the Controller.

All system-supplied and/or user-supplied information about a record is contained in the record Details.

Naming Tips

Many functions within Controller are executed against one or more records.
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For example, you can assign a user permission to:

® Change only certain tasks.
® [ssue commands against a group of task instances.
® Filter a trigger list to display only certain triggers.

Two methods are available to help you organize your records to facilitate the use of these functions.

Method 1

Method 2

Develop a naming scheme for records.

For example, when naming tasks, you could prepend with SF all tasks related to San Francisco operations, or you could prepend with REPT all report-related tasks. With such a naming
scheme, you can sort and filter lists by selecting records, for example, that begin with "REPT." You can assign permissions and execute commands against records using the same method.

Use Business Services, which simply is a method of grouping records. Whenever you create a record, you can assign it to a Business Service.
For example, you could have a Business Service called "SF" and a Business Service called "REPT." Using this method, you could then filter or sort a list based on the Business Service. As

another example, you could assign permissions to a user, giving the user update permission to all records in the "REPT" Business Service. Business Services allow you to create groups based
on business functions and organize all your Controller records according to user-defined categories.

Creating a Record

Step 1 | Select arecord type from the appropriate navigation pane of the Services. The records list for that record type displays.

Step 2 | Either:

® Enter / select information for a new record in the empty Details that displays below the list.
® Click the New button that displays above the list to display an empty Details pop-up, and enter / select information for a new record.

Step 3 | Click the Save, Save & New, or Save & View button to save the record.

Note
1

You also can create a record by copying and renaming an existing record.

Opening a Record

Opening a record refers to the displaying of a record Details.

Note
1

Some actions (such as delete) can be performed on a record without opening the record.

Step 1 | Select arecord type from the appropriate navigation pane of the Services. The records list for that record type displays.
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Step 2 | Either:
® Click a record in the list to display its record Details below the list.

® Clicking the Details icon next to a record name in the list, or right-click a record in the list and then click Open in the Action menu that displays, to display a pop-up version of the record
Details.

® Right-click a record in the a list, or open a record and right-click in the record Details, and then click Open In Tab in the Action menu that displays, to display the record Details under a new
tab on the record list page (see Record Details as Tabs).

Record Details

When you select a record type from the Services, a list of records for that type displays. To the right of the list, an empty record Details for a new record of that type displays.

For example:

Dashboards ¥ % Linux/Unix Tasks ¥ *
- Unsaved 1 - = | A geTo + & e By +
Name ~ Description  Command or Script ~ Updated By ~ Updated - Linux|Unix Task 4 > -
stanebranch-linuxunixtask-01 Command ops.admin  2022-08-28 12:21:15 -0400 General .
[ stenebranch-linuxunixtask-02 Command ops.admin 2022-08-25 12:21:28 -0400 ame
stonebranch-linuxunixtask-03 Command ops.admin 2022-08-25 12:21:39 -0400

Hold Resources on Failure

Mutually Exclusive With Self

Agent Details

Cluster

Command

To see Details of an existing record, open the record.

For example:
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Linux/Unix Task Details: stonebranch-linux/unixtask-01

B 0 O @ LaunchTask [@ ViewParents

4]
Linux/Unix Task Variables Actions Virtual Resources Mutually Exclusive ® Instances Triggers Notes ® Versions
General
Name Version

stonebranch-linux/unixtask-0 2

Description

Member of Business Services

Hold on Start

Virtual Resource Priority Hold Rescurces on Failure
10

Mutually Exclusive With Self

Agent Details

Cluster

Agent Variable

-1.stene.branch - CNTLR-ORA

Credentials

Credentials Variable

Run as sudo

Record Details Fields

The following formatting applies to fields for all record types:

Fields with names followed by an asterisk ( * ) are required.

Gray fields are read-only.

White fields are editable. They may accept any value or only values selected from a drop-down list.
Some fields provide a drop-down list of values, which are the only selections available for that field.
Some fields contain a default value.

Some fields provide hints that describe value to be entered/selected for that field.

Selecting Field Values

Many fields provide a drop-down list of values for that field. These fields have a down arrow next to it, which you must click to display the list of values.

Additionally, drop-down list fields whose available values are records (as identified by a Details Icon), provide a filter for only listing records that contain the sequence characters that you enter in any of the
provided record fields.

In the following example, the drop-down list for Default Promotion Target lets you filter the list of Promotion Target records by Name or Description field:
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® - +
Bundle

Details

Name
stonebranch-bundle-0

Description

Member of Business

Default Promotion Target

romo

stonebranch
Name Description
stenebranch:

stonebra

stonebranch-p

Visible To

Details Icon

A Details icon displays next to a drop-down list field if the values available for that field are records.

® |f the drop-down list field contains a value (a record selected from the list), you can click the Details icon to view (and modify) that record.

® |f the drop-down list is empty, you can click the Details icon to create a record of that record type.

For example, every Trigger record contains a Calendar field whose value is the name of a Calendar selected from the drop-down list:

Temporary Trigger

General

Name *

onebranch-trigger-01

Description

Member of Business Services

Calendar i
System Default Server (America/New_York)

If you click the Details icon next to the Calendar field, the Details for that Calendar displays.
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Temporary Trigger

General Calendar Details: System Default o ox
Name * [ &

stonebranch-trigger-01 B [0 O @ CalendarPreview ”
Description Calendar Local Custom Days Custom Days @ Triggers ® Versions

R Details
Member of Business Service
Name * Version
System Default 2

Calendar *

Description
Default

Calendar

Task(s) *
Member of Business Services

Business Days

Sunday |v| Monday || Tuesday |+ nesday |v| Thursday || Friday Saturday
First Day Of Week
Sunday
Purge By Retention Duratior
1st Quarter Start

Jan 1
Forecast
2nd Quarter Start
Apr 1
Skip Details 3rd Quarter Start
Jul 1
Task Launch Skip Condition
— None — 4th Quarter Start
Oct 1
Temporary Details
Date * Keep Trigger

2022 - | Oct 10~ B

Field Hints
Fields hints describe the value to be entered/selected for that field.

To display a field hint, hover your cursor over the field value.

For example:

Temporary Trigger

General

Name
stonebranch-trigger-01

Description

Member of Business Services

Calendar * Time Zone

=
[%]
g

ver (America/New_York)

The calendar this trigger uses. Click the details icon to
Task(s)* | viewthe selected calendar.

&

No items to show.

®
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Record Details Tabs

The record Details for every record contains one or more tabs, including the default <record type> tab that provides detailed information about the record.

The currently selected tab displays in white. All other tabs display in gray.

Dashboards ¥ x Linux/UnixTasks ¥

B + @ T [ LaunchTask @ View Parents o o
Linux/Unix Task Variables Actions @ Virtual Resources Mutually Exclusive Instances Triggers Notes ® Versions

General

Name Version

stonebranch-linux/unixtask-0 2

Description

Member of Business Services

Hold on Start

Virtual Resource Priority Hold Resources on Failure
10

Mutually Exclusive With Self

Each tab displays a list of records that have been user-defined to be associated with the record. For example, the Triggers tab for a task would list any trigger records that specify this task in its trigger Details.
As appropriate for the type of record listed for a tab, the following also is provided:

® Details icon that allows you to view and edit Details for that record.

. + button that allows you to create a new record of that type and automatically associate it with the record whose Details are displayed in the <record type> tab.
When you click a tab to display a list of records associated with the current record, you can:

® View details about each record on the list.
® Create a new record of that type.

Color-Coding of Tabs

Tabs are color-coded:
® Current tab displays in white.
® Tabs that contain records display a green icon.
® Tabs that do not contain records display a gray icon.

For example, this Linux/Unix Task Details shows that there are one or more records under the Virtual Resources and Versions tabs:
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Dashboards ¥ x Linux/Unix Tasks #
® + 0O O @ launchTask [@ View Parents o o
Linux/Unix Task Variables Actions ® Virtual Resources Mutually Exclusive Instances Triggers Notes ® Versions
General
Narne Version
stonebranch-linux/unixtask-0 2
Description

Member of Business Services

Hold on Start

Virtual Resource Prioity Hold Resources on Failure
10

Mutually Exclusive With Self

Re-Ordering of Tabs

You can change the order of one or more tabs for a record type by clicking the tabs in any record of that type and dragging them left or right to a new position.
The tabs for all records of that record type will display in that order.

To restore the original order of the tabs, right-click any tab and click Restore Tab Order.

Any tab re-ordering that you apply is associated with your user own account. The re-ordering is automatically persisted in the Universal Controller database and will apply any time that you log into the user
interface.

Complete Database Details

The information displayed in the Details for any record is only a portion of the complete details for that record contained in the Controller database.
To see the complete details, right-click anywhere in the record Details to display an Action menu and then click Details > Show Details.
The database Details for all records contains the following fields:

uuID
Updated By
Updated
Created By
Created

The database Details for some record types (for example, any Task Instance record, as shown below) may show additional fields, such as Status History.
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After Date:

After Tirme:

Agent:

Agent Acquired:

Agent Acquired Marme:

Agent Cluster: | chSc8898a8fecssf003bosbsoa20514

Agent Cluster Aequired:

Agent Cluster Acquired Marme:

Agent Cluster Mame: | Opswise - Default Linux/Unix Cluster

Agent Cluster Unresolved:

Agent Cluster Variable: | falzz

Agent Marne:

Agent Unresoleed:

Agent Variable: | falzz

All Dependenches Cleared: | falzs

Attempe: |1

Auto Cleanup: | falze

Automatic Output File:

Automatic Output Retrieval: | -- None —

Average Estirmated End Time:

Before Date:

Before Time:

Calendar: | 7717143400a801c9016d5b2b5d17ddes

Calendar Marne: | Systern Default

Can Copy: | falss

Can Delete: | falz=

Can Update: | trus

Class: | ops_esxec_universal

Cluster: | trus

Computed Late Finish Tirme:

Compauted Late Start Time:

Content Type: | Text

CF Duration:

CP Duration (Resalved):

CP Duration Unit: | Minutes

CPU Tirme: (O

Created: | 2022-08-15 09:43:55 -0400

Created By: | Yan

Credentials:

[l RSP T Y S
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Credentals Unresolved:

Credentials Variable:

falzz

;| falze

Current Retry Count:

Date List:

Delay Duration:

D0:00:00:00

Delay Duration In Secomnds:

Delay On Start:

- Mone —

Description:

Duration:

Duwration In Seconds:

Early Finigh:

falzz

Earty Finish Day Constraint:

- None —

Early Finish Durathon:

D0:00-00:00

Early Finish Duration Offset [-):

Early Finish Duration Offset Unit:

Minutes

Early Finish Nth Amount:

5

Early Finish Offsat Type:

Percentage

Early Finish Percentage Offset (-]

D

Early Finish Tirme:

D000

Early Finish Type:

Time

En Tirme:

Environment Variables:

Evaluation Tirme:

Examiple Array:

Exarnple Boolean:

true

Example Choboe:

Medium

Exarmple Credentials:

Ba124dd32edasb3sh7ciefechdosodal

Exarnple Credentials Narme:

Application Credentials

Exarnple Integer:

7

Example Large Text:

Lorem ipsum dolor sit amet, consectetur adipisdng
elit, sed do efusmod termpor incididunt ut labore et
dolore magna aligua.

Example Script Data:

GfscodaTosedaei3afrdooba 34233838

Example Script Data Marme:

Application Data

Examipla Text:

Lorem |psum

Exclude Backup (Task Instance):

falzz

Exclusive State:

Imitizl

Execution Restriction:

- Mone —

Execution Lssar:
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Exit Cone:

D

Exit Code Processing:

Suocess Bxtcode Rangs

Exit Codes:

D

Extension Status:

Failure Only:

falzz

Finished Early:

falzz

Finished Late:

falzz

Forced Finished:

falzz

Highest Estimated End Tirme:

Hold on Start:

falzz

Hold Reason:

Hald Resources on Failure:

falzz

Instance Marme:

yantest

Instance Number:

1

Inwoked By:

Manually Launched

10 Other:

D

10 Reads:

o

10 Wirites:

D

Is Vershon:

falzz

Late Finish:

falzz

Late Finish Day Constraint:

- Mone —

Late Fintsh Duration:

D0:00-00:00

Late Finish Duraton Offset [+):

Late Finish Duration Offset Unit:

Minutes

Late Finish Mth Amount:

5

Late Finish Offsat Type:

Percentage

Late Finish Percentage Offset [+):

D

Late Finish Tirme:

D000

Late Finish Type:

Tirme

Late Start:

falzz

Late Start Day Constraint:

-- Mone —

Late Start Duration:

D0:00-00:00

Late Start Mth Amount:

5

Late Start Tirme:

D000

Late Start Type:

Time

Launch Source:

Lawnch Task [ User Interface

Lawnch Tirme:

2022-05-16 054555 -0400

Log Level:

Inherited

Lowest Estirmated End Tirme:

Bl i Dbl
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IFISAIEEILT PSR IS, |

Member of Business Serdces:

Member of Business Serdces:

Memaory Peak: |0

Memory Used: |0

Mutually Exclusive With Self: | falz=

Mext Retry Time:

Humber of Lines: | 100

Operational Menmo:

Operator: | =

Output File:

Output Type: | Standard Output

Path Expression:

Predecessors Satisfied Time:

Process [D:

Progress:

Projected End Tirme:

Projected Late: | falze

Queuved Time:

Resolhve Mame Immediately: | falss

Resources Consumed: | falzs

Resources State: | Initizl

[Restriction Perlod: | - None —

Retention Time:

Retry Exit Codes:

Retry Indefinitely: | falze

Retry Interval (Seconds): | 60

Run as sudo: | false

Run Called: | trus

Run Criteria Run Time: | false

Run Criteria Trigger Tirme: | falss

Run with Highest Privileges: | fals=

Runtirme Directory:

Scan Output For:

Scan Text:

Sacurity Narme:

Source Instanoe:

Sounce Instance Mame:

Source Version:

e

Start Line:

|
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Start Tirme:

Started Late: | false

State Changed Time: | 2022-08-15 019:43:55 -0400

Status: | Undeliverzble

Status Attributes:

Status Descripton: | No active Agents in the Cluster.

2822-98-16 B89:43:55 -pded: Defined

Status History: .
2822-98-16 B9:43:58 -8408: Undeliverable

Strategy: | Match Any

Suppress Intermediate Failures: |falzs

Tab Mames Containing Data:

Table Mame: | ops_sxec_universal

Task: | 0dE75dC0C0BT747313229460609306122

Task Marme: | yantest

Task Priority: | MEDIUM

Tirme Wait State: | Initizl

Time Zone: | Server

Tirme Zone Preferemce: | - System Default —

Trigger:

Trigger Marne:

Trigger Tirme:

Type: | Universal

Universal Template: | db1079661 20744 7fobbolecd26d5dasSa

Universal Ternplate Name: | Example

Updated: | 2022-08-15 019:43:55 -0400

Updated By:

User Defined Field 1:

User Defined Field 2:

User Estirmated End Tirme:

UUID: | 16503632000787367 1SMMYIESSPOBVUZ

Walue:

Wirtual Resource Priority: | 10

Wait Day Constraint: | - None —

Wait Durathon: | 00:00-00:00

‘Wait Duration In Seconds:
Wait For Output: | falzs
& Prnt | Refresh O

| Wait mmrl_'|—NunE—
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Record Details Metadata

The Action menu for every record Details contains a Details sub-menu. If you click Show Metadata on this sub-menu, a Metadata section displays at the bottom of the Details. (If Metadata is being displayed,

the Details sub-menu contains a Hide Metadata entry.)

Note
1

You can choose to display Metadata automatically via the Show Metadata Universal Controller system property, and you can override the Show Metadata property setting via the Show Metadata user

preference.
The Metadata for all records contains the following fields:

uuID
Updated By
Updated
Created By
Created

The Metadata for any Task Instance record, as shown below, also contains a Status History field.

Metadata
uuID
166515725551134663947Z6WSNSUNUYLO

Updated By

ops.admin
Updated

2022-10-10 17:20:14 -0400
Time Zone

Server (America/New_York)
Status History
Date
2022-10-10 17:20:02 -0400
2022-10-10 17:20:03 -0400
2022-10-10 17:20:04 -0400
2022-10-10 17:20:04 -0400
2022-10-10 17:20:04 -0400
2022-10-10 17:20:14 -0400

Created By
ops.admin

Created
2022-10-10 17:20:02 -0400

Status

Defined

Resource Requested
Queued

Started

Running

Finished

Metadata Field Descriptions

The following table describes the fields that display in the Metadata section of record Details.

Field Name Description

uuID Universally Unique Identifier of this record.
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Updated By Name of the user that last updated this record.

Updated Date and time that this record was last updated.
Created By Name of the user that created this record.
Created Date and time that this record was created.

Status History | Task instance only; History of all statuses that the task instance has gone through.

Performing Actions on a Record

You can perform many actions on a record by right-clicking anywhere in the the record Details to display an Action menu of all actions available for that record.
You also can perform many actions on a record (or multiple records) from a records list; that is, without having to open the record (see Performing Actions on a Record from a List).
Note

1
The actions available for a record when selecting an Action menu from the record Details may not be the same as the actions available when you select an Action menu from a list.

The following actions can be performed for all user-defined records:
Updating
Copying

Printing
Deleting

Updating a Record

Step 1 | Open the record that you want to update.

Step 2 | Make any desired updates to the record and click the Update button.
Note

1
If you change the name of a task that is part of a Workflow, the Controller automatically changes the name of that task within the Workflow itself.

Copying a Record
Step 1 | Open the record that you want to copy.
Step 2 | Inthe <record> Name field, enter a new name for the record.

Step 3 | Right-click in the Details and then click Insert on the Action menu. The displayed record becomes a copy of the record you selected and is added to the list.

Note

!
To copy a Report or Filter, you must use the Save As... button in the record Details, which lets you save the record under a different Title (for Reports) or Name (for Filters) and/or as being visible to different
users.
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Caution

Do ot use Insert to copy the following types of records unless you do not want to copy any records associated with them, such as Actions, Notes, and Variables. Using Insert does not copy any records
associated with these types of records:

Tasks

Triggers
Calendars
Scripts
Connections
SNMP Managers

To copy any of these record types and all of their associated records, use the methods described in:

Copying Tasks

Copying Triggers

Copying Calendars

Copying Scripts

Copying Email Templates
Copying Database Connections
Copying Email Connections
Copying PeopleSoft Connections
Copying SAP Connections
Copying SNMP Managers

Also, do not use the Update button to copy a record; the Update button overwrites the existing record.

Printing a Record

To print a hard copy of the Details of any record:

Step 1 | Either:

® Right-click the record in the records list and click Details > Print in the Action menu.
® Open the record, right-click in the record Details, and click Details > Print in the Action menu.

Step 2 = Select a printer and click OK.

Deleting a Record
Deleting a record removes it from the Controller database.

Step 1 | Either:

® Right-click a record in the records list and click Delete in the Action menu.
® Open the record and either:
® Click the Delete button.
® Right-click anywhere in the record Details and click Delete in the Action menu.

Step 2 | On the Confirmation pop-up that displays, click Yes.
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Record Versioning

Universal Controller maintains historical copies of most user-created records in the database. These include tasks and their associated records (virtual resources, variables, actions, notes), calendars and their
custom day associations, custom days, variables, credentials, virtual resources, scripts (and associated notes), email templates and connections, database connections, SNMP managers, SAP connections,

PeopleSoft connections, agent clusters, applications, Business Services, and triggers (and associated variables).

These historical copies - old versions of the current records - are read-only.

When you update any of these records, the Controller creates an image of the old version and stores it in the record's Versions tab. It also updates the Version field in the current version of the record. For
example, if you have updated a task three times, there will be three versions of that task stored in the Versions tab, and the current version will be identified as Version 4.

Although you can purge old versions of records, the Versions field in the current record always will show how many versions of the record have been created.

Viewing Old Versions of Records

To view old versions:

Step 1

Open the record Details for which you want to view old versions. The Version field indicates how many versions of this record have been made.

Dashioards ¥
®+ 0 0 L

Linux(Unix Task

General

Step 2

Dashboards # x

B+ M0 0 &L

Mutvally Exclusive © Instances Triggers Notes © Versions

The number of old versions that currently exist for this record is identified above the list.

Click the Refresh icon at any time to get the current list.
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Step 3 | Click the Details icon next to the Name of the version, or double-click anywhere in the version row, to displays Details for that version.

Linux/Unix Task Version Details: stonebranch-linux/unixtask-01 x

Linux/Unix Task Variables Actions Virtual Resources Mutually Exclusive Notes

General

Name Version
stonebranch-linux/unixtask-01 1

Description

Member of Bus

one Preference

Tim
— System Default —

Hold on Start

Virtual Resource Priority Hold Resources on Failure
10

Current Linux/Unix Task
stonebranch-linux/unixtask-01 EI

Agent Details

Cluster

Agent Agent Variable
qga-cntlr-ora-1.stone branch - CNTLR-ORA

Credentials Credentials Variable

Run as sudo

Linux/Unix Details

Command or Script
Command

All of the associated records (tabs) contain the data as it existed when this version was the current version. At the top of the Details, the Name field contains the name of the record as it existed for tt

Step 4 | Click Close to return to the version list.

Restoring Old Versions of Records

You can restore an old version of a record to the current version. When you restore an old version, the current version will become the newest old version.
Step 1 | Display the Details of the record for which you want to restore an old version.
Step 2 | Click the Versions tab.

Step 3 | Either right-click a Version record in the Versions list and then click Restore Version, or open a Version record and click the Restore Version button.

Fields Not Restored

The following fields are not restored when you restore an old version of a record.
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Record Type Fields

Trigger (all types}

Disabled By
Execution User
Forecast

Skip Count

Agent Cluster

Task Execution Limit
Current Task Count
Suspended

Limit Amount

Last Used

Application

Status

Status Description
Last Known Status
PID

Queued Time
Start Time

Last Query

Email Connection
® Use for System Notifications

Task (all types)
® Statistics (Statistics section in Task Details)

Workflow Task
® Calculate Critical Path

Virtual Resource
® Resource Used

Purging Old Versions of Records

The Controller provides two methods for purging old versions of records.

Note
!
When you purge old versions of records, the version number of the current version remains the same.

Purge Specific Versions

Step 1 Display the Details of the record for which you want to purge versions.
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Step 2 | Click the Version tab to display a list of old versions of that record.

Step 3 | Either:

® Citrl-click one or more versions to be purged, right-click in the row of any selected version, and click Delete.
* Display the Details of a version that you want to delete and click the Delete button.

Purge All Outdated Versions
Step 1 = From the Administration navigation pane, select Configuration > Server Operations. The Server Operations list displays.

Step 2 | Runthe Purge Versions server operation to purge versions that exceed the maximum number of records allowed, as defined by the System Default Maximum Versions Universal Controller
property.

Enabling/Disabling Versioning
Two properties are available that allow you to control if and when the Controller automatically creates a new version of a record (and all its associated records):
®* The Automatically Create Versions Universal Controller system property (true or false) determines whether modifications to the record itself will cause the Controller to create a new version of the
record. The default value is true. If this property is set to false, the Controller does not create versions.
® The Create Version On Related List Change Universal Controller system property (true or false) determines whether changes, deletions, or additions to a related list will cause the Controller to create a
new version of the record. For example, if this property is enabled, the Controller will create a new version of the task and all its associated records when the user adds a variable to the task, deletes a
Note, or changes an Email Notification. The default value is true. If this property is set to false, and the Automatically Create Versions property is set to true, the Controller creates a new version only if
the base record is updated.

To change one or both of these properties:

Step 1 | From the Administration navigation pane, select Configuration > Properties.
Step 2 | Locate the property you want to change.

Step 3 | Double-click the Value and select true or false.

Exporting and Importing Records

There are two different types of exports/imports:

® Bulk exports/imports let you export/import all records in a Controller database.
® List exports/imports let you export/import all records selected on a list.

Note

1
Critical Path settings for tasks and Workflows are not exported/imported.
Important!

It i@rongly recommended that you do NOT use the Import and Export functions for modification of Universal Controller records. API functions are available if you need to programmatically update, copy, insert,
or otherwise manipulate Universal Controller records.
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Bulk Export/Import

Universal Controller provides Server Operations (in Controller 5.2.0 and earlier: maintenance scripts) that allow you to perform a bulk export and bulk import of all records in your Controller database.

Normally, you would use bulk export and bulk import to migrate data, in bulk, from an existing Universal Controller deployment to a new Universal Controller deployment. If you are upgrading from Universal
Controller 5.2.0, you would also migrate data using bulk export and bulk import.

See:

® Run an Import
® Run an Export

List Export/Import

You also can perform a list export of records selected on a list, or a list import of an XML file to any list for a specific record type.

Updating Multiple Records

You can update multiple records from any of the following lists:

Agents list for any Agent type (Credentials field and Member of Business Services field only)

All Agents list (Credentials field and Member of Business Services field only)

Tasks list for any task type

All Tasks list

Triggers list for any trigger type

All Triggers list

Database Connections, Email Connections, PeopleSoft Connections, and SAP Connections lists
SNMP Managers list

Credentials list (all fields except Type and Key Location (FTP only))

Email Templates list

Global Variables list

Scripts list

Users (these fields only: Active, Command Line Access, Department, Locked Out, Manager, Password, Password Requires Reset, Time Zone, Web Browser Access, Web Service Access)
Virtual Resources list

There are two actions available for updating multiple records:

1. Update - Updates all manually selected records on the list.
2. Update Filtered - Updates all records that match the currently selected filter for the list.

Updates are applied and validated per selected record, since a valid update for one record may not be valid for another. A validation failure for one update does not prevent the update of other records.

Updating Manually Selected Records
Step 1 | Select the list from which you want to update multiple records.
Step 2 | Ctrl-click each record on the list that you want to update.

Step 3 | Right-click any of the selected records to display an Action menu.
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Step 4 | Click Update... to display the Update dialog, which lists every field that can be updated for that record type (since read-only fields cannot be updated, they are not displayed).

For example, the following Update dialog displays if you select multiple Linux/Unix Task records.

Update... x

Field Title Field Value Clear Field Value
After Date -~
After Time

Agent

Agent Cluster

Agent Cluster Unresclved
Agent Cluster Varizble

Agent Unresolved

Agent Variable

Automatic Output File
Automatic Output Retrieval
Before Date

Before Time

Cluster Broadcast

Cluster Broadcast Unresolved
Cluster Broadcast Variable
Command

Command or Script

CP Duration

CP Duration Unit

Credentials

Credentials Unresolved -

Update Cancel
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Step 5 | Forany field, click anywhere in the Field Value cell to display an editor where you can enter / select a value.

For example, if you click the Agent row, a drop-down list displays that lets you select any currently defined Linux/Unix Agent.

Update...

Field Title Field Value Clear Field Value

>

After Date
After Time

Agent |

Agent Cluster =

Agent Cluster Unresolved Name Type

Agent Cluster Variable

Agent Unresolved ga-cntlr-ora-1.stone branch - CNTLR-ORA Linux/Unix
Agent Variable garlin26s11-%x64 - LXS11%64 Linux/Unix
Automatic Output File

Automatic Qutput Retrieval

Before Date

Before Time

Cluster Broadcast

Cluster Breadcast Unresolved

Cluster Broadcast Variable

Command

Command or Script

CP Duration

CP Duration Unit

Credentials

Credentials Unresolved ~

Update Cancel

Step 6 | Ifyou want to clear the value of a field for each selected record and not select a new value, click the Clear Field Value check box.

Step 7 | Click the Update button to update all of the fields with the changed values.

Updating Records That Match the Current Filter
Step 1 | Select the list from which you want to update multiple records.
Step2 | Createa Filter to display only those records that you want to update.
Step 3 | Right-click the list header to display an Action menu.

Step 4 | Click Update Filtered.... A Confirm pop-up displays.
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Step 5 | Click OK to display the Update Filtered dialog, which lists every field that can be updated for that record type (since read-only fields cannot be updated, they are not displayed).

For example, the following Update Filtered dialog displays if you select multiple Linux/Unix Task records.

Update Filtered... X

Field Title Field value Clear Field Value

>

After Date

After Time

Agent

Agent Cluster

Agent Cluster Unresolved
Agent Cluster Variable
Agent Unresolved

Agent Variable

Automatic Output File
Automatic Output Retrieval
Before Date

Before Time

Cluster Broadcast

Cluster Broadcast Unresolved
Cluster Broadcast Variable
Command

Command or Script

CP Duration

CP Duration Unit
Credentials

Credentials Unresolved

Update Cancel
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Step 6 | Forany field, click anywhere in the Field Value cell to display an editor where you can enter / select a value.

For example, if you click the Agent row, a drop-down list displays that lets you select any currently defined Linux/Unix Agent.

Update Filtered...

Field Title Field Value Clear Field value

>

After Date
After Time

Agent ‘

Agent Cluster =

Agent Cluster Unresolved Name Type
Agent Cluster Variable

Agent Unresolved ga-cntlr-ora-1.stone branch - CNTLR-ORA Linux/Unix
Agent Variable ga-lin26s11-%x64 - LXS11X64 Linux/Unix
Automatic Qutput File

Automatic Qutput Retrieval

Before Date

Before Time

Cluster Broadcast

Cluster Broadcast Unresolved

Cluster Broadcast Variable

Command

Command or Script

CP Duration

CP Duration Unit

Credentials

Credentials Unresolved ~

Update Cancel

Step 7 | If you want to clear the current value of a field for each selected record and not select a new value, click the Clear Field Value check box.

Step 8 | Click the Update button to update all of the fields with the changed values.

Update / Update Filtered Dialog Columns

The following columns display on the Update / Update Filtered dialog:

Field Title Name of the field as displayed in the Record Details.
Field Value Value that you want to select for this field in all of the selected records.

Clear Field Value | Check box indicating whether or not to clear the value from this field when the record is updated. By default, this column is unselected for all
fields.

For fields that cannot be blank (for example, fields that demand a yes or no value), the check box will not be displayed.
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Since read-only fields cannot be updated, they are not displayed on the List.

If you are updating multiple records on the All Tasks list or All Triggers list, the Update / Update Filtered dialog contains only fields that are common to all types of tasks or triggers.

Note

1
When updating manually selected Universal Task records on the All Tasks list, the Update dialog will only contain mapped fields if all of the records have the same Universal Template UUID (that is, those
Universal Tasks were based on the same Universal Template).

Update / Update Filtered Dialog Variable Fields for Tasks
The Record Details for many individual tasks contain one or more Variable fields that allow you enter a variable instead of a record.
For example:

If you select Agent Variable in the Details for a single Linux/Unix task, the Agent field converts from a reference field (where you browse and select a record) into a text field that allows you to enter the variable.

In the Update / Update Filtered dialog for multiple tasks, the Agent field is not converted into a text field if you select Agent Variable. Instead, an additional field - Agent Unresolved - is provided, into which
you enter a variable, variable and text, or Agent name. The Agent field is not used.
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Update...

~

Field Title Field Value Clear Field Value
After Date |
After Time |
Agent |
Agent Cluster |
Agent Cluster Unresolved |

Agent Cluster Variable

Agent Unresclved | |

Agent Variable Yes

Automatic Output File |
Automatic Qutput Retrieval
Before Date

Before Time

Cluster Broadcast

Cluster Broadcast Unresolved
Cluster Broadcast Variable
Command |
Command or Script

CP Duration |
CP Duration Unit

Credentials |

Credentials Unresolved |

Update Cancel

Uploading Records

You can upload records (as contained in a zip and/or JSON file) from your local system to any of the following lists:

Agent Clusters list

Bundles list

Business Services list

Calendars list

Connections list (Database Connections, Email Connections, PeopleSoft Connections, and SAP Connections)
Credentials list
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Custom Days list

Email Templates list

OMS Servers list

Promotion Targets list
Scripts list

SNMP Managers list

Tasks list (for any task type)
All Tasks list

Triggers list (for any trigger type)
All Triggers list

Variables list

Virtual Resources list

The Upload operation takes a zip file (containing one or more files) or a JSON file.

® For a zip file, each JSON file in the zip file will parsed, and non-JSON files will be ignored.
® For a JSON file, the file is parsed to update/create a record.

Note
1
A zip can contain multiple files, where each file could be for a different record type. For example, the zip might contain two files; one file for a task and one file for a trigger. The zip file can be uploaded from any
list that supports upload (for example; tasks list, triggers list, and calendars list). When the zip file has been successfully uploaded, both the task record and the trigger record will be uploaded.
A JSON file contains data for one record type only. The export Tabl e property in the JSON file is used to identify the record type. Any file without this attribute will be ignored.

® For arecord type that supports download/upload, the JSON response from Read web service API contains the expor t Tabl e property.
® For a Read response from an older release, you must manually add the export Tabl e property in order to be upload compatible.

Step 1 | Right-click any column on any list that supports uploads to display an Action menu.

Step 2 | Click Upload... to display the Upload dialog.

Upload...
Definition(s) File *
| Choose File | No file chesen

Upload

Step 3 | Click Browse to Select a file to upload.

Step 4 | Click Upload to upload the selected file.

Downloading Records

You can download multiple records from a list (or download a single record from its record details) from any of the following lists:
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Agent Clusters list

Bundles list

Business Services list
Calendars list

Connections list (Database Connections, Email Connections, PeopleSoft Connections, and SAP Connections)
Credentials list

Custom Days list

Email Templates list

OMS Servers list

Promotion Targets list

Scripts list

SNMP Managers list

Tasks list (for any task type)

All Tasks list

Triggers list (for any trigger type)
All Triggers list

Variables list

Virtual Resources list

There are two actions available for downloading records from a list:

® Download
Downloads all manually selected records on the list.
® Download Filtered
Downloads all records that match the currently selected filter for the list.

There is one action available for downloading a single record from its record details:

® Download
Downloads the current record.

Download Manually Selected Records from a List
Step 1 | Select the list from which you want to download multiple records.
Step 2 | Ctrl-click each record on the list that you want to download.

Step 3 | Right-click any of the selected records to display an Action menu.

Step 4 | Click Download to download the selected records.

Download Records That Match the Current Filter

Step 1 | Select the list from which you want to download multiple records.
Step 2 | Create a Filter to display only those records that you want to download.

Step 3 | Right-click the list header to display an Action menu.
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Step 4 | Click Download Filtered.... A Confirm pop-up displays.

Confirm

@ Download 151 matching records?

| Download | Cancel

Step 5 | Click Download to download the matching records

Download a Single Record from its Record Details
Step 1 | Select the list from which you want to download a single record.
Step 2 | Open the record that you want to download.
Step 3 | Right-click anywhere in the record details to displays an Action menu.

Step 4 | Click Download to download the record.
Note

1
You also can download a single record by manually selecting it from the records list.
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Record Lists

Introduction
List Task Bar
Formatting a List
Sorting
® Sorting by Type
® Configure a Multi-Level Sort
® Filtering
® Selecting Columns / Column Locations for a List
® List Layouts
® Layouts Menu
® Selecting a Layout for a List
® Saving a Layout
® Saving a Layout As Your Default Layout
® Deleting a Layout
Adding Records from a List
Deleting Records from a List
Updating Multiple Records from a List
Uploading Records to a List
Downloading Multiple Records from a List
Performing Actions on One or More Records from a List
Exporting Records to an Output File
® Exporting Records to CSV, PDF, XLS (Excel), or XLSX
® Exporting Records to XML, XML (Export References), or Permissions for Group
® Importing Records from a File

Introduction

A record list is either a:

® Listing of records of the same type, such as tasks, calendars, or users.
® Listing of all records of the same type or category, such as all tasks or active triggers.

When you click a record type in the Services, a list of currently defined records for that record type displays.

List Task Bar

A task bar displays at the top of every list. For example:
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Dashboards ¥ x LinuxfUnixTasks ¥ x
[ =No Filter — | Qoo | + )
Name ~ Description Command or Script  Updated By  Updated -

[ stonebranch-linux/unixtask-01 Command ops.admin  2022-10-10 17:15:16 -0400
B stonebranch-linux/unixtask-02 Command ops.admin 2022-10-10 09:47:11-0400
[ stonebranch-linux/unixtask-03 Command ops.admin  2022-10-10 09:47:27 -0400
B stonebranch-linux/unixtask-04 Command ops.admin  2022-10-10 09:47:45 -0400
stonebranch-linux/unixtask-05 Command ops.admin  2022-10-10 10:17:19 0400

The following table describes the different elements that can appear on a list task bar and the function of each element:

Task Bar Element Function
. Allows you to apply an existing filter to the records on the list. The default selection is -- No Filter -- (no Filter is applied). Click the
- Mo Filter - down arrow to display a list of existing filters.

Allows you to create, view, or edit a filter that you can save or apply to the records on the list.

Allows you to create a quick record name filter that you can apply (but not save) to the records on the list.

Q,

I
(]
—
o

Allows you to create a new record of the record type displayed on the list.

Allows you to refresh any dynamic data displayed on the list.

)

Formatting a List

For every list in the user interface, an Action menu of formatting options is available.

To display the menu of formatting options, click the down arrow that appears over the Detail icons column.
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Auto Fit All Columns

Auto Fit

Columns...

Layouts >
Save Layout...

Save As Default Layout
Restore Default Layout

Import

Export >

For all lists, you can right-click any column header on the list to display an Action menu of formatting options preceded by sort actions for the selected column.
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Sort Ascending

Sort Descending
Configure Sort...

Auto Fit All Columns
Auto Fit

Columns...

Layouts >
Save Layout. ..

Save As Default Layout
Restore Default Layout
Import

Export *

See Action Menus for a description of these formatting and sort options.

Sorting

By default, lists are sorted by <record type> Name in ascending, alphanumeric order (0-9, a-z).
You can sort a list in ascending or descending order of the entries in any displayed column.
There are two ways to sort a list:
1. Click a column header; the list is sorted in ascending order of the entries in that column. A small arrow appears to the left of the column name to indicate the direction of sort. An up arrow indicates

ascending alphanumerical order; a down arrow indicates descending alphanumerical. Re-click the header to reverse the direction of sort.
2. Right-click a column header to display an Action menu and click either:
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® Sort Ascending
® Sort Descending

Sorting by Type
Type columns, such as Permission Type, Task Type, or Task Instance Status, are sorted by the Type underlying integer values, not alphabetically by the Type display names.

For example, if you sort the list of task instances on the Activity Monitor by Status, the list is sorted by the numeric Status Code, not the alphabetic Status Name:

Dashboards ¥ % Activity ¥ %
7 Task Instances 4D No time constraint ¥ # No quick filter v — No Filter ~ = (]

Instance Name Instance Number ~ Type
stonebranch-z/OStask-01 1 2/0s
stonebranch-z/OStask-01 2/0S
stonebranch-linux/unixtask-01 Linux/Unix

stonebranch-2/0Stask-01 2/0S

stonebranch-z, 2/0s

stonebranch-2/OStask-01 2/0s

AEEEEB B

stonebranch-2/0Stask-01 2/0s

Configure a Multi-Level Sort

You can use the Configure Sort action to create a temporary, multi-level sort for any column.

Click a column header to sort the list by the currently defined sort level of that column (default is column name in ascending order).

S
t
e
p
1

Right-click the same column header to display an Action menu.

S
t
e
p
2
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S | Click Configure Sort... to display the Sort dialog.
t
e
p Sort X
3
(® Add Level
Column Order
Sort by Status Ascending
Apply || Cancel
The Sort By row identifies the default Column and Order by which the list is sorted if you click the column header.
S | Click the Add Level or Copy Level button to add a Then by row to the list.
t
e
p SOI"t x
4
® AddLevel | O DeleteLevel I[] CopylLevel @
Column Order
Sort by Status Ascending
Then by Instance Name ~ || Ascending
Apply | Cancel
S  Select a Column and Order for Then by.
t
e
p
5
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Add as many sort levels as desired. To remove a level from the dialog (including the default level), select it and then click Delete Level. Use the up and down arrow buttons to re-arrange the order of the lev

Click Apply. The list is sorted according to the levels that you have defined. Numbers display next to the column headers, identifying the sort order.

S
t
e  For example:
p
7 PR ity ® %

4 Notime constraint ¥ | 4 No quick filter ~ | | ~NoFilter - = o

~  instance Number Status ~ 1

1

To remove the temporary sort levels for the column, either:

S

t

e ® Click anywhere in the list header row.

p ® Right-click the column header of the column you were sorting and click Clear Sort.
8

Filtering
You can apply a filter to a list so that it temporarily displays only records matching the filter criteria, and you can create and save a filter that can be applied at any time to the list.
You also can create a quick filter that will filter a list by full or partial record name.

For detailed information on creating and applying filters, see Filters.

Selecting Columns / Column Locations for a List

Initially, all lists display default columns of information in default locations. You can change a list to display any available column in any location.

The columns are based on the fields that exist for a record type in the Controller database; all fields that display in the user interface, including Metadata fields, are available as columns.

To select which columns you want displayed on a list:
Step 1 | Display the list.

Step 2 | Access the Action menu of list formatting options.

103 / uc-73x-uext


https://docs.stonebranch.com/confluence/display/UC73/Filters
https://docs.stonebranch.com/confluence/display/UC73/Records#Records-RecordDetailsMetadata

Universal Controller 7.3.x General Information

Step 3 | Click Columns... to display the Field Picker pop-up dialog.

Field Picker
Drag and drop or use arrows to move fields. Drag reorder ta change field order

Available Fields Visible Fields

Name ™ Sample Value - Field Title Sample Value

After Date 2 @
After Time I @ nstance Name  stonebranch-z/0Stask-01 @
Agent @ nstance Number 1 @
Agent Acquired Type z/0S @
Agent Cluster Acquired Status Finished

All Dependencies Cleared No

Attempt

Average Estimated End Time -

Apply Cancel

® The Available Fields window lists the fields that currently are not displayed on the list but are available for display.
® The Visible Fields window lists the fields that currently are displayed on the list (in left-to-right sequence).

Step 4 | Drag and drop fields between the Available Fields and Visible Fields windows, as appropriate for whichever fields you want displayed on the list.
You can drag and drop a field from the Available Fields window into any location in the Visible Fields window, and you can drag and drop any field in the Visible Fields window to a new location.

Fields dragged from the Visible Fields window to the Available Fields are automatically dropped into location based on alphabetical order.

Note
!
You also can:

®* Move any field between the Available Fields and Visible Fields windows by clicking the field and then clicking the > or < arrow.
® Relocate any field by dragging and dropping the corresponding column directly on the list.

Step 5 | Tofilter the fields listed in either window, enter characters in the text field above the Name column. Only fields containing that sequence of characters will display in the list.

Step 6 | Click the Apply button on the Field Picker dialog to save your relocation selections.

List Layouts

Every list displays in its System Default layout when you first log in to the Controller.

You can sort, filter, select, and/or relocate columns in a list, and save that configuration of the list as a new layout.

You can create any number of layouts for a list, and:
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® Pin any layout to a list, making it your Default layout whenever you display that list.
® Select any layout as a temporary layout for the list while it currently is being displayed.

To select a layout for a list, access the Action menu, which provides the following selections for saving and selecting list layouts:

Layouts > Displays a menu of all layouts, including the System Default layout, that you can apply to the list.
Save Layout... Saves the current configuration of the list as a new layout and displays the layout in the Layouts menu.
Save As Default Layout For the ops_admin role only; Saves the current configuration of the list as the System Default layout for this list.

Restore the Default Layout | For the ops_admin role only; Restores the System Default layout of this list to the original System Default layout.

Layouts Menu
The Layouts menu identifies all currently defined layouts for the list, including the System Default layout.

Layouts menu Icons:

Icon Description

!‘ Indicates that this layout has been pinned as the Default layout for this list.

D Lets you delete a layout (except the System Default layout).

v II_ndicates the list layout that currently is selected for the list. This layout will display for the list - including any modifications made since the layout was selected - until you close, and then re-open, the
ist.
For example:
Layouts > .~ System Default It
Save Layout... Taskinstance ¥ [

Save As Default Layout

Restore Default Layout

In this Layouts menu, the checkmark next to System Default indicates this is the currently selected layout.
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Selecting a Layout for a List

There are two ways to select a layout for a list:
1. Click the name of the layout in the Layouts menu. The check mark will display next to that layout, indicating that it is the currently selected layout for the list.
2. Click the Layout icon next to the layout. The Default Layout icon and the check mark will display next to that layout, indicating that it is the currently selected layout for the list and is pinned as the Defaul
t layout for the list.
Note

1
Pinning a layout as your Default layout also selects it as the currently displayed layout, but selecting a layout as the currently displayed layout does not pin it as your Default layout.

Saving a Layout

You can save any configuration of a list as a list layout.

Step 1 Select Save Layout... from the Action menu. A Save As... pop-up dialog displays.

Save As... .

Name *
Task Instance]

Pin Layout
v

Save Cancel

Step 2 | Enter a Name for the layout. (By default, the dialog displays the record type of the list as the Name.)

Step 3 | Select whether or not you want to pin the layout as your Default layout for this list.

You can display a layout for a list without pinning it as your Default layout by clicking the layout name in the Layout > menu. The list will display in the selected layout, but your Default layout will remain the
same.

Saving a Layout As Your Default Layout

To save a layout as your Default layout for a list, which pins the layout to the list, click the ‘! icon next to that layout in the Layouts menu.

Saving a layout as your Default layout for a list does not make that layout the System Default layout; it only means that for you, as the user that saved the layout, it is pinned as your Default layout for the list
whenever you display the list.

In the following example, Task Instance has been pinned as the your Default layout for the list, and System Default has been selected as the currently displayed layout.
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Layouts > ~ System Default It
Save Layout... TaskInstance ¥ [
Save As Default Layout

Restore Default Layout

Deleting a Layout

To delete a list layout, click the D icon that appears next to every layout (except the System Default layout, which cannot be deleted) in the Layouts menu.

If you delete a layout that is pinned as your Default layout for the list, the System Default layout automatically becomes your Default layout for the list.

Adding Records from a List

Adding a new record is a simple uniform procedure through the environment: from any list, click the + button.

Deleting Records from a List

To delete one or more records from a list of records:
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Step 1 | On the records list, Ctrl+right-click the records that you want to delete. Each selected record is highlighted.

For example:
Dashboards ¥ x Users
— No Filter - «|= | Q goTo. +
User Id (Username) ™ Name Locked Out  Active Updated By
[E stonebranch-user-01 stone a branch No ® ops.system
[El stonebranch-user-02 stone b branch No (O] ops.admin
[E stonebranch-user-03 stone ¢ branch No ®  ops.admin
[E stonebranch-user-04 stone d branch No ®  ops.admin
[E stonebranch-user-05 stone e branch No (O] ops.admin
Update...
Delete
Details >

Refresh

Step 2 | On the Action menu that displayed after you made your first selection, click Delete.

Step 3 | On the Confirmation pop-up that displays, click OK.
Note

1
You also can delete an individual record from its record Details (see Deleting a Record).

Updating Multiple Records from a List

You can update multiple records from any of the following lists:

Agents list for any Agent type (Credentials field and Member of Business Services field only)
All Agents list (Credentials field and Member of Business Services field only)

Tasks list for any task type

All Tasks list

Triggers list for any trigger type

All Triggers list

Credentials list (all fields except Type and Key Location (FTP only))

Email Templates list

Global Variables list

Scripts list

Users (these fields only: Active, Command Line Access, Department, Locked Out, Manager, Password, Password Requires Reset, Time Zone, Web Browser Access, Web Service Access)
Virtual Resources list

For detailed information on how to perform a multiple records update, see Updating Multiple Records.

Uploading Records to a List

You can upload records (as contained in a zip and/or json file) to any of the following lists:
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Agent Clusters list

Bundles list

Business Services list
Calendars list

Connections list (Database Connections, Email Connections, PeopleSoft Connections, and SAP Connections)
Credentials list

Custom Days list

Email Templates list

OMS Servers list

Promotion Targets list

Scripts list

SNMP Managers list

Tasks list (for any task type)

All Tasks list

Triggers list (for any trigger type)
All Triggers list

Variables list

Virtual Resources list

For detailed information on how to perform a multiple records upload, see Uploading Records.

Downloading Multiple Records from a List

You can download multiple records from a list (or download a single record from its record details) from any of the following lists:

Agent Clusters list

Bundles list

Business Services list
Calendars list

Connections list (Database Connections, Email Connections, PeopleSoft Connections, and SAP Connections)
Credentials list

Custom Days list

Email Templates list

OMS Servers list

Promotion Targets list

Scripts list

SNMP Managers list

Tasks list (for any task type)

All Tasks list

Triggers list (for any trigger type)
All Triggers list

Variables list

Virtual Resources list

For detailed information on how to perform a multiple records downloads, see Download Records.

Performing Actions on One or More Records from a List

You can perform many actions on one or more records on a list without having to open the record(s).

® For a single record, right-click the record on the list to display an Action menu of all actions available for that record.
® For multiple records, press Ctrl and right-click each record. An Action menu of all actions available for multiple records of that type displays.
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Note
!
The actions available for a record when selecting an Action menu from a list may not be the same as the actions available when you select an Action menu from its record Details.

Exporting Records to an Output File

This feature allows you to export record information for records on a list to any of the following file types:

CSV (comma-separated values in an Excel file)
Permissions for Group (XML for User Groups only)
PDF

XLS (Excel)

XLXS

XML

XML (Export References)

To export records, you first display the current list of those records.
By default, an export contains all records on the list. If you do not want to export all records on the list, use filtering to select the records to be exported.
Note

1
You cannot select records on a list manually to indicate which records are to be exported; you must filter the list in order to select the records.
Important!

It i@rongly recommended that you do NOT use the Import and Export functions for modification of Universal Controller records. API functions are available if you need to programmatically update, copy, insert,
or otherwise manipulate Universal Controller records.

Exporting Records to CSV, PDF, XLS (Excel), or XLSX

When you export to CSV, PDF, XLS (Excel), or XLXS, you export only the columns of information displayed on the list. To select which columns are displayed, see Selecting Columns / Column Locations for a
List.

To run the export:
Step 1 | Display the list of records.
Step 2 Right-click in any column header of the list to display an Action menu.
Step 3 = Select Export.
Step 4 | Select CSV, PDF, XLS (Excel), or XLXS.

Step 5 | When the export is complete, select whether to open or save the file.

Exporting Records to XML, XML (Export References), or Permissions for Group

When you export to XML, XML (Export References), or Permissions for Group (XML for User Groups only), you export the entire record.
Note

1
Exporting records to XML files requires the ops_admin role or the ops_imex role.
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To run the export:
Step 1 | Display the list of records.
Step 2 | Right-click in any column header of the list to display an Action menu.

Step 3 | Select Export.
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Step 4 Select either:

* XML
® XML (Export References)
® Permissions for Group

The following table provides notes on these export types for different record types.

Export Type Record Notes
Type
XML Task Also exported: local variables, Actions, Notes, and Virtual Resource requirements.
XML Workflow Also exported: all tasks in the workflow. Each task is exported to a separate XML file
XML (Export Task Also exported: all of the XML export data, plus triggers, global variables, calendars, credentials, and any resources referred to. These "reference"”
References) records are saved to separate XML file.
XML Universal Task

® Export does not include Universal Template XML.

® Any unmapped fields (for example: booleanFieldl, choiceFieldl) are excluded from the XML.

® For any mapped fields, the XML element includes both the Name and Label attributes. For example: <boolean_fieldl name="immediate" label="
Immediate">true</boolean_field1>

XML (Export Universal Task = Export includes:
References)
® Universal Template XML.
* Referenced Credentials, Agent Cluster, and Broadcast Cluster.
* Referenced Agent only if the Export Agent References Universal Controller system property (opswise.export.agent_references) is set to true.

For any other reference fields that might be inherited from the common Task definition (for example, System Operations), those references also will be

followed.
XML Universal Export includes the base Universal Template definition, along with as the Universal Template Field and Universal Template Field Value Maps data, in a
Template single XML per Universal Template.

XML (Export Universal Export includes:
References) Template

* Referenced Credentials, Agent Cluster, and Broadcast Cluster (under "Defaults" section).

* Referenced Agent only if the Export Agent References Universal Controller system property (opswise.export.agent_references) is set to true.
XML (Export Bundle Export includes:
References)

® Any Business Services referenced by the Member of Business Services field.
® Any Promotion Target referenced by the Default Promotion Target field.
® Any record added to the Bundle, including those records referenced by any record added to the Bundle.

Step 5 = When the export is complete, an Exported message displays above the list, indicating that the export is complete. (The export location is configurable; see the Export Path Universal Controller
system property.)

Importing Records from a File
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You can import record information from any valid XML file to a list using the Import action that is available for all lists.

® Any Universal Template XML found in the import directory will be processed prior to any other XML.

® Universal Template XML will be processed only if the Universal Template does not exist by name or sys_id. You can create a Universal Template via List Import, but you cannot update a Universal
Template via List Import; if the Universal Template exists, the Universal Template XML will be ignored.

® Any Universal Task XML must be validated to ensure that it conforms to the currently defined Universal Template it is associated with.

Note

!
Importing records from XML files requires either the ops_admin role or the ops_imex role.
Important!

It i@rongly recommended that you do NOT use the Import and Export functions for modification of Universal Controller records. API functions are available if you need to programmatically update, copy, insert,
or otherwise manipulate Universal Controller records.
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Action Menus

® Overview
® Accessing Action Menus
® Actions

Overview

Action menus contain a set of actions and commands that you can apply to a list of records or one or more individual records. The actions listed on an Action menu are context-sensitive; they appear only as
appropriate for the type of list or record (and as allowed by your User Permissions).

Accessing Action Menus

To access an Action menu:

For a List Right-click a column header to display an Action menu containing a set of actions that you can apply to that column or to the entire list.

For aRecord | Either:

® Right-click a record on a list.
® Right-click anywhere in the record Details.

The list of actions on an Action menu for a record may differ depending on whether you accessed the menu from the records list or from the record Details.

The following is a sample Action menu for an individual record selected on a list:
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- Mo Filter -

Failure Only

No
MNo
No
No
No
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Dashboards ¥ =

Linux/Unix Tasks *

vl = | Q cgoTo. |

Name ™

stonebranch-linuxunixtas’
stonebranch-linuxunixtas
stonebranch-linuxunixtas
stonebranch-linuxunixtas

stonebranch-linuxunixtas

Launch Task

Launch Task with Variables_ .

Open

Open In Tab

Copy

View Bundles

Add To Bundle...
Fromote...

Reset Statistics

Set Execution Restriction...
Clear Execution Restriction
View Parents

Update...

Download

Delete

Details

Refresh
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Actions

The following table identifies actions that can appear on Action menus throughout the Universal Controller user interface. The Availability column identifies the location(s) from where each action is available.

Most actions are available for multiple, if not all, record types. Some actions are available for specific record types; these actions are categorized alphabetically following the list of actions for multiple record
types:

Multiple Record Types
Agents and Agent Clusters
Applications

Bundles and Promotion
Calendars and Custom Days
Dashboards

Data Backup/Purge
Manual Task Instances
Reports

SAP Task Instances

Task Instances

Task Monitor Task Instances
Tasks

Triggers

Universal Templates
Users and Groups

Virtual Resources
Workflow Task Instances
Workflow Tasks

z/OS Task Instances

z/OS Tasks

Action Availability Description

Multiple Record Types

For any type | Adds this record to any existing Bundle.
AddTo Bundle... of record that
can be This action is enabled only if a user has the ops_bundle_admin role or at least one Bundle Update permission assignment.
added to a
Bundle: ® For a user with the ops_bundle_admin role, the Add To Bundle dialog allows selection of any pre-existing Bundle.
® For a user without the ops_bundle_admin role but at least one Bundle Update permission assignment, the Add To Bundle
®* Record dialog allows selection of pre-existing Bundles for which the user has Read permission.
on any
list
® Record

Details Only users with the ops_bundle_admin role or Update permission for the bundle can add definitions to the Bundle.
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Auto Fit

Auto Fit All Columns

Clear Sort

Close

Columns...

Configure Sort...

Copy

C5V

Details

Delete
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Lists

Lists

Lists

Record
Details
pop-up

Lists

Lists

Record
on any
list

Record
Details

Lists

Record
on any
list

Record
Details

Record
on any
list

Record
Details

Left-adjusts all columns in the list to their smallest size that still displays the full column name and column details for all records in
the list.
Adjusts all Auto Fitted columns back to their original size.

Clears the temporary sort levels that you created via the Configure Sort action.

Closes the Details pop-up of any record.

Displays a list of all available columns that can be displayed for this list. Click any column in the list to display / remove it.

Sorts a list according to temporary, user-defined sort levels for a column on the list (see Configure a Multi-Level Sort).

Creates a copy of the selected record, which you are prompted to rename.

Exports records on a list in CSV (comma-separated values in an Excel file) format (see Exporting Records to an Output File).

Displays a menu of the following actions:

Show/Hide Metadata
Show Details

Show Variables

Print

Deletes the selected record(s).

Downloads the selected record(s) to a zip file on your local file system.
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® Records
Download on any
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ers
list
® Tas
ks
lists
® Trig
ger
s
lists
® Vari
abl
es
list
® Virt
ual
Res
our
ces
list
® Record
Details
of these
record
types

Downloads all records in the list that match the current filter to a zip file on your local file system.

Download Filtered * Records

on any

of these

e Confirm
* Age

nt
Clu

Ster @ Download 5 matching records?

S
list

® Bun
dles

list

e Bus [ Download ] Cancel
ines
S
Ser

vices
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Export

Hide Metadata

Import

Insert

Layouts
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® Trig
ger

lists
® Vari
abl
es
list
® Virt
ual
Res
our
ces
list

® Lists

* All
record
Details

® Lists

* Al
record
Details
(except
task
instance
S,

Agents,

cluster

nodes)

® Lists

Exports records on a list in either of seven formats (as available for the type of record in the list):

Csv

Permissions For Group
PDF

XLS (Excel)

XLSX

XML

XML (Export References)

e o o o 0 o o

Hide Metadata for these Details.

Imports valid XML files (usually from an Export) from a user-defined location to a list.

Import performs a pre-validation on the XML files; if any files are found to be invalid, a warning displays on the Console and the
import operation is aborted. Any invalid XML files should be fixed or removed from that location.

Creates a copy of the current record, for which which you have just entered a new Name.

Displays a menu of available layouts for this list.
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MNew

Open

Open

Open In New Tab

Open InTab

PDF

Print

Promote...
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* Any
Details

* Any
record
on list

® Navigator

® Navigator

® Record
in list

® Record
Details

® Lists

® Record
in list

® Record
Details

For any type
of record that
can be
promoted:

®* Record
on any
list

® Record
Details

Displays empty Details for you to begin creating a new record.

Opens the Details pop-up of a record.

Opens a page right-clicked in the Navigator under the current tab. (If the current tab is for the Activity Monitor or Dashboard Details,
the page will open in a new tab (see Tabs).

Opens a page right-clicked in the Navigator under a new tab.

Displays the record Details under a new tab rather than as a pop-up (see Opening a Record).

Exports the displayed data (the selected columns) of every record on a list into PDF format (see Exporting Records to an Output File

).

Prints the record Details as shown in the user interface.

Copies this record from this source cluster node to a target cluster node.

The Promote... action is disabled unless a user has the ops_promotion_admin role or if the Bundleless Promotion With Execute
Permission Permitted Universal Controller system property is true and the user has at least one promotion target Execute
permission assignment.

® For a user with the ops_promotion_admin role, the Promote... dialog allows selection of any pre-existing promotion target.
® For a user without the ops_promotion_admin role, the Promote... dialog allows selection of pre-existing promotion targets for
which the user has Read permission.

The server will prohibit the user from promoting the definition using the promotion target if neither of the two conditions are met:

® The user has the ops_promotion_admin role.
® The user has Execute permission for the selected promotion target and the Bundleless Promotion With Execute Permission
Permitted Universal Controller system property is true.
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Refresh

Restore Default Layout

Save

Save & New

Save As Default Layout

Save Layout...

Show Details

Show Metadata

Sort Ascending

Sort Descending
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Record
Details

Lists

New,
unsaved
record

New,
unsaved
record

Lists

Lists

Record
on any
list

All
record
Details.

All
record
Details

Lists

Lists

Refreshes all dynamic information in the Details.

Restores the current layout of the list to its default layout.

Saves this record and, if the record is displayed in a pop-up dialog, closes the record.

(Same action as Save button on Details.)

Saves this record and displays empty Details for a new record.

(Same action as Save & New button on Details.)

Saves the current layout of the list as the default layout.

Saves the current layout of the list.

Displays all details stored in the database for this record in table format.

Display Metadata for these Details.

Sorts the list in ascending alphabetical order.

Sorts the list in descending alphabetical order.
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Selects the default layout for the list.

~ System Default X * Lists

Performs a connectivity test to the selected connection.
. " ® Emalil,

Test Connection Databas = (Same action as Test Connection button on Details.)

e, SAP,

and

PeopleS

oft

Connecti

ons lists

Updates the Details of any record and, if the Details are displayed in a pop-up dialog, closes the pop-up.
Upd: ® Record
paate Details (Same action as Update button on Details.)
(except
Cluster
Nodes)

Updates the Details of any record and continues to display the record.

Update & View * Record
Details
pop-up
(except
Cluster
Nodes)
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Update...

125 / uc-73x-uext

Agents
lists
Connecti
ons lists
(Databas
€,

Email,
PeopleS
oft, SAP)
Credenti
als list
Email
Templat
es list
SNMP
Manager
s list
Tasks
lists
Triggers
lists
Users
list
Variable
s list
Virtual
Resourc
es list

Updates all currently selected records in the list.
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Update Filtered...

126 / uc-73x-uext

Agents
lists
Connecti
ons lists
(Databas
€,

Email,
PeopleS
oft, SAP)
Credenti
als list
Email
Templat
es list
SNMP
Manager
s list
Tasks
lists
Triggers
lists
Users
list
Variable
s list
Virtual
Resourc
es list

Updates all records in the list that match the current filter.
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Upload...

View
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Agent
Clusters
list
Bundles
list
Business
Services
Calenda
rs
Connecti
ons lists
(Databas
€,
Email,
PeopleS
oft, SAP)
Credenti
als list
Custom
Days
Email
Templat
es list
OMS
Servers
list
Promotio
n
Targets
Scripts
list
SNMP
Manager
s list
Tasks
lists
Triggers
lists
Variable
s list
Virtual
Resourc
es list

Entries
on Edit
Member
s dialogs

Uploads all selected files.

Upload...

Definition(s) File *
|_ Browse... | Mo file selected.

Upload

Click Browse to select the file(s) that you want to upload.

Upload...

Definition(s) File *
|_ Browse... | Confluence-space-export-202922-606 xml zip

Upload

Click Upload to upload the selected file(s).

Displays detailed information about that entry.
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View Bundles

XLS (Excel)

XLSX

AML

XML (Export References)

Agents and Agent Clusters

Reset Agent Task Count

Reset Agent Cluster Task Count
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For any type
of record that
can be
added to a
Bundle:

Record
on any
list

Record
Details

Lists

Lists

Lists

Lists

Agents
list
Agent
Details

Agent
Clusters
list
Agent
Cluster
Details

Displays a list of bundles to which this record belongs.

This action is enabled only if a user has the ops_bundle_admin or ops_promotion_admin role, or at least one Bundle Read
permission assignment.

® For a user with the ops_bundle_admin or ops_promotion_admin role, the View Bundles list displays every Bundle containing
the definition.

® For a user with neither the ops_bundle_admin or ops_promotion_admin role, the View Bundles list displays every Bundle, for
which the user has Read permission, containing the definition.

Exports the displayed data (the selected columns) of every record on a list into XLS (Excel) format (see Exporting Records to an
Output File).

Exports the displayed data (the selected columns) of every record on a list into XLSX format (see Exporting Records to an Output
File).

Exports all data of every record on a list into XML format (see Exporting Records to an Output File).

Exports all data, plus references, of every record on a list into XML format (see Exporting Records to an Output File).

Resets the Current Task Count field for this Agent to 0.

Resets the Current Task Count field for this Agent Cluster to 0.
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Fesolve Agent Cluster

Resume Agent

Resume Agent Cluster

Resume Cluster Membership

Suspend Agent
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Agent
Cluster
on
Agent
Clusters
list
Agent
Cluster
Details

Agent
on
Agents
list
Agent
Details

Agent
Cluster
on
Agent
Clusters
list
Agent
Cluster
Details

Agents
in
Cluster
list

Agent
on
Agents
list
Agent
Details

If Distribution type for an Agent Cluster is Network Alias; Resolves the Network Alias for this Agent Cluster.

Resumes the ability to run tasks for suspended Agent.

(Same action as Resume Agent button on Agent Details.)

Resumes the ability to run tasks for a suspended cluster of Agents.

(Same action as Resume Cluster button on Agent Cluster Details.)

Resumes the membership of this Agent in the selected Agent Cluster.

Suspends the ability to run tasks for this Agent.

(Same action as Suspend Agent button on Agent Details.)
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Suzpcnd Agent Cluster

Suspend Cluster Membership

Applications

Query

Start

Stop

Bundles and Promotion

Bundle Report

Promote Bundle...
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Agent
Cluster
on
Agent
Clusters
list
Agent
Cluster
Details

Agents
in
Cluster
list

Applicati
onon
Applicati
ons list

Applicati
onon
Applicati
ons list

Applicati
onon
Applicati
ons list

Bundle
on
Bundles
list

Bundle
on
Bundles
list

Suspends the ability to run tasks for this cluster of Agents.

(Same action as Suspend Cluster button on Agent Cluster Details.)

Suspends the membership of this Agent in the selected agent cluster.

Queries the application (if it is running).

Starts the application.

Stops the application.

Displays a Bundle Report for this bundle.

(Same action as the Bundle Report button in Bundle Details.)

Copies this bundle from this source cluster node to a target cluster node.

(Same action as Promote Bundle button on Bundle Details.)
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Refresh Target Agents

Reschedule...

View Target Server Info

Calendars and Custom Days

Calendar Preview

List Qualifying Dates...
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Promotio
n
Targets
list
Promotio
n
Targets
Details

Promotio

n
Schedul
eon
Promotio

n
Schedul
e list
Promotio
n
Schedul
e Details

Promotio
n
Targets
list
Promotio
n
Targets
Details

Calenda
ron
Calenda
rs list
Calenda
r Details

Custom
Day
Details

Refreshes any Agents on the promotion target server selected in this record.

Reschedules a scheduled promotion.

(Same action as Reschedule... button in Promotion Schedule Details.)

Displays a Remote Server Information pop-up that lists details about the Automation Center cluster node selected as the promotion
target in this record.

Provides a month-by-month display of all Custom Days defined for this calendar.

Displays a table of the next 30 dates that match this Custom Day details.

(Same action as List Qualifying Dates button.)
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https://docs.stonebranch.com/confluence/display/UC73/Creating+Custom+Days

Universal Controller 7.3.x General Information

. . ] Displays a table of the next 30 periods that match this Custom Day details.
List Qualifying Periods * Custom
Day (Same action as List Qualifying Periods button.)
Details

Data Backup/Purge

Disable . Data Disables this scheduleddata backup/purge.
Backup
/Purge (Same action as Disable button on Details.)
record
on Data
Backup
/Purge
list

Enable ® Data Enables this scheduleddata backup/purge.
Backup

/Purge (Same action as Enable button in Details.)
record

on Data

Backup

/Purge

list

Run the selected backup or purge.
Run * Data

Backup (Same action as Run button in Details.)
/Purge

list

Terminates this scheduleddata backup/purge.
Terminate * Data , _ _ _
Backup (Same action as Terminate button in Details.)
/Purge

record

on Data

Backup

/Purge

list

Manual Task Instances
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Displays a menu of commands specific to Manual task instances:

Manual Task Commands ) * Manual
task ® Set Completed
instance ® Set Started
on
Activity
Monitor
| Task
Instance
s list

®* Manual
task
instance
Details

Sets this task instance to Success status.

Set Completed * Manual
task

instance
on
Activity
Monitor
| Task
Instance
s list

Resets the Started Time of this task instance.
Set Started * Manual

task

instance

on

Activity

Monitor

| Task

Instance

s list

OMS Servers

Resumes the connection of a suspended OMS Server.
Resume © OMS
Server
on OMS | (Same action as Resume button on OMS Server Details.)
Servers
list
* OMS
Server
Details
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Temporarily disconnects the OMS Server.
Suspend * oMs
Server
on OMS | (Same action as Suspend button on OMS Server Details.)
Servers
list
* OMS
Server
Details

Reports

Run the selected report.
Run ® Reports

list (Same action as Run button in Details.)
® Reports

Details

SAP Task Instances

Displays a menu of commands specific to SAP task instances:

SAP Task Commands > * sAP P P

task ® Abort SAP Job

instance ® Interrupt SAP Process Chain

on ® Purge SAP Job

Activity ® Restart SAP Process Chain

Monitor ® Retrieve SAP Job Definition

/ Task ® Retrieve SAP Job Log

Instance ® Retrieve SAP Job Status

s list ® Retrieve SAP Process Chain - Instance

* SAP ® Retrieve SAP Process Chain - Planned

task ® Retrieve SAP Process Chain Log

instance ® Retrieve SAP Process Chain Status

Details ® Retrieve SAP Spool List

Aborts the SAP job specified in the task instance.

Abort SAP Job * SAP

task

instance

on

Activity

Monitor

| Task

Instance

s list

* SAP

task

instance

Details
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Interrupt SAP Process Chain
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SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

Interrupts the SAP Process Chain.

Purges the SAP job specified in the task instance.

Restarts the SAP Process Chain.
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SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

Retrieves the SAP job definition.

Retrieves the SAP job log.

Retrieves the SAP job status.
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SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

Retrieves the specific run information for the SAP Process Chain.

Retrieves the "blueprint" information for the SAP Process Chain.

Retrieves SAP Process Chain log.
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Tabs

Pin

Auto

Close

Close Others
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SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

SAP
task
instance
on
Activity
Monitor
| Task
Instance
s list
SAP
task
instance
Details

All tabs
except
non-
replacea
ble tabs.

All tabs
except
non-
replacea
ble tabs.

All tabs.

All tabs.

Retrieves SAP Process Chain status.

Retrieves SAP spool list.

Pins the tab to the task bar.

Automatically pins the tab to the task bar upon login.

Close this tab from the task bar.

Close all other tabs except this tab.
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Close All

Task Instances

Cancel

Clear

Clear All Dependencies
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All tabs.

Task
instance
on
Activity
Monitor
/ Task
Instance
s list

Task
instance
on
Activity
Monitor
| Task
Instance
s list
Task
Instance
Details

Task
instance
on
Activity
Monitor

Task
instance
on
Activity
Monitor
| Task
Instance
s list

Close all tabs including this tab.

Cancels this task instance.

Note
1
Cancelling a Web Service task instance with Protocol = SOAP is prohibited.

Cancelling a PeopleSoft task instance cancels the PeopleSoft process itself, not the PeopleSoft task process. Once the Peoplesoft
process has been cancelled, its status will filter through to the PeopleSoft task.

Displays a menu of the following actions:

Clear All Dependencies
Clear Exclusive

Clear Resources

Clear Time Wait/Delay

Clears all dependencies (predecessors, resources, and exclusive) to allow the task instance to run.

Clears mutually exclusive dependencies of this task instance.
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Clears resource dependencies of this task instance.

® Task
instance
on
Activity
Monitor
/ Task
Instance
s list
Clears all Wait To Start and Delay On Start specifications for this task instance.
® Task
instance
on
Activity
Monitor
/ Task
Instance
s list
® Task
instance
Details
Delete ® Task Deletes the selected task instance if it is in any of the following statuses:
Instance
on ® |n Doubt (110)
Activity ® Failed to Start (120)
Monitor ® Confirmation Required (125)
| Task ® Cancelled (130)
Instance ® Failed (140)
s list ® Skipped (180)
® Finished (190)
® Success (200)
Note:
1
You cannot delete a task instance in any of these statuses if it was within a workflow task instance that itself has not been deleted.
Force Finish > ® Task Displays a menu of the following actions:
instance
on ® Force Finish
Activity ® Force Finish (Halt)
Monitor ® Force Finish/Cancel
/ Task ® Force Finish/Cancel (Halt)
Instance
s list
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Places this task into the Finished status.
Force Finish ® Task

instance

on

Activity

Monitor

| Task

Instance

s list

Places this task into the Finished status without aborting monitoring processes.
Force Finish (Halt) * Task

instance

on

Activity

Monitor

Cancels this task and places it into the Finished status.

® Task

instance

on

Activity

Monitor

/ Task

Instance

s list

Cancels this task and places it into the Finished status without aborting monitoring processes.
® Task
instance
on
Activity
Monitor

Places this task instance in the Held status
Hold ® Task

instance

on

Activity

Monitor

| Task

Instance

s list
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Releases this task instance from Held status.
Release ® Task

instance

on

Activity

Monitor

| Task

Instance

s list

Displays a menu of the following actions:
Re-run 2 * Task

instance ® Re-run

(except ® Re-run (Suppress Intermediate Failures)
Workflo

ws) on This menu is disabled if the task instance does not qualify for re-run.
Activity

Monitor

/ Task

Instance

s list

Re-runs this completed task.
Re-run ® Task

instance | For tasks not completed but scheduled for automatic retry, it re-runs the task and counts the re-run as one of the automatic retries.
(except

Workflo

ws) on

Activity

Monitor

/ Task

Instance

s list

Re-runs a task instance specifying that intermediate failures be suppressed. (See Re-run (Suppress Intermediate Failures)

® Task Permitted Universal Controller system property.)

instance

(except If the task instance qualifies for re-run, but it already has Retry Options enabled, the Re-run (Suppress Intermediate Failures)

Workflo = command will display as disabled in the menu.

ws) on

Activity

Monitor

/ Task

Instance

s list

Re-run (Suppress Intermediate Failures)

Retrieves standard out and/or standard error output for the following running or completed task instances: FTP File Monitor, Linux
Retrieve Output... ® Task /Unix, SAP, Universal Command, Windows, z/OS.

instance

in list
® Task

Instance

Details
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Run Command On Filtered >
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® Activity
Monitor

® Task
Instance
s List

Executes a selected command against all task instances that match the current filter.

® Clear
® Clear All Dependencies
® Clear Exclusive
® Clear Resources
® Clear Time Wait Delay
® Force Finish
® Force Finish
® Force Finish (Halt)
® Force Finish/Cancel
® Force Finish/Cancel (Halt)
Cancel
Hold
Release
Skip Path
Skip
Unskip
Rerun
Set Priority (High, Medium, Low)
Delete

Before the selected command is executed, a confirmation pop-up displays. For example:

Confirm

@ Clear All Dependencies using Filter that currently matches 142 Task Instances?

0K Cancel
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Displays a menu of run priorities that you can set for this task instance:
Set Priority » ® Linux
/Unix, ® High = Sets the run priority to High so that it will run before task instances in Low and Medium priorities.
Universa ® Medium = Sets the run priority to Medium so that it will run before task instances in Low priority and after task instances in
l, High priority.
ngh Windows ® Low = Sets the run priority to Low so that it will run after task instances in High and Medium priorities.
,and z
/0S
Task
instance
on
Activity
Monitor
/ Task
Low Instance
s lists
® Linux
/Unix,
Universa
l,
Windows
,and z
/0S
Task
instance
Details

Medium

Displays all variables currently available to the task instance, including those inherited from a workflow, those passed in from a
ShowVanables ® Task trigger, or those available globally.
instance
on
Activity
Monitor
/ Task
Instance
s list
® Task
Instance
Details

Places this task in the Skipped status.
‘_—,Ic;||:| ® Task

instance

on

Activity

Monitor

| Task

Instance

s list
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Skips this task instance and all of its dependent task instances.
Skip Path * Task

instance

on

Activity

Monitor

Removes the Skip status from this task.
Unskip * Task
instance
on
Activity
Monitor
| Task
Instance
s list

Displays a dialog identifying blocking ancestors of a waiting task instance in a Workflow, if any exist.
View Blocking Ancestors... ® Task
Instance = Only task instances that are in a workflow and have not started (that is: Defined, Waiting or Held status) will qualify.
Details
® Task
Instance
on
Activity
Monitor
/ Task
Instance
s list
® Task
Instance
on View
Blocking
Ancestor
S... pop-
up dialog

Displays the Workflow Monitor for the parent Workflow of a selected task instance and highlights that task instance within the
View In Workflow ® Task Workflow.
Instance
Details
® Task
Instance
on
Activity
Monitor
| Task
Instance
s list
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Displays the Workflow Task Instance Details of the parent Workflow, if applicable, of this task instance.

View Parent ® Task
Instance
Details

® Task
Instance
on
Activity
Monitor
/ Task
Instance
s list

Displays a dialog identifying the predecessors / successors of this task instance in the Workflow, if any exist.

View Predecessors/Successors * Task
Instance
Details

® Task
Instance
on
Activity
Monitor
| Task
Instance
s list

® Task
Instance
on View
Predece
ssors
/Success
ors pop-
up dialog

Task Monitor Task Instances

For task instances in Running status; Displays a list of running task instances that have the potential to match the specifications for
View Potential Matches. .. ® Task tasks being monitored by the running Task Monitor task instance.
Instance
Details
® Task
instance
on
Activity
Monitor
/ Task
Instance
s list
* Workflo
w
Monitor

Tasks
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Clears any Execution Restrictions that have been set for this task.
Clear Execution Restriction ¢ I"_'ftSkS
ists
® Task
Details
Launches the task.
Launch Task ® Taskon | (Same action as Launch Task button in Task Details.)
Tasks
list
Launches this task with one or more variables that you will specify on a Task Variables pop-up dialog.
Launch Task with Variables... ® Task
Details
Resets the run-time statistics that the Controller has gathered for this task.
Reset Statistics * Task
Details
) ] Executes a selected command against all tasks that match the current filter.
Run Command On Filtered 3 e All
Tasks ® Launch Task
list ® Add To Bundle
® Tasks ® Promote
list (all ® Reset Statistics
task ® Delete
types)
Before the selected command is executed, a confirmation pop-up displays. For example:
Confirm w0
@ Launch Task using Fitter that currently matches 23 Windows Tasks?
oK Cancel
Allows you to sets Execution Restrictions for this task.
Set Execution Restriction... ® Tasks
lists
® Task
Details
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Displays a list of all parent workflows, if any, of this task.
View Parents ® Tasks
lists (Same action as View Parents button on Task Details.)
® Task
Details
Triggers
Displays a dialog that lets you select an execution user that overrides the execution user of task instances being launched by the
Assign Execution User.... ® Trigger trigger.
on
Triggers = Users not assigned the ops_admin role must provide the execution user credentials (User ID and Password) in order to assign the
list execution user to the trigger.
® Trigger

Details Users must have the Assign Execution UserTrigger permission in order to assign an execution user.

Disables this trigger.
Disable ® Trigger
record (Same action as Disable button on Details.)
on
Triggers
list
® Trigger
Details

Enables this trigger.
Enable * Trigger
record (Same action as Enable button on Details.)
on
Triggers
list
® Trigger
Details

Allows for the forecasting of a Workflow by specific date/time.

Forecast... ® Workflo
w on
Workflo
ws list

® Workflo
w Details

® Trigger
on
Workflo
w
Triggers
tab list

Lets you modify and display a list of qualifying times for this trigger (the next 30 dates and times when this trigger will be satisfied).

List Qualifying Times... * Trigger
Details
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Recalculates the forecast data for this trigger.
Recalculate Forecast * Trigger
on
Triggers
list
® Trigger
Details
Executes a selected command against all triggers that match the current filter.
Run Command On Fittered 3 * Triggers
list ® Enable
® Disable
® Assign Execution User...
® Unassign Execution User...
® Set Skip Count...
® Recalculate Forecast
® Add To Bundle...
® Promote...
Note
!
® Enable and Disable are not valid for Active and Manual Triggers.
® Disable is not valid for Manual Triggers.
® Set Skip Count is not valid for Manual and Temporary Triggers.
® Recalculate is valid only for the following lists: All Triggers, Active Triggers, Cron, Time, and Temporary.
Before the selected command is executed, a confirmation pop-up displays. For example:
Confirm *
@ Recalculate Forecast using Filter that currently matches 50 Triggers?
OK Cancel
Lets you perform a Set Skip Count action if you have the Set Skip Count Trigger permission, Update permission, or both.
Set Skip Count... ® Trigger
on
Triggers
list
® Trigger
Details
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Irigger Mow:...

Unassign Execution User

Universal Templates

Deselect All

Load
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® Trigger
on
Triggers
list

® Trigger
Details

* Trigger
on
Triggers
list

® Trigger
Details

® List
/Load
Built-In
Universa
|
Templat
es
server
operation

® List
/Load
Built-In
Universa
|
Templat
es
server
operation

Immediately triggers all the tasks specified in this trigger.
(Same action as Trigger Now... button on Trigger Details.)
Optionally, you also can select to:
® Launch the task(s) specified in the trigger with one or more variables.
® Launch the task(s) specified in the trigger by a specified date and time.
® Launch the task(s) specified in the trigger but place them in Held status; they will not run until they are released.

Note

1
If a Trigger Now... command is issued for an Enabled trigger that does not have an assigned Execution User, the trigger will launch
its task(s) under the context of the user that enabled the trigger.

If a Trigger Now... command is issued for a Disabled trigger that does not have an assigned Execution User, the trigger will launch
its task(s) under the context of the user that issued the Trigger Now... command.

If a Trigger Now... command is issued for an Enabled or Disabled trigger that has an assigned Execution User, the trigger will
launch its task(s) under the context of the assigned Execution User.

Unassigns an execution user that had been selected to override the execution user of task instances being launched by the trigger.

Users must have the Assign Execution UserTrigger permission in order to unassign an execution user.

Deselects all templates on the List/Load Built-In Universal Templates server operation list.

Loads all templates on the List/Load Built-In Universal Templates server operation list to the Universal Templates list.
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Restores the default Universal Task icon to all Universal Tasks based on this Universal Template.

o I

Restore Default lcon universa
Templat
eon
Universa
I
Templat
es list

® Universa
I
Templat
e Details

Selects all templates on the List/Load Built-In Universal Templates server operation list.
. ® List

Select All oad

Built-In

Universa

|

Templat

es

server

operation

Users and Groups

Exports user groups and their permissions (see Exporting Records to an Output File).

Permissions For Group . Srft)ur’s
IS

Virtual Resources

Resets the Resource Used value of a renewable virtual resource to accurately reflect the actual number of resources currently in

- * i
Reset Virtual Resource X'é‘s“(f‘u'm use:

e Details

Workflow Task Instances
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Displays a menu of the commands specific to Workflow task instances:
L]

Workflow Task Commands > wgzﬂo
instance
on
Activity
Monitor
/ Task
Instance
s list

® Workflo
w task
instance
Details

Release Recursive
View Children
View Tree

View Workflow

Releases this Workflow, and all of its task instances on Held Status, from Held status.
Release Recursive * Workflo

w task

instance

on

Activity

Monitor

| Task

Instance

s list

Displays all children task instances of this Workflow task instance (and children task instances of any sub-Workflow task instance)

. . ® Workflo | and, optionally, their Predecessors and Successors within this Workflow.
View Children w task

instance

on

Activity

Monitor

/ Task

Instance

s list
* Workflo

w task

instance

Details
* Workflo

w

Monitor
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View Tree

View Workflow

Workflow Tasks
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Workflo
w task
on
Workflo
w tasks
list
Workflo
w task
Details
Workflo
w Editor
Workflo
w
Forecast
Workflo
w
Monitor
Workflo
w
Vertex
in
Workflo
w Editor
/
Workflo
w
Forecast

Workflo
w task
instance
on
Activity
Monitor
| Task
Instance
s list
Workflo
w task
instance
Details

Displays a tree view of this workflow task instance and its tasks, including children tasks of any sub-Workflow task, and, optionally,
lets you display the Details for any of those tasks.

Displays the Workflow Monitor for this Workflow task instance.

(Same action as View Workflow button on Details.)
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Workflow Task Commands

>

Clone...

Edit Workflow
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Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details

Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details

Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details

Displays a menu of the commands specific to Workflow tasks:

Clone

Edit Workflow
Forecast

Recalculate Forecast
View Children

View Tree

Creates a copy of the Workflow, a copy of each task in the Workflow, and - optionally - copies of its Virtual Resources.

Displays the Workflow Editor for this Workflow.
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Recalculate Forecast

Forecast...
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Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details

Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details
Trigger
on
Workflo
w
Triggers
tab list

Recalculates the forecast data for this workflow.

Allows for the forecasting of a Workflow by specific date/time.
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View Children
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Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details
Workflo
w Editor
Workflo
w
Forecast
Workflo
w
Vertex
in
Workflo
w Editor
/
Workflo
w
Forecast

Displays all children tasks of this Workflow task (and children tasks of any sub-Workflow task) and, optionally, their Predecessors,
Successors, and Task Run Criteria within this Workflow.
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View Tree

z/OS Task Instances

z/]OS Task Commands

Deselect for Re-run
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Workflo
w task
on All
Tasks
list
Workflo
w task
on
Workflo
w Tasks
list
Workflo
w task
Details
Workflo
w Editor
Workflo
w
Forecast
Workflo
w
Vertex
in
Workflo
w Editor
/
Workflo
w
Forecast

z/0S
task
instance
Details

z/IOS
task
instance
Details

Restarta
ble Job
Step tab
of z/0OS
Task
Instance
Details

Displays a tree view of this workflow and its tasks, including children tasks of any sub-Workflow task, and, optionally, lets you
display the Details for any of those tasks.

Displays a menu of the following actions:

® Confirm JCL Changes

Deselects the selected job step(s) from being included in a z/OS job re-run.
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Select for Re-run

Select for Re-run (Force)

Select to End for Re-run

z/OS Tasks

z/O5 Task Commands
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Restarta
ble Job
Steps
listinz
/0S
Task
Instance
Details.
Restarta
ble Job
Steps
Details

Restarta
ble Job
Steps
listinz
/0S
Task
Instance
Details.
Restarta
ble Job
Steps
Details

Restarta
ble Job
Steps
listinz
/0S
Task
Instance
Details

All
Tasks
list
z/0S
Tasks
list
z/0S
Task
Details

Selects the selected job step(s) for inclusion in a z/OS job re-run.

Selects the selected non-Restartable job step(s) for inclusion in a z/OS job re-run.

Selects the selected job step and all following job steps for inclusion in a z/OS job re-run.

Displays a menu of the following actions:

® Reset Override Statistics
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Reset Override Statistics
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* Al
Tasks
list

® 7/0OS
Tasks
list

® z/OS
Task
Details

Reset the override statistics used for automated JCL override clean-up.
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Action URLs

Overview

open Action URL
open_workflow Action URL
run_report Action URL

Overview

Action URLs let you automatically perform actions in the user interface.

There are three action URLs:

Name Action
open Navigates to a specific record in the user interface.
open_workflow ' Navigate to a specific Workflow Monitor/Editor graph in the user interface.

run_report Runs a Report and displays the report output without navigating to the Report record.

To use an action URL:

1. Verify that the URL Action Parameter Enabled Universal Controller system property is set to true (the default).
2. Append the action URL to the URL of the Universal Controller Login page or Home page.

If you do not have an authenticated browser session, regardless of the URL that you specify, you will be redirected to the login page to authenticate. Once authenticated, the action URL will proceed.

If you have an authenticated browser session, and you are entering the action URL from an already loaded application page/browser tab, the application page/browser tab will be reloaded, comparable to a
browser refresh, and all unsaved changes will be lost, including any open application tabs.

open Action URL
The open action URL lets you automatically navigate to a specific record.
You must append the open action URL to the Login page or Home page URL in the following format: ?act i on=opené&t ype=<r ecord t ype>& d=<UUl D>

The open action URL contains the following parameters:

Name Value

action  open
type Type of record to open.

id UUID of the specific record to open.
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Examples:
® Login Page
http://localhost:8081/uc/login.jsp?action=open&type=task&id=b93b64075a49419eal9b74faaa864320
® Home Page
http://localhost:8081/uc/?action=open&type=task&id=b93b64075a49419eal9b74faaa864320

The following table provides:

® List of the record types that you can navigate to with the open action URL.
® type parameter value for each record type.

Parameter values with a V suffix, such as credentialV, let you navigate to any previous record version of that record type by using the UUID of that version.

Record Type
Agent
Agent Cluster
Application
Audit
Business Service
Calendar
Cluster Node
Credential
Custom Day
Data Backup/Purge
Database Connection
Email Connection
Email Template
History
OMS Server
PeopleSoft Connection
Report
SAP Connection
Script
SNMP Manager

Task
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t ype Parameter Value
agent
agentCluster, agentClusterV
application, applicationV
audit
businessService, businessServiceV
calendar, calendarV
clusterNode
credential, credentialV
customDay, customDayV
backup
databaseConnection, databaseConnectionV
emailConnection, emailConnectionV
emailTemplate, emailTemplateV
history

omsServer

peoplesoftConnection, peoplesoftConnectionV

report

sapConnection, sapConnectionV
script, scriptV

snmpManager, snmpManagerV

task, taskV
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Task Instance exec

Trigger trigger, triggerV

Variable variable, variableV

Virtual Resource virtualResource, virtualResourceV
Widget widget

open_workflow Action URL

The open_workflow action URL lets you automatically navigate to a specific Workflow Monitor/Editor graph in the user interface.

You must append the open_workflow action URL to the Login page or Home page URL in the following format: ?act i on=open_wor kf | ow& ype=<record type>& d=<UUl D>

The open_workflow action URL contains the following parameters:

Name Value
action  open_workflow
type Type of record to open.

id UUID of the specific record to open.

Examples:
® Login Page

http://localhost:8081/uc/login.jsp?action=open_workflow&type=task&id=b93b64075a49419eal9b74faaa864320

® Home Page
http://localhost:8081/uc/?action=open_workflow&type=task&id=b93b64075a49419eal9b74faaa864320

The following table provides:

® List of the record types that you can navigate to with the open_workflow action URL.
® type parameter value for each record type.

Record Type type Parameter Value
Workflow Task task

Workflow Task Instance & exec

run_report Action URL

The run_report action URL lets you automatically run a Report and display the report output without navigating to a specific Report record.
You must append the run_report action URL to the Login page or Home page URL in the following format: ?act i on=r un_r epor t & d=<UUl D>

The run_report action URL contains the following parameters:
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Name Value

action | run_report

id UUID of the specific Report record for which you want to run a report.

Examples:

® |Login Page
http://localhost:8081/uc/login.jsp?action=run_report&id=bfe8a7df83b64c90876dfce6ecfabOaba

® Home Page
http://localhost:8081/uc/?action=run_report&id=bfe8a7df83b64c90876dfce6cfabOaba
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User Preferences

® Selecting User Preferences
® User Preferences Field Descriptions

Selecting User Preferences

You can select your own preferences for the display of information on the Controller Activity Monitor and the Universal Automation Center Console.
Step 1 On the User task bar, click the User Actions drop-down list arrow to display a menu of user actions.
admin v+ @ O @

Edit Frofile

Change Password
User Sessions
Preferences

Logout

Step 2  Click Preferences. The User Preferences dialog pops up.
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User Preferences

Name

Activity Monitor Automatically

Activity Refresh Rate

Activity Results Per Page

Activity Time Constraint

Agent Task Instances Tab Time Constraint
Audit Time Constraint

Boolean Column Display Format

Console Error Fade Out Delay

Console Info Fade Out Delay

Console Location

Conscle Open For Info

Dashboard Force Refresh On Focus
Dashboard Force Refresh On Focus Threshold
Go To Operator

History Time Constraint

MNode Time Display

MNode Time Display Background Color
MNode Time Display Color

MNode Time Display Time Zone

Pin Tabs Automatically

Reference Picker Display Columns
Services Recently Visited Limit

Show Metadata

Show Variables Fetch Global Automatically
Target Task Instances Tab Time Constraint
Task Instances Tab Time Constraint

Task Instances Time Constraint
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Value

Mo

10 seconds

25 per page

Last 48 hours

Last 48 hours

Last 48 hours
Yes/No

)

3

Bottom

Yes

Mo

30 seconds
contains

Last 48 hours

-- System Default --
-- System Default -
-- System Default --
-- System Default -
Mo

2

10

-- System Default --
-- System Default --
Last 48 hours

Last 48 hours

Last 48 hours




Trigger Task Instances Tab Time Constraint Last 48 hours

Use Dashboard Visibility lcons -- System Default --

Use Default Dashbeoard For Home No

User Interface Density -- System Default -

User Interface Theme -- System Default -- o
Submit Cancel

Universal Controller 7.3.x General Information

Step 3 Using the field descriptions below as a guide, change any of the User Preferences, as desired.

Step 4 Click the Submit button.

User Preferences Field Descriptions

The following table describes the fields that display on the User Preferences pop-up dialog.

Name

Activity Monitor
Automatically

Activity Refresh Rate
Activity Results Per Page
Activity Time Constraint

Agent Task Instances Tab
Time Constraint

Audit Time Constraint

Boolean Column Display
Format

Console Error Fade Out
Display

Console Info Fade Out
Display

Console Location

Console Open For Info
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Description

Specifies whether or not the Activity Monitor automatically monitors Controller activity.

Frequency that dynamic data is refreshed on the Activity Monitor.
Number of task instances that display on a single page of the Activity Monitor
Time frame, starting with the current time, for which activity data is listed on the Activity Monitor and Task Instances list.

Time frame, starting with the current time, for which instance data is listed on the Task Instances tab of a specific Agent.

Time frame, starting with the current time, for which audit data is listed on the Audits list.

Specifies whether Boolean columns on lists will be in Yes/No or enabled/disabled (check box) format.

Specifies how long the Console will stay open after displaying an error message.

Specifies how long the Console will stay open after displaying an informational message.

Location of the Console that displays when you click the Console icon.

Specifies whether or not the Console will open automatically to display informational messages.
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Dashboard Force Refresh Forces a refresh of all Widgets in a Dashboard when the Dashboard is re-focused (that is, the user tabs back to the Dashboard). Whether a Widget qualifies for a refresh
On Focus depends on the configuration of the Dashboard Force Refresh On Focus Threshold user preference.
Warning
Depending on user behaviour, enabling this user preference could increase the load on Universal Controller by ultimately increasing the number of and frequency of Widget
refreshes.
Dashboard Force Refresh If the Dashboard Force Refresh On Focus user preference is Yes, when re-focusing an already open Dashboard, each Widget in the Dashboard will be refreshed immediately
On Focus Threshold if the last refresh time of the Widget exceeds this threshold (Default is 30 seconds).
Go To Operator Specifies the default operator for the Go To filter:
® contains
® starts with
® equals
History Time Constraint Time frame, starting with the current time, for which history data is listed on the History list
Node Time Display Specifies whether to use the currently defined system default for whether or not to display the Cluster Node time in the User Task Bar, or to select Yes or No.
Note

1
For a change in Cluster Node time visibility to take effect, you must re-login or click your browser refresh button. In either case, all unsaved changes will be lost, including any
open application tabs.

Node Time Display Specifies whether to use the currently defined system default as the background color of the Cluster Node time in the User Task Bar or select another color.
Background Color

Node Time Display Color Specifies whether to use the currently defined system default as the color of the Cluster Node time in the User Task Bar or select another color.

Node Time Display Time Specifies whether to use the currently defined system default for the cluster node time zone in the User Task Bar, or to use the time zone of the Server or User.
Zone

Pin Tabs Automatically Specifies whether or not to pins tabs automatically.

® |f No (default):

® Users must pin their own tabs.

® Once atab is pinned, a tab will not be replaced by a new tab being opened and will remain designated as pinned between a user's sessions.

® Pinned tabs are identified with a pin icon displayed in the tab.

® Tabs are pinned by DataSource; therefore, once you pin a type of tab (for example, Reports,) any time you open Reports in a tab, it will be designed as pinned.
® If Yes:

® All tabs will be pinned automatically, no pin icon will be displayed, and legacy tab behavior will be applied.

Reference Picker Display Where applicable, if additional information is available for Controller records in drop-down lists, the columns of information displayed for each record:
Columns

® 1 =Record name only.

® 2 =Record name and type.

® 3 =Record name, type, and ID or Description.

[ ]

All = (Same as 3.)
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Services Recently Visited
Limit

Show Metadata
Show Variables Fetch
Global Automatically

Target Task Instances Tab
Time Constraint

Task Instances Tab Time
Constraint

Task Instances Time
Constraint

Trigger Task Instances
Time Tab Constraint

Use Dashboard Visibility
Icons

Use Default Dashboard For
Home

User Interface Density

User Interface Theme
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Maximum number of Services that will display in the Recently Visited column for Available Services in the user interface.
If the number of recently visited Services exceeds this number, the earliest of the recently visited Services will be dropped from the column.
Default is 10.

Specifies whether to use the currently defined system default for whether or not the Metadata section displays automatically in the the Details of all Controller records, or to
override the system default by selecting Yes or No.

Specifies whether to use the currently defined system default for whether or not to fetch and display Global Variables automatically for the Show Variables action, or to override
the system default by selecting Yes or No.

Time frame, starting with the current time, for which target task instance data is listed on the Target Task Instances tab of a Recurring Task instance.

Time frame, starting with the current time, for which instance data is listed on the Instances tab of a specific task.

Time frame, starting with the current time, for which instance data is listed on the Task Instances list.

Time frame, starting with the current time, for which task instances display on a trigger Instances tab.

Specifies whether to use the currently defined system default for whether or not to include visibility indicator icons in the Dashboard tabs that display at the bottom of the
Dashboards page, or to select Yes or No.

Specifies whether you want to use the currently selected default Dashboard as the Home dashboard for this user (Yes) or use the system-defined default Dashboard as the
Home dashboard (No).

Warning

WeStrongly encourage you to maintain the system-defined default Dashboard as your Home dashboard. At login, all Widgets on the Home dashboard will be loaded. By
keeping the system-defined default Dashboard, you will maintain a more consistent and optimal login process.

Specifies whether to use the currently defined system default for the user interface density, or to select another density.

Specifies whether to use the currently defined system default for the user interface theme, or to select another theme.
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Wildcards and Regular Expressions

® Introduction
® Wildcards
® File Name Examples
® Regular Expressions
® File Name Examples
® String Examples

Introduction

Universal Controller supports the use of wildcards and regular expressions in the user interface and remote interfaces.

For files, wildcards and regular expressions can be used only in:

® Source file specifications, not destination file specifications. (Under some operating systems, it is possible for * and ? to be valid characters in a file name. If they appear in a destination file, they are
treated as file characters, not as wildcards or regular expressions.)
® File name portion of file specifications, not as part of the directory.

Wildcards

Universal Controller supports two wildcards:

® Asterisk (*)
® Question mark (?)

You can use wildcards in record searches and when applying some rule or command against records. Fields that support wildcards are identified in their field description.

Wildcard Meaning
Asterisk (*) Represents a wildcard of any number of characters.
For example, a search for string "FEE*SF" returns all records whose name begins with "FEE" and ends with "SF", with any number and type of characters between the two strings.
Question mark (?) Represents a wildcard of one character in a specific position.
For example, a search for string "FEE?SF" returns all records whose name begins with "FEE" and ends with "SF", with any single character between the two strings.
Multiple questions marks | Represent wildcards of multiple characters in a specific position.

For example, a search for string "FEE??SF" returns all records whose name begins and ends with "FEE" and "SF", respectively, with any two characters between the two strings.

File Name Examples

File Names
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. test.txt

testl. txt
test2. txt
test3.txt
test.bin

testl.bin
. test2.bin
test3.bin

PNOO B LN R

Wildcard Matches

* * % test*.* andtes?**. will match all of the files.
* . txt will match files 1 - 4.

* . bi n will match files 5 - 8.

test ?. t xt will match files 2 - 4.

Regular Expressions

Important!

PC@X Extended Regular Expression syntax is used for file name matching and string matching.
Note
!
You can use regular expressions only on Windows and UNIX operating systems; you cannot use them on z/OS.

File Name Examples

File Names

. test.txt

. testl.txt
test2. txt
test3.txt
test.bin

testl.bin
. test2.bin
test3.bin

PNOUA®NE

Regular Expression Matches

.+,tes. +,and t e. +[ t n] $ will match all of the files.
.+t xt $ will match files 1 - 4.

. +bi n$ will match files 5 - 8.
te..[123]. +bi n$ will match files 6 - 8.

String Examples

C:\UDM\TEST\OUT\LinuxSystem.[D](20)[1-9][1-9][0-1][0-9][0-3][0-9][.][T][0-2][0-9][0-5][0-9][0-5][0-9].* = Matches C:\UDM\TEST\OUT\LinuxSystem.D20171001.T235159.*
C:\UDM\TEST\OUT\LinuxSystem.[D][1-9][1-9][0-1]{0-9][0-3][0-9][.][T][0-2][0-9][0-5][0-9][0-5][0-9].* Matches C:\UDM\TEST\OUT\LinuxSystem.D171001.T235159.*

C:\UDM\TEST\OUT\LinuxSystem.[D](20)[1-9][1-9][0-1][0-9][0-3][0-9][.][T][0-2][0-9][0-5][0-9][0-5][0-9].* | Fails C:\UDM\TEST\OUT\LinuxSystem.D2017201033.7235159.* month 20 day 33!
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C:\UDM\TEST\OUT\LinuxSystem.[D][1-9][1-9][0-1][0-9][0-3][0-9][.][T][0-2][0-9][0-5][0-9][0-5][0-9].* Fails C:\UDM\TEST\OUT\LinuxSystem.D171001.T266159.* hour 26 minutes 61!

171 | uc-73x-uext



Universal Controller 7.3.x General Information

Access Keys

® Overview
® Access Key Combination
® Access Keys

Overview

In a web browser, access keys allow you to immediately jump to specific sections of a web page using only the keyboard.

To use an access key, press the access key in combination with one or more other keys, as defined by the browser, in order to focus an element on a page.

Access Key Combination

The following access key combinations, which vary for different browsers / platforms, are implemented in Universal Controller:

Browser Platforms Access Key Combination

Mozilla Firefox = Windows, Unix = Alt+Shift + access key

Mozilla Firefox = Mac Ctrl+Opt + access key
Chrome Windows, Unix = Alt + access key
Chrome Mac Ctrl+Opt + access key

Access Keys

The following access keys are pre-defined in Universal Controller:

Access Key Description

G Focuses the Go To... button on any list so that the Go To Filter dialog can be displayed by pressing Enter.

172 | uc-73x-uext


https://docs.stonebranch.com/confluence/display/UC73/Filters#Filters-GoToFilter

Universal Controller 7.3.x General Information

Troubleshooting

Troubleshooting

Troubleshooting information is categorized into two areas:

® Problem Resolution
® Error Messages
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Problem Resolution

® Problem Resolution
® Database
® |nstallation
® Operations

Problem Resolution

This page provides links to problems, and their solutions, that you might encounter with Universal Controller.

Database

Error in your SQL syntax

Maximum open cursors have been exceeded
Out-of-Range Value during Database Initialization
JDBC Connections Time Out

DB2 JDBC License Error

Installation

Processes Will Not Start Automatically (Debian Linux)

Error when Starting Controller

Tomcat Post Limit: STATUS_MAX_POST_SIZE_EXCEEDED
Special Characters not Displayed Correctly

Open JRE Dependency not Installed

Operations

Cannot launch a task

VBScript stuck in "Running" state

My Universal Controller License has Expired

Packet for query is too large

Invalid login credentials for refreshing target agents

Invalid Call Error: Invalid call to setDataSource()

Permanent Generation (PermGen) space removed in Java 8
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Error in your SQL syntax

Problem

When you execute an SQL task that includes multiple SQL commands, the following error message (for example) may display:

I NSERT | NTO uc_deno (name, value) values ("A, '"F);
I NSERT | NTO uc_deno (name, value) values ('B, 'S);
I NSERT | NTO uc_deno (nane, value) values ('C, 'F);

Solution

Multiple queries, by default, are disabled for MySQL. To enable multiple queries, append the following string to the Connection URL field in the Database Connections resource definition:

?al | owMul ti Queri es=true

The following example is a URL connection string for a MySQL Database Connection resource definition:

jdbc: mysql ://1 ocal host: 3306/ uc?al | owVul ti Queri es=true
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Maximum open cursors have been exceeded

Problem

During large imports on Oracle, you could receive following error message:

ORA- 01000: maxi num open cursors exceeded

(The cursors are used only during the import; they then are closed.)

Issue the following sql*plus utility command to check the current value for maximum open cursors:

show par anmet er open_cursors

A listing similar to the following will display:

SQL> show paraneter open_cursors;

NAVE TYPE VALUE
open_cursors i nt eger 1000
Solution

An open_cur sor s value of 1000 should be sufficient for all large imports.

You can temporarily set the open_cur sor s value with the following SQL:

al ter system set open_cursors=1000

To make a permanent change, you must set the open_cur sor s value in the initialization parameters file.
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Out-of-Range Value during Database Initialization

Problem

During the database initialization performed on initial start-up, you could receive the following message:

The conversion of a varchar data type to a datetinme data type of the value is out of range.

The problem likely is that the database was created in SQL SERVER Management Studio with a user that has other than English as the default language.

Solution

Verify the installed default language and set the language to U.S. English.

To check what default language a server has installed, use the following SQL command:

sp_configure 'default |anguage'

If the resulting value is not 0, the default language is not U.S. English. Run the following SQL command to find the installed default language setting and date format used:

sel ect name , alias, datefornat
from sysl anguages

where langid =
(sel ect value from master..sysconfigures
where comment = 'default |anguage')

To set the default language to U.S. English, use the following SQL statements:

sp_configure 'default |anguage', O
reconfigure with override

For further details, refer to this Microsoft Support page.
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JDBC Connections Time Out

Problem

JDBC connections from Linux to MS SQL Server 2008 R2/Windows 2008 R2 time out after 40 seconds causing SQL/Stored Procedure Tasks that take longer than 40 seconds to fail with the following
exception:

2014-09-22-14: 51: 37: 034 -0400 ERROR [ Ops. General . 15. EP. Sgl Handl er . ecd8ab62183f 4b9dbf 32d3ead4ad0al26. 74b824adlca84142a40d3eclf 84d4d2b. 0]
SQLSer ver Exception - Connection reset
com microsoft.sql server.jdbc. SQLServer Exception: Connection reset
at com m crosoft.sql server.jdbc. SQLServer Connecti on. term nat e( SQLSer ver Connecti on. j ava: 1667)
at com m crosoft.sql server.jdbc. SQL.Server Connecti on. t erm nat e( SQLSer ver Connecti on. j ava: 1654)
at com m crosoft.sql server.jdbc. TDSChannel . read(| OBuf fer.java: 1789)
at com m crosoft.sql server.jdbc. TDSReader . readPacket (| OBuf f er.j ava: 4838)
at com m crosoft.sql server.jdbc. TDSConmand. st art Response( | OBuf f er. j ava: 6150)
at com m crosoft.sql server.jdbc. SQLServer Prepar edSt at enent . doExecut ePr epar edSt at enent ( SQLSer ver Pr epar edSt at enent . j ava: 402)
at com m crosoft.sql server.jdbc. SQLSer ver Prepar edSt at enent $Pr epSt nt ExecCnd. doExecut e( SQLSer ver Pr epar edSt at enent . j ava: 350)
at com m crosoft.sql server.jdbc. TDSConmand. execut e( | OBuf f er. j ava: 5696)
at com m crosoft.sql server.jdbc. SQLServer Connecti on. execut eConmand( SQLSer ver Connecti on. j ava: 1715)
at com m crosoft.sql server.jdbc. SQ.Server St at enent . execut eConmand( SQLSer ver St at enent . j ava: 180)
at com m crosoft.sql server.jdbc. SQ.Server St at enent . execut eSt at enent ( SQLSer ver St at enent . j ava: 155)
at com m crosoft.sql server.jdbc. SQLServer Prepar edSt at enent . execut e( SQLSer ver Pr epar edSt at ement . j ava: 332)
at com stonebranch. opswi se. server. events. Sql Event Handl er. st or edPr oc( Sql Event Handl er . j ava: 266)

Resolution

To disable TCP Chimney Offload, follow these steps:
Step 1 Use administrative credentials to open a command prompt.
Step 2 | Atthe command prompt, enter the following command: net sh int tcp set gl obal chi mey=di sabl ed

Step 3 Press ENTER:.

For additional information, see:

http://support.microsoft.com/kb/951037
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DB2 JDBC License Error

Problem

A SQL or Stored Procedure task using a DB2 Database Connection may fail with the following error message:

The 1BM Data Server for JDBC and SQ.J license was invalid or was not activated for the DB2 for z/OS subsystem If you are connecting
directly to the data server and using DB2 Connect Unlimted Edition for Systemz, performthe activation step by running the activation
programin the license activation kit. |If you are using any other edition of DB2 Connect, obtain the license file, db2jcc_license_cisuz.jar,
fromthe license activation kit, and follow the installation directions to include the license file in the class path.

Solution

The db2j cc_l i cense_ci suz. j ar file needs to be included in the classpath for Universal Controller.

Step 1 | Copy the db2j cc_l i cense_ci suz. j ar file to the following directory:

Windows
[tontat-install]\webapps\uc\VEB-INF\Iib

UNIX
[tontat-install]/webapps/uc/ VEB-INF/Iib

Step 2 | Restart Universal Controller.
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Processes Will Not Start Automatically (Debian Linux)

Problem
For Debian Linux environment: Outboard 5.1.0 processes will not start automatically at boot time.

Debian Linux does not provide the chkconfig command and therefore cannot work with the runlevels specified in the opsagent, opstransport, opsmsghub scripts provided in/ etc/init. d.

This is a known problem; we are working on a solution.
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Error when Starting Controller

Problem

Upon starting the Universal Controller, the opswi se. | og shows ERR:

SQLSTATE: HY000, SQLERR 1040, ERRVSG [uni xODBC][ MySQL][ODBC 5.1 Driver] Too nany connections

Solution

You must set additional connections in your database server:

MySQL - /etc/ny.conf - max_connections=500 (default is either 100 or 150)
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Tomcat Post Limit - STATUS_MAX_POST_SIZE_EXCEEDED

Problem

The following error message displays:
The server did not receive the data that was sent to it. Please see the docunentation for isc. RPCResponse. STATUS_MAX_POST_SI ZE_EXCEEDED
Resolution

Remove the post limit by specifying the following attribute on the <Connector> elementin conf/server. xm :

maxPost Si ze="-1"
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Special Characters not Displayed Correctly

Problem

Some special characters not getting displayed correctly in your browser GUI.

Resolution
Tomcat on Windows requires you to define code page UTF-8 as the default code page for war files.
To do this, add the following to the Java options statement just as you did with the memory parameter:

-Dfil e. encodi ng=UTF8
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Open JRE Dependency not Installed

Problem

If Universal Controller produces an exception similar to the following when exporting a dashboard widget or generating a scheduled chart report, a required dependency may not be installed.

java. |l ang. Nul | Poi nt er Excepti on
at sun. awt . Font Confi gur ati on. get Ver si on( Font Confi guration.java: 1264)
at sun. awt. Font Confi gurati on. readFont Confi gFi | e( Font Confi gurati on. java: 219)
at sun. awt . Font Confi gurati on.init(FontConfiguration.java: 107)
at sun.awt. X11Font Manager. cr eat eFont Confi gur ati on( X11Font Manager . j ava: 774)

When using the j ava- 1. 8. 0- openj dk- headl ess package from the EL7 repository, it did does not include a required dependency; specifically, f ont confi g.

Solution

Installing the f ont conf i g dependency, along with its own dependencies, will resolve the issue.

yuminstall fontconfig

Alternatively, you can use the non-headless package, j ava- 1. 8. 0- openj dk.
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Cannot launch a task

Problem
You cannot launch a task.

The problem may be with your credentials. Check the stderr for the following message:

ops_suexec: Not enough privileges. Check SU D bit and binary owner.

Solution

If the error message is present, issue the following commands as root in the $WVS_HOVE/ bi n directory:

chown root ops_suexec
chnod 4755 ops_suexec
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VBScript stuck in "Running" state

Problem

By default, Windows uses a GUI-based VBScript interpreter (wscr i pt . exe). With this interpreter, if your script tries to display an error message that requires a user-response (for example, Click OK), you will
never see the dialog box. The script therefore gets stuck in the "Running"” state.

Solution

To avoid this, we recommend you use the console version of the VBScript interpreter (cscri pt . exe). To do so, specify cscri pt . exe before the script name in a task definition, as shown in the following
example:

"cscript.exe C\Wrk\script.vbs".

186 / uc-73x-uext



Universal Controller 7.3.x General Information

My Universal Controller License has Expired

Problem

If your Universal Controller license has expired, you will not be able to run any tasks. If you attempt to run a task under an expired license, the Controller will place the task in the Defined state.

When you log in to the Controller, the Console will displays a license expiration informational message if your license will expire within a week, and an error message if your license already has expired.
Additionally, if you have configured the Controller for System Notifications, system notifications are sent when the Controller license will expire in seven days and if the license already has expired.

There are two other methods you can use to check on license expiration.

Method 1
Check the System Details widget (view the system-defined Home Dashboard or, on the Reporting navigation pane, click Widgets) to see how many days are left on your license.

The Days: #/# entry in the License field indicates the current day of your current license and the total number of days in the license. If the numbers are identical, your license has expired.

System Details
License: [Agents: 67/5000] [Triggers: Unlimited] [Tasks: Unlimited] [Days: 4/365]
Mode |d: ga-opswiseb:8080-ga_opswise620b21
Mode Mode: Active
Mode Uptime: 2 Days 20 Hours 53 Minutes 0 Seconds
MNode Time: 2015-05-18 14:17:43 -0400
Release: 6200
Build: build_21
Build Date: 05-13-2015_0345
Database Type: MY SQL
Database Mame: ga_opswiseb20b21
Database URL: jdbc:mysqgl://ga-dfdb2_stone_branch/
Database Connections:  In Use: 3, Total: 5
Memory Maximum: 989.85 MB
Memory Used: 140.18 MB (14.16%)
Memory Free: 849.70 MB (85.84%)
Method 2
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Check the Controller log file.

If your license has expired, the following two messages should appear in the log at the midnight roll-over:

2015-01- 07-00: 00: 00: 006 ~ WARN [ Ops. Ti mer. Forecast _Refresh. 0] License Violation: Nunber of Days has exceeded # suspendi ng system
2015-01-07- 00: 00: 00: 006 I NFO [ Ops. Ti ner. Forecast _Refresh. 0] Pausing the server.

Additionally, this message should appear in the log if you try to run a task under an expired license:

2015-01-07-09: 32: 27: 728 I NFO [ Ops. Avai | abl e. 2367. 0] System paused, waiting for resume

Solution

Contact Stonebranch Customer Support.
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Packet for query is too large

Problem

During operations, the following message may appear in the Universal Controller log:

Packet for query is too |large (1084852 > 1048576).

Solution
Change this value on the database server by setting the MySQL max_allowed_packet configuration variable.
For detailed information about this variable, refer to:

® MySQL 5.7.x reference manual
® MySQL 8.0.x reference manual
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Error when refreshing target agents

Problem

An error occurs when you click Refresh Target Agents on a Promotion Target record and you are using invalid login credentials for the target Universal Controller instance.

The user interface on source machine will show the following error:

GET http://NN NNN. NN. N: 8080/ uc/ resources/ agents/list returned a response status of 401 Unauthorized

The the Controller log on the source machine will show the following error:

ERROR [ htt p-8080-10] com sun.jersey.api.client.Uniform nterfaceException:
CET http:///uc/resources/agents/list returned a response status of 401 Unauthorized"

The target machine will return the following error:

ERROR [http--#] *** ERROR *** Login using Basic Authentication failed for:

Solution

Update the Promotion Target record with valid login credentials and try the promotion again.
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Invalid Call Error

Problem
The following error message displays:

onUncaught Exception: Exception caught: Invalid call to setDataSource() passing null.

Resolution

You may need to update the LimitRequestLine property in the Apache ht t pd. conf file to its default value, 8190.
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Permanent Generation (PermGen) space removed in Java 8

Problem
The Permanent Generation (PermGen) space has been completely removed in Java 8.

If you specify the Maximum PermGen Size option (- XX: MaxPer n5i ze=<NNN>) for a Java 8 VM, you may see a warning message similar to the following.

Java Hot Spot (TM 64-Bit Server VM warning: ignoring option MaxPernSi ze=512m support was renoved in 8.0

Resolution

The PermGen space is superseded by a new space called Metaspace in Java 8.

You can specify the Maximum Metaspace Size with the analogous - XX: MaxMet aspaceSi ze=<NNN> option; however, the default (no limit) is recommended for most deployments.
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Error Messages

Error Messages

This page identifies error messages (in alphabetical order) that you may receive for Universal Controller.

For each error, there is a link to the cause problem, and its solution, in Problem Resolution.

GET http://NN NNN. NN. N: 8080/ uc/ resources/ agents/list returned a response status of 401 Unaut horized

(in user interface on source machine)

ERROR [ htt p-8080-10] com sun.jersey.api.client.Uniformn nterfaceException:
CET http:///uc/resources/agents/list returned a response status of 401 Unauthorized"

(in Controller log on source machine)

ERROR [http--#] *** ERROR *** Login using Basic Authentication failed for:

(on Target machine)

See Error when refreshing target agents.

I NSERT | NTO uc_deno (name, value) values ("A, '"F);

See Error in your SQL syntax.

Java Hot Spot (TM 64-Bit Server VM warning: ignoring option MaxPernSi ze=512m support was renoved in 8.0

See Permanent Generation (PermGen) space removed in Java 8
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onUncaught Exception: Exception caught: Invalid call to setDataSource() passing null.

See Invalid Call Error.

ops_suexec___Not enough privileges. Check SU D bit and binary owner

See Cannot launch a task.

ORA- 01000: maxi mum open cursors exceeded

See Maximum open cursors have been exceeded.

Packet for query is too |large (1084852 > 1048576

See Packet for query is too large.

SQ.STATE: HY000, SQLERR 1040, ERRMSG. uni xODBC MySQ. ODBC 5.1 Driver Too many connections

See Error when Starting Controller.

The conversion of a varchar data type to a datetine data type resulted in an out-of-range val ue.

See Out-of-Range Value during Database Initialization.
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The I1BM Data Server for JDBC and SQ.J license was invalid or was not activated for the DB2 for z/OS subsystem If you are connecting directly to the
data server and using DB2 Connect Unlinmted Edition for Systemz, performthe activation step by running the activation programin the |icense
activation kit. If you are using any other edition of DB2 Connect, obtain the license file, db2jcc_license_cisuz.jar, fromthe license activation kit,
and follow the installation directions to include the license file in the class path.

See DB2 JDBC License Error.

The server did not receive the data that was sent to it. Please see the docunentation for isc. RPCResponse. STATUS_MAX_POST_SI ZE_EXCEEDED

See Tomcat Post Limit - STATUS_MAX_POST_SIZE_EXCEEDED.
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Tutorials

Introduction

The tutorials guide you through features of Universal Controller. They also provide links to more detailed information about each aspect of the Controller.
Once you have completed the tutorials, you should have a basic understanding of how the features work together to automate your environment.

Before you begin, we recommend that you read the Setting Up Universal Controller and User Interface sections of this documentation to familiarize yourself with user interface navigation and terminology.

Note

1
During the course of performing these tutorials, you will build up a small database of demonstration records that you will re-use in subsequent exercises. To avoid having to reenter data, do not delete the
records.

The navigation pane on the left lists the tutorials in the sequence they should be read; many of them refer to information created in one or more previous tutorials.

The following table lists the tutorials by topic, rather than sequence.

Tasks

Creating and Manually Launching a Simple Task

Creating and Manually Launching a Universal Task

Running a Windows Task

Launching a Task Automatically Using a Simple Time Trigger
Launching a Task Every Monday Except Holidays

Launching a Task Every Two Hours During Workday
Launching Tasks at a Future Time

Launching an Email Task Based on a File Monitor

Launching an Email Task Based on a Task Monitor
Launching Tasks Using a Cron Trigger

Aborting a Process Launched by a Task

Force Finishing, Force Finish-Cancelling, and Cancelling a Task
Accessing Task Instance Details

Monitoring Task Activity
Workflows

Creating a Simple Workflow
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Running a Workflow with a Conditional Path
Running a Workflow with Multiple Conditional Paths
Running a Workflow with Skipped Criteria
Finding and Inserting Tasks in an Active Workflow
Skipping, Unskipping, and Showing-Hiding Skipped Task Instances
Variables
Using Variables in a Simple Task
Using Variables in a Workflow
Custom Days
Creating Custom Days and Periods
Forecasting
Generating Forecast Data
Virtual Resources
Setting Up a Virtual Resource
User Interface
Creating a Widget
Creating a Dashboard and Selecting Widgets
Business Services
Creating Business Services
Assigning Records to Business Services
Viewing Activity by Business Service
Reports
Creating a Report
Creating a Report Based on Business Services
Scheduling a Report
Security

Creating Users and Assigning Permissions

Creating User Groups and Assigning Permissions
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Bundles and Promotion

Creating and Promoting a Bundle

Scheduling the Promotion of a Bundle
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Tutorial - Creating and Manually Launching a Task

In this tutorial, you will:
® Create a Timer task.

® Manually launch the task.
® View task instance Details of the task.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Task. The Timer Tasks list displays.

Step 2 Click New. The Timer Task Details displays.

® Inthe Task Name field, enter stonebranch-timertask-01.
® |n the Time Duration in Seconds field, enter 60.

Timer Task Details |[=)|E%
[l save 03 Save & New Save & View 3£ Close

Timer Task

— General

Task Name :

Task Description :
Member of
Business Senvices :
Resolve Name B Time Zone
Immediately : Preference :
Hold on Start: []

Virtual Resource Hold Resources on =
Priority © Failure :

- System Default — v

— Timer Details

Timer Type * | Seconds >

Timer Duration In
Seconds :

— Time Options
Late Start: []

Late Finish: [7]

Early Finish : [0]

UserEstimated  Day Hour Win Sec
Duration : v v v v

Critical Path Options
’7 CP Duration : CP Duratien Unit: |Minutes v

— Workflow Execution Options

Execution
Restriction - |~ None =

[] save [ save & New Save & View 3 Close

Step 3 Click Save.

Step 4 On the Timer Tasks list, right-click stonebranch-timertask-01 task to display an Action menu.

Step5  Click Launch Task.

Step 6 | Fromthe Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Step 7  Locate the stonebranch-timertask-01 task instance. When the task instance completes, the status changes from Running to Success.
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Step 8

Timer Task Instance Details: stonebranch-timertask-01

Click the Details icon next to the Instance Name of stonebranch-timertask-01 to display Details of the task instance.

[=][ 3

‘H Update 0@ Re-fun (&) Delete [[% Refresh & Close |

Timer Task Instance H Virtual Resources || Exclusive Requests ” Notes |
— General
Instance Name |5mnehran:h—nmenask401 ‘ Instance Number :
Task |slunabran:h-ﬂmenask-ﬂﬂ E Invoked By ‘ManuallyLauncngd ‘
Task Description
Member of Execution User ‘ups admin ‘
Business Serices
ol Time Zone
Calendar |Sy5tem Default |\_/ Preference -~ System Default—
Virtual Resource Hold Resources on
Priority |m |-.‘ Failure : o
— Status
Status |Succsss ‘
Status Description | ‘
Operational Memo
Trigger Time | \ Launch Tume.\zmg-ca-zu 15:24:37 -0400 \
Start Time - [2019-08-20 15:24:38 -0400 | End Time : | 2019-08-20 15:25:38 0400 |
Duration |1 Minute 0 Seconds ‘
Run Unti Time : [2019-08-20 15:25:38 -0400 |
— Timer Details
Timer Type : [seconds [+
Timer Duration In 50
Seconds :
— Statistics
User Estimated End ‘ Average Estimated ‘201905720 16:24:38 -0400 ‘
Time End Time
Lowest Estimated ‘ Highest Estimated ‘
End Time EndTime :
| Flupdate | E@Rewn || ¢ Delete || (5 Refresh || & Close |

For additional information, see:

® Creating Tasks
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Tutorial - Creating and Manually Launching a Universal Task

® Overview
® Before You Begin
® Create a Universal Template
® Create Universal Template Fields
® Create a Universal Task

Overview

To run a Universal Task, you must:

® Create a Universal Template, for which Universal Controller automatically creates a Universal Task type. This includes:
® Entering a script that any Universal Task created for that Universal Task type will execute.
® Creating fields, for which the Controller will both automatically assign variables (to be used in the script) and add to any Universal Task created for that Universal Task type.
Replace variables in the script with the variables assigned to the user-defined Fields that you created in the Universal Template.
Create a Universal Task for the Universal Task type based on the Universal Template that you created.
Enter/select values for the user-defined fields in the Universal Task that match the fields you created in the Universal Template.
Run the Universal Task.
Retrieve the task output and verify that the script variables have been resolved to the Universal Task field values.

In this tutorial, you will:

® Create a Universal Template.
® Define fields for a Universal Task in the Universal Template.
® Create a Universal task.

Before You Begin

When you create a Universal Template, you create fields that will display in the Details of the Universal Task (based on this Universal Template) that you will create. These Universal Template fields are
assigned variables to be used in the script. The script should contain these variables in a specific format based on information that you provide when creating the Universal Template.

Create a Universal Template
First, create a Universal Template:
Step 1 From the Administration navigation pane, select Configuration> Universal Templates. The Universal Templates list displays.

Step 2  Click New. The Universal Template Details displays.
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In the Name field, enter Oracle EBS.

In the Description field, enter Oracle E-Business Suite Tasks.
In the Variable Prefix field, enter: oebs.

In the Agent Type field, select Linux/Unix.

In the Linux/Unix Script field, enter:

concsub ${credential user ("${ops_oebs_appscredential }")}/${_credential Pwd("${ops_oebs_appscredential }")} \
"${ops_oebs_respapp}" ${ops_oebs_respnanme} ${ops_oebs_usernanme} \

WAl T=Y CONCURRENT FND FNDFMRTC \

PROGRAM_NAMVE= ' " ${ ops_oebs_prognane}

® Inthe Agent field, select a Linux/Unix agent on which the Universal Task based on this agent will run.
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F

Universal Template Details =|ax

|H save [ Save&New [[j Save &View $ Close |

Universal Template

— General

Name: Oracle EBS

Description : Oracle E-Business Suite Tasks

Variable Prefix: ogbs

lcon:

EBS logo (48x48).png

PNG image (48 x 48 pixels)

— Universal Template Details
AgentType : |LinudUnix [+

concsub S{credentialuser ("${ops_ogbs appscredentiall™)}
/${credentialbnd("S{ops_ochs appscredential}™>} \
"${ops_gebs_respappl” ${ops_gsbs respname} ${ops_gebs username} \
WATT+Y CONCURRENT FND ENDFMRTC

PROGRAM_NAME= ""${ops_pebs_progname}|

Linux/Unix Script :

— Defaults

Agent :|qa-snlr-mysql stone. branch - ga:Fticmysal

Agent Cluster ‘

AgentVariable : [7]

Agent Cluster
Variable o

Credentials : |

Cluster Broadcast ‘

Credentials
Variable : a8

Cluster Broadcast "
Variable

Runtime Directary

Environment | ame

Variables

Value

No items to show.

Exit Code
. |Success Exitcode Range

Processing

Exit Codes: 0

Automatic Qutput

Retreval: |~ None =

— Field Restriction

Agent Fields * [No Restriction

Jv] Credential Fields © No Restriction

Emvironment "
Verizbles Fie - Mo Restricton

Exit Code

Processing Fields Mo Restriction

Automatic Qutput

Retrieval Fields : [ivo Restrcion

| [F] save

|| @ save & New | [ Save & View |

€ Close

Step 3 Optionally, in the Icon field, browse for an icon (PNG image, 48x48 pixels) to be used instead of the default icon for any Universal Tasks based on this Universal Template.
If you select an icon, the file name display next to the Browse button. When you save the Universal Template, the logo itself displays in the Icon field (see #Create Universal Template Fields, below).
Step4  Click Save.

Create Universal Template Fields
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Next, create fields in the template:

Step 1 Open the Oracle EBS template that you just created.

=
T Universal Template Details: Oracle EBS Ei=E3

‘H Update [F Copy ¢f] Delete & Refresh 3% Close |

| Universal Template || Fields. |
Ican
No file selected. PNG image (48 x 48 pixels)
— Universal Template Details
Agent Type : | LinuUnix [+]

concsub ${credentialuser (“${ops_pebs_appscredential}l™)}
/8{credentialPwd("${ops_oebs_appscredentiall™} \
“${ops_gebs_respapp}” S{ops_gehs respname} ${ops_gebs username} \
WALT+Y CONCURRENT END ENDEMRTC

PROGRAM_NAME= " "S{ops_pebs_progname}|

Linux/Unix Script
— Defaults
Agsnt'|qa—mm—mysqlsmns branch - ga-cntir-mysaql ‘v [ AgentCluster \
AgentVariable : Ager;;a[r:‘g&teer 1
Credenials - | |+ [ cluster Broadcast - |
Credentials Cluster Broadcast —
Variable : Variable
Runtime Directory :
9@
Environment | ame ek
Variables :
No items to show
Exit Code
Processing |Success Exitcode Range ‘v ‘
Exit Codes: 0
Automatic Output -
Retrieval : |=one - ]
— Field iction; M
Agent Fields : |Nn Restriction ‘v | Credential Fields \Nﬂ Restriction |v|
Environment Exit Code .
Variables Field * |Na Restriction ‘V ‘ Pr Fields ‘No Restriction |"|
Automatic Output |Nn Restriction ‘v ‘

Retrieval Fields

| Elupdate || [Crcopy || ¢ff Delete || [ Refresh || § Close

o]
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Step 2 Click the Fields tab to display an empty Fields list.

Universal Template Details: Oracle BE(E3
Universal Template Fields
0 Fields New =)
Name Label Type Mapping Add To Default ListView  UpdatedBy  Updated v
No items to show:
Step 3 Click New. The Field Details for a new Field displays.
* In the Name field, enter appscredential.
® In the Label field, enter Oracle Application Credential.
® In the Hint field, enter Credential containing the Oracle Applications username and password..
® In the Type field, select Text.
® In the Required field, enter a check mark.
Field Details BIEIES
[E] save [F Save & New Save & View $§ Close
Field
— General
MName : appscredential Label : | Oracle Application Credential
Hint: Credential containing the Oracle lication username and
Add To Default List
View o
[~ Field Details
Type  [Text - Mapping : Text Field 1 a
Default Value
r— Validation
Required
Require IfField . — None — ~
Show IFField : |— None — .
Length
— Form Layout
StartRow: [] Column Span : 2 v
EndRow: []
[E] save liEy Save & New | | [y Save & View 3 Close

Step 4 Click Save to save the Field and re-display the Fields list.
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Step 5 Click New and create four more Fields.

® Name =respapp.
® |abel = Responsibility Application.
® Type = Text.

® Name =respname.
® |abel = Responsibility Name.
Type = Text.

® Name = username.
® Label = Application User.
® Type = Text.

Name = progname.
Label = Program Name.
Type = Choice.

Default = active users

Click Save to save each Field.

Step 6 When you save the progname field, the Choices tab is enabled so that you can define user-selectable Choices for that Field. An empty Choices list displays under the enabled Choices tab. Click New to display an
empty Choice Details for a new Choice:

® In the Value field, enter active users.
® Inthe Label field, enter Active Users.

Choice Details (=113
[E] save ER save &New [ Save &View 3£ Close

Choice

Details
Value : active users

Use Value For Label : [T]
Label: Active Users

[E] save I Save & Mew Save & View 3 Close

Step 7 Click Save to save the Choice and then create two more Choices for the progname field:

® Value = inactive users.
® Label = Inactive Users.

® Name = temporary users.
® Label = Temporary Users.

Click Save to save each Field.

Step 8 Click the Field tab to re-display the Field Details, click the Close to return to the Fields list, and then click click the Universal Template tab to return to the Universal Template Details.
Step 9 Check the script to make sure that the variables for the five Fields that you created are in the following format: ops_<Vari abl e Prefi x>_<Fi el d Name>. For example: ops_oebs_appscredenti al .

Step 10 Click Save to save the template.

Create a Universal Task

You now can create a Universal Task based on Stonebranch Template One.
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Step 1 Select the Automation Center navigation pane.

Step 2 Right-click inside the navigation pane and, on the Action menu that displays, click Refresh Navigation Tree. An Oracle EBS Tasks Universal Task task type now displays in the Universal Tasks folder.

Step 3 Click Oracle EBS Tasks to display an empty tasks list for this Universal Task type.
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Step 4 Click New to display Details for a new Oracle EBS Tasks task.

Oracle EBS Task Details = =ES
[E] save [ Save & New [ Save &View 3£ Close |

Oracle EBS Task

— General

Task Name :

Task Description

Member of
Business Services

Resolve Name Time Zone

Immediately Preference : |~ System Default -

Hold on Start

Virtual Resource Hold Resources on
Priority |1 Failure :

— Oracle EBS Details

Agent ME Agentcluster'l

Agent Cluster
Variable

AgentVariable : [F]

Credentials v Cluster Broadcast
| [P |

Credentials Cluster Broadcast
Variable Variable :

QOracle A
Credential :
Responsibliity Responsibility
Application Name

Application User Program Name : |Actwe Users

Runtime Directory

Enviranment Value
Variables
No items to show:

Exit Code
Processing

ExitCodes: 0

Automatic Qutput
Retrieval - |~

|Su:cess Exitcode Range

None —

— Retry Options
Retry Exit Codes

Maximum Retries Retry Indefinitely :

Suppress

R(EE:EC‘SI:Z:)E‘ s Intermediate
Failures :

— Wait/Delay Options
Wait To Start |_ None —

Delay On Start |, Nane —

Workflow Only |7 System Default —

— Time Options
Late Start
Late Finish
Early Finish
User Estimated __Day Hour Win

CP Duration CP Duration Unit: |Minutes

’7 Critical Path Options

— Workflow Execution Options

Execution
Restriction

—None —

sae |3 savesNew |[F) savesview| &£ close
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Step 5 In the Task Name field, enter: Active Users Report.
Step 6 Review the Details section fields that you defined in the Oracle EBS Universal Template to make sure that their names, defaults, and requirement settings are correct.
Step 7 Enter the following field values:

® Oracle Application Credential: APPS

* Responsibility Application: SYSADMIN

® Responsibility Name: System Administrator
® Application User: SYSADMIN

Step 8 Click the Save button to save the task.

Step 9 Right-click Active Users Report on the Oracle EBS Task list and, on the Action menu that displays, click Launch Task.
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Step 10

Oracle EBS Task Instance Details: Active Users Report

Click Activity in the Automation Center navigation pane and open the Active Users Report task instance:

= =163

‘ [F] Update Force Finish » [ Rerun [ Refrieve Qutput.. &) Delete [[5 Refresh £ Close

— General

Oracle EBS Task Instance H © Virtual Resources. H © Exclusive Requests ‘l © Output H © Hotes ‘

Instance Name : ‘Amve Users Report

‘ Instance Number :

Task: ‘Achve Users Report

|E Invoked By : |Manually Launched

Task Description :

Member of
Business Services :

Execution User: |ops.admm

Calendar: ‘Syshzm Default

Time Zone
Preference :

=

|- System Default -

virual Resource

Priority 10

Hold Resaurces on
Failure

]

[~ Status

Status ‘Suc:ess

Exit Code : [2

Status Description : ‘

Operational Memo :

Trigger Time © ‘

Launch Time : |2019-08—20 17:03:04 -0400

Queued Time ‘2019—0&—20 17:03:04 -0400

Start Time : ‘2019'0&20 17:03.04 -0400

EndTime : |2019'0&20 17:02:05 -0400

Duration ‘

CPU Time - [120

Process ID - 31825

— Oracle EBS Details

Agent: ‘uastune.branch --mysql

Agent Cluster © |

Agent Variable

Agent Cluster

Variable :

Credentials - ‘

Credentials
Variable :

Oracle Application
Credential : APPS

Responsibliity SYSADMIN
Application :

Responsibilly System Administrator
Name :

Application User: SYSADMIN

Program Name * | Active Users

Runtime Directory :

Environment
Variables :

Value

No items to show.

Exit Cods
1 ode ‘Su:cess Exitcode Range

Exit Codes: 0

Automatic Output

Retrieval; = NOne ~

— Retry Options

Retry Exit Codes

Maximum Retries l:l
] I

(Seconds)

a9
Count

Retry Indefinitely : []

Suppress
Intermediate []
Failures

[~ Statistics

User Estimated
nd Time

‘ Average Esl\mated‘wﬂmm 17:03:04 -0400
End Time .

Lowest Estimated
End Time

‘ Highest Estimated
End Time

‘ H Update H Force Finish vH @ Re-run

|| Retrieve Output..| | ¢ Delete | [ Refresh || 3 Close

210 / uc-73x-uext




Universal Controller 7.3.x General Information

Step 11 In the Status section of the task instance Details, check the Status and Exit Code fields to verify that the task ran to success. Optionally, retrieve output from the task instance to view details about the
run.

S
For additional information, see:

® Universal Templates
® Universal Tasks
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Tutorial - Running a Windows Task

® Creating a Simple Windows Task
® Manually Retrieving Output from a Windows Task
® Attaching Output to an Email Notification

To perform this tutorial, you need a running Universal Agent for Windows.

Creating a Simple Windows Task

Step 1 Fromthe Automation Center navigation pane, select Tasks > Windows Tasks. The Windows Tasks list
displays.

Step 2 In the empty Windows task Details below the list:

® Inthe Task Name field, enter stonebranch-windowstask-01.
® In the Agent field, select your Windows agent.
¢ In the Command field, enter md c:\tutorial.

Step3  Click Save.
Step 4  Onthe Windows Tasks list, right-click stonebranch-windowstask-01 to display an Action menu.
Step 5 Click Launch Task.

Step 7 Check the Activity Monitor for the task instance.

Manually Retrieving Output from a Windows Task

In this Windows task, we will run a DIR command. Normally, you would use the Automatic Output Retrieval field to specify that any output generated by the command be attached to the task instance after the
task completes. However, if you did not specify that output be attached, you can manually retrieve it after the task instance has run. In this exercise, we will manually retrieve and display the output.

Step 1 Use the same steps to create another Windows task called stonebranch-windowstask-02. Do not specify Automatic Output Retrieval, and use the following command:

dir c:\w ndows

Step 2  Save and launch the task.

Step 3 Locate and open the task instance on the Activity Monitor.
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Step 4 Note that the Output tab is empty. Click Retrieve Output. The Retrieve Output window appears:

Retrieve Output = |[3¢

& Standard Qutput and Standard Error
Output Type : € Standard Qutput
" Standard Error
Start Line : 1
Mumber of Lines : 100
Scan Text

Submit Cancel

Step5  Change the number of lines to 300 and click Submit.

Step 6 Click the Output tab. The STDOUT (standard output) displays on the output list, as shown in the following example:

3

Windows Task Instance Details: stonebranch-windowstask-02 ==
Windows Task Instance Virtual Resources Exclusive Requests | @ Output Notes
&
Type Attempt Output Updated By  Updated
Velume in drive C has no label. |
| Velume Serial Number is 74F4-252€
Directory of c:\windows
01/17/2012 08:04 B <DIR>
01/17/2012 08:04 BM  <DIR> ..
07/13/2009 10:37 B <DIR> AppCompat
01/17/2012 07:58 BM  <DIR> AppPatch
11/20/2010 O05:1& AM €5,024 bfsvc.exe
07/14/2009 12 AM <DIR> Boot =
07/14/200%9 12:52 BM <DIR> Branding 3
10/08/2009 02: M <DIR> csc
07/14/2009 AM <DIR> Cursors
12/23/2009 M <DIR> debug
07/14/2009 MM <DIR> diagnostics
07/14/2009 MM <DIR> Digitallocker
07/14/2009 MM <DIR> Downlosded Program Files
10/09/2009 ™ 1,774 DrcInstall.log
01/17/2012 M <DIR> ehome
10/08/2009 AM <DIR> en-US
11/20/2010 AM 2,81€,320 explorer exe -
Q7/13/2009 M 13,824 fveupdate. exe
07/14/2009 AM <DIR> Globalization
10/09/2009 e <DIms Help
Q7/13/2009 M 487,152 HelpPane exe
07/13/2009 ™ 15,360 hh.exe
01/17/2012 ™ 21,337 iis7.log
07/14/2009 MM <DIR> ™E
01/22/2014 M <DIR> inf
07/14/2009 MM <DIR> L2Schemas
07/13/2009 M <DIR> LiveKernelReports
1040972009 M <DIRE Logs
Q7/13/2009 M 43,131 mib.bin
01/17/2012 M <DIR> Microsoft NET
10/09/2009 e <DIms Minidump
07/13/2009 e <DIms ModenLogs
0€/10/2009 M 1,405 msdfmap.ini
07/13/2009 ™ 179,712 notepad.exe
10/09/2009 ™ 124,998 ntbtleg.txt
10/09/2009 M <DIR> nview
07/14/2009 MM <DIR> Offline Web Pages
10/09/2009 MM <DIR> Panther
07/14/2009 MM <DIR> Performance
04/15/2013 M 180,958 PFRO.log
07/13/2009 M <DIR> PLA b
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Attaching Output to an Email Notification

In this exercise, we will modify the stonebranch-windowstask-02 task with an Email notification that includes the output from the DIR command.
Step1  Open the stonebranch-windowstask-02 task.
Step2  Clickthe Actions tab.

Step 3  Click Email Notification and then click the New button.
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Step 4 In the Email Notification Details, specify the following:

e & o 0 0 0 o o

Status=Success

Email Connection=Your email connection
To=Your email address

Subject=Output

Body=See attached.
Attach Standard Output=enabled

Start Line=1

Number of lines=300

P
Email Notification Details

=113

|H Update (i Delete [|5 Refresh 3§ Close |

Email Notification

— Action Criteria

Exit Cot

Status : [Success [+

On Late Start: [7]
On Late Finish: [7]
On Early Finish : [7]

Description

des

— Action Details

Email Tem|

Email Template

Variable
Reply-To

Subject: Output

‘ | Email Connection : | OPSWISE-MAILER

late
fhe

stonebranch@stonebranch.com

Bee

See attached.

Body
Report ‘ Report Variable : [7]
Attach Standard Output Start Line 1
Number of Lines : 300
Scan Text
Attach Standard Error - []
Attach File: [F]
| Elupdate || ¢ Delete || [ Refresh || 3% Close

Step5  Click Save.
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Step 6  Launch the stonebranch-windowstask-02 task.

Step 7 Once the Windows task goes to success, check your inbox for the email. The output is attached, as shown in the following example.

Output Inbox  x &

opswise-email@stonebranch.com & 3:19 PM (1 minute ago) - -
to me [+

See attached.

B STDOUT_Thu_Jul.. '

e
For additional information, see:

® Creating Tasks
® Windows Task
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Tutorial - Launching a Task Automatically Using a Simple Time Trigger

In this exercise, we will define a time trigger that launches our Timer task every one minute.
Step 1 From the Automation Center navigation pane, select Triggers > Time Triggers.
Step 2 Click New.
Step 3 In the Name field, enter stonebranch-timetrigger-01.

Step 4 In the Task(s) field, click the Add-Remove Multiple icon.

Step 5 In the Collection window, locate the Timer task created in the Creating and Manually Launching a Task tutorial, stonebranch-timertask-01, move it to the Tasks List window, and click Save.
Edit Members Si=1|E3
Timer ¥ ¥ stonebranch-imetrigger-01
Task Name * Type T - Task Name * -
stonebranch-timertask-02 Timer stonebranch-timertask 01
stonebranch-timertask-03 Timer
stonebranch-timertask-04 Timer
stonebranch-timertask-05 Timer
(=]
[+]
[»]
[«
[ save Cancel
Step 6 In the Task(s) field, click the lock icon.
Step 7 In the Time Style field, select Time Interval.
Step 8 In the Time Interval field, enter 1.
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Step 9 In the Time Interval Units field, select Minutes.

Time Trigger Details e
[£] save [ Save & New Save & View 3% Close

Time Trigger

— General
Name : stonebranch-timetrigger-01
Description :

Member of
Business Services

Calendar : | System Default v Time Zone : |Server (AmericaiNew_York) .

stonebranch-timertask-01

A

Task(s):

Purge By Retention
Duration - a

— Status

Forecast: []
Skip Count 0

Task Launch Skip

Condition : |~ None = <

Simulate - |- System Default — e

— Time Details
Time Style : | Time Interval A
Time Interval - 1 Enable Offset: []

Time Interval Units - | Minutes o

— Day Details
Day Style : |Simple v
@ Daily (O Business Days (O Specific Day(s)

— Restrictions
Restrict Times =[]
Special Restriction : [7]

[E] save [y Save & New || [ Save & view 3 close

Step 10  Click Save.

Step 11 By default, triggers are disabled. To enable this trigger:
1. On the Time Triggers list, right-click stonebranch-timetrigger-01 to display an Action menu.
2. Click Enable to enable the trigger. Note that the Enabled column on the trigger list now displays a green check-mark for this trigger.

Step 12 From the Automation Center navigation pane, select Activity to display the Activity Monitor. Note that a new instance of stonebranch-timertask-01 appears every one minute.
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Step 13 Click the most recent instance of stonebranch-timertask-01 to view its details, and note that the Invoked By field contains the name of the trigger that launched this task.

7

Timer Task Instance Details: stonebranch-timertask-01 [ |(=)]E

| [F] update @ Re-run i Delete ([ Refresh 3% Close |

Timer Task Instance H Virtual Resources H Exclusive Requests H Notes ‘

— General

Instance Name ‘stonebrancn—timenaskih ‘ Reference Id

Task ‘stunebranch-{lmsnask-{n Invoked By ‘Tngger stnebranch-timetrigger-01 |

Task Description

Member of

Execution User ‘ups admin |
Business Services

Calendar : [System Default prame 207 | gystem Default—
Virtual Resource Hold R on
Priarity ‘10 ‘vl Failure O

— Status

Status ‘Su::ess ‘

Status Description

Operational Memo

Trigger Time ‘2017—10-05 15.18:25-0400 Launch Time ‘2(]17—10-06 15:18:25-0400 |

Start Time ‘2017—10436 15:18:25-0400 EndTime ‘2017—10436 15:18:35-0400 |

|
|
Duration ‘mSe:unds ‘
Run Until Time : [2017-10-06 15:13:35-0400 |

r— Timer Details

Timer Type ‘Semnds ‘vl

Timer Duration In

Seconds: 1

- Statistics

ser Average

EngTime | et | 2017-10-08 15:18:25-0400 |

Shortest Estimated ‘ Longest Estimated |
End Time End Time

| F update || @ Re-run |

off| Delete | [ Refresh || $£ Close |

e —————
For additional information, see:
® Triggers

® Time Trigger
® Enabling and Disabling Triggers
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Tutorial - Launching a Task Every Monday Except Holidays

® Introduction

® Create Calendar and Custom Days
® Create a Time Trigger

® Adding a Complex Restriction

Introduction

In this exercise, we will define a trigger that runs the stonebranch-timertask-01 task (created in the Creating and Manually Launching a Simple Task tutorial) automatically every Monday at 1 p.m., except
holidays.

For cases where Monday falls on a holiday, we will define a special restriction in the trigger that instructs the Controller to run the task on the next business day.

We will define the business days and holidays in a calendar.

Create Calendar and Custom Days

Before building the trigger, we will create the calendar:

Step 1 From the Automation Center navigation pane, Others > Calendars to display the Calendars list.
Step 2 Click New to display an empty Calendar Details.
Step 3 Enter stonebranch-calendar-01 in the Name field.
Step 4 In the Description field, enter Defines our company business days and holidays.
Step 5 Do not change the default selections for Business Days (Monday through Friday). Click Save.
Calendar Details =3

[F] save [E) Save & New Save & View £ Close

Calendar

Details
Name: stonebranch-calendar-01
Description : Defines our company business days and holidays
Member of Business Senices v

Business Days [C]sunday [#]Monday [¥|Tuesday [¥]Wednesday [¥]Thursday [¥]Friday [[] Saturday

First Day Of Week: | Sunday w2

[E save [ save & New | | [ Save & View 3 close

Step 6 Open stonebranch-calendar-01 and click the Custom Days tab.

Step 7 On the Custom Days list, click the New button. A Custom Day Details for a new Custom Day displays.
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Step 8 In the Name field, enter stonebranch-customday-01.
Step 9 In the Description field, enter Labor Day.
Step 9 In the Category field, select Holiday.

Step 10 In the Type field, select Relative Repeating Date. In the three additional fields that appear, make the following selections:

® When = 1st
* Day of Week = Mon
® Month = Sep
Custom Day Details —l@lx
[ save H3 Save&Mew 3£ Close
Custom Day
r— Details

Name : Labor Day
Description

Category: (O Day (O Business Day @ Holiday (O Period

Type  |Relative Repeating Date A
When:|qst -
Day Of Week: |Mon v,
Month - |Sep v
Adjustment: |- None — v
@ @

Actual Day Of Week Observed Day Of Week
Observed Rules

Mo items to show.

[l save [ Save & New # Close

Step 11  Click Save to add this Custom Day to the Calendar.

Step 12 On the Custom Days list, click the New button. A Custom Day Details for a new Custom Day displays.
Step 13 Inthe Name field, enter stonebranch-customday-02.

Step 14 | Inthe Description field, enter The founder’s birthday.

Step 15  Inthe Category field, select Holiday.
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Step 16  Inthe Type field, select Relative Repeating Date. In the three additional fields that appear, make the following selections:
® When =2nd
® Day of Week = Mon
¢ Month = Oct
Custom Day Details ==

[E] save [ Save &New $£ Close

Custom Day

— Details
Name : stonebranch-customday-02
Description : The founder's birthday
Categary: (O)Day () Business Day (® Holiday () Period

Type : | Relative Repeating Date v
‘When:|2nd -
Day Of Week " |yon v
Month : | Qct -
Adjustment . |~ None — v
")

Actual Day Of Week Observed Day Of Week

Observed Rules
No items to show,

[E] save [ save & New 3 Close

Step 17  Click Save to add this Custom Day to the Calendar.

Create a Time Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Time Trigger to display the Time Triggers list.

Step 2 Click New to display an empty Time Trigger Details.

Step 3 In the Name field, enter stonebranch-timetrigger-01.

Step 4 In the Description field, enter Run every Monday at 1 p.m., roll to Tuesday if Monday is a holiday.
Step 5 In the Calendar field, select stonebranch-calendar-01.

Step 6 In the Task(s) field, select stonebranch-timertask-01.

Step 7 In the Time Style field, keep the default, Time.

Step 8 In the Time field, enter 13:00 (1 p.m. in 24-hour time).

Step 9 In the Day Style field, keep the default, Simple.

Step 10 = Enable Specific Day(s) field and select Monday.
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Step 14

Step 15
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Step 11  Enable Special Restriction and select:

® On Holiday in the Situation field.

® Next Business Day in the Action field.
Step 12 Click Save.

Time Trigger Details

Time Trigger

— General

Name : stonebranch-timetrigger-01
Description

Run every Monday at 1 p.m., roll to Tuesday if Monday is a holiday.
Member of
Business Services

Calendar : stonebranch-calendar-01

-|afXx
[E] save [ Save & Mew Save & View 3¢ Close

£ Time Zone | | US/Eastern
stonebranch-timertask-01
Task(s):
Purge By Retention ]
Duration

Bl

 Status

Forecast: []

Skip Count 0
Skip Trigger if

Active a

Simulate | — System Default —

— Time Details

Time Style : Time

Hour Min
Tme: 31w oo
— Day Details

Day Style : | Simple

.

(O Daily (O Business Days @ Specific Day(s)

Special Restriction

[]Sunday [J]Monday [|Tuesday [|Wednesday [|Thursday [T|Friday []Saturday
— Restrictions

Simple Restriction

Situation : | On Holiday

[l save

Action : Next Business Day

Complex
sl
-
I3 Save & New

Restriction
Save & View

3 close

Click the List Qualifying Times button to display the *List Qualifying Times Input pop-up dialog.
In the Number of Dates/Times field, enter 15.

In the Start Date fields, Select July 25 2014.
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Step 16 Click Submit to display a list of Qualifying Times when the trigger will launch the task.

Qualifying Times =] Es

stonebranch-timetrigger-01

Run every Monday at 1 p.m., roll to Tuesday if Monday is a
holiday.

E Listing From: Friday, July 25, 2014 10:42:45 EDT -0400 [9]

UzerTrigger Timezone: US/Eastern

Manday, July 28, 2014 13:00:00 EDT -0400
Maonday, August 04, 2014 13:00:00 EDT -0400
Maonday, August 11, 2014 13:00:00 EDT -0400
Monday, August 18, 2014 13:00:00 EOT -0400
Maonday, August 25, 2014 13:00:00 EDT -0400
Tuesday, September 02, 2014 13:00:00 EDT -0400
Maonday, September 08, 2014 13:00:00 ECT -0400
Monday, September 15, 2014 13:00:00 EDT -0400
Maonday, September 22, 2014 13:00:00 EDT -0400
Maonday, September 29, 2014 13:00:00 EDT -0400
Manday, October 06, 2014 13:00:00 EDT -0400
Tuesday, October 14, 2014 13:00:00 EDT -0400
Manday, October 20, 2014 13:00:00 EDT -0400
Manday, October 27, 2014 13:00:00 EDT -0400
Maonday, Movember 03, 2014 13:00:00 EST -0500

As shown in the list, the task will not run on the two Mondays that you have defined as holidays in the calendar, but instead will run the the following
Tuesday.

Adding a Complex Restriction
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The following steps show you how to add a complex restriction to the stonebranch-timetrigger-01 trigger. In this case, you will add a restriction that skips the last Monday of the year and instead triggers the
task on the following Tuesday, just as it does for Mondays that are holidays.

Step1  Enable Complex Restriction.

Step2  Inthe Restriction Mode field, select Or.

Step 3 In the Restriction Adjective field, select Last.
Step 4  Inthe Restriction Noun field, select Monday.
Step 5 In the Restriction Qualifier field, select Year.
Step6  Click Update.

Step 7 Re-open the trigger, click the List Qualifying Times button, enter 25 in the Number of Dates/Times field, and click Submit. The Qualifying Times list now shows an additional Monday (the last Monday of the year)
on which the task will not be run.
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Qualifying Times =

stonebranch-timetrigger-01

Run every Monday at 1 p.m., roll to Tuesday if Monday is a
holiday.

E Listing From: Friday, July 25 2014 11:01.54 EDT -0400 [E]

U=zerTrigger Timezone: US/Eastern

Maonday, July 28, 2014 13:00:00 EDT -0400
Monday, August 04, 2014 13:00:00 EDT -0400
Monday, August 11, 2014 13:00:00 EDT -0400
Monday, August 18, 2014 13:00:00 EDT -0400
Monday, August 25 2014 13:00:00 EDT -0400
Tuesday, September 02, 2014 13:00:00 EDT -0400
Monday, September 08, 2014 13:00:00 EDT -0400
Monday, September 15, 2014 13:00:00 EDT -0400
Monday, September 22, 2014 13:00:00 EDT -0400
Monday, September 29, 2014 13:00:00 EDT -0400
Monday, October 06, 2014 13:00:00 EDT -0400
Tuesday, October 14, 2014 13:00:00 EDT -0400
Monday, October 20, 2014 13:00:00 EDT -0400
Monday, October 27, 2014 13:00:00 EDT -0400
Monday, Movember 03, 2014 13:00:00 EST -0500
Monday, Movember 10, 2014 13:00:00 EST -0500
Monday, Movember 17, 2014 13:00:00 EST -0500
Monday, Movember 24, 2014 13:00:00 EST -0500
Monday, December 01, 2014 13:00:00 EST -0500
Monday, December 08, 2014 13:00:00 EST -0500
Monday, December 15, 2014 13:00:00 EST -0500
Monday, December 22, 2014 13:00:00 EST -0500

[ P P - S — e e MM M A B A SLTPL AT ST S an
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IUESUdY, LEeCEITIDET U, AU 14 I3 UUUY ES 1 -uduy
Monday, January 05, 2015 13:00:00 EST -0500
Monday, January 12, 2015 13:00:00 EST -0500

For additional information, see:

® Triggers

® Time Trigger

® Calendars

® Displaying Trigger Forecast Information
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Tutorial - Launching a Task Every Two Hours During Workday

In this exercise, we will define a recurring task that runs every two hours, limited to business hours — Monday through Friday from 9 a.m. to 5 p.m. We will also instruct Universal Controller not to run the task on
holidays.

Also, if the task is still running two hours later when it is time to run the next task instance, the Controller will be instructed not to run the next instance.
Step 1 From the Automation Center navigation pane, select Triggers > Time Triggers. The Triggers list displays.

Step 2 Click the New button to display an empty Time Trigger Details.

Step 3 In the Name field, enter stonebranch-timetrigger-02.

Step 4 In the Description field, enter Run Every Two Hours During Business Hours Except Holidays.

Step 5 In the Calendar field, select stonebranch-calendar-01 (created in the Launching a Task Every Monday Except Holidays tutorial).
Step 6 In the Task(s) field, select stonebranch-timertask-01 (created in the Creating and Manually Launching a Simple Task tutorial).

Step 7 Enable the Skip Trigger if Active field. This tells the Controller not to trigger the task if the previous instance of the task is still active.
Step 8 In the Time Style field, select Time Interval and specify the following:

® Time Interval =2
® Time Interval Units = Hours
Step 9 Enable the Restrict Times field and specify the following:
® Enabled Start = 09:00
* Enabled End = 17:00
Step 10 Specify that this trigger should run on weekdays only by selecting either:

® Day Style = Simple
® Business Days = Enabled

OR

Day Style = Complex

Date Adjective = Every
Date Noun = Business Day
Date Qualifier = Year

Both methods use the Business Days specified in stonebranch-calendar-01.
Step 11 Enable the Special Restriction field and specify the following:

® Situation = On Holiday
® Action = Do Not Trigger
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Step 12 Click the Save button.

7

Time Trigger Details: stonebranch-timetrigger-02 (=63

[E] update & Enable (T Trigger Mow. List Qualifying Times... [ Copy ¢f Delete [ Refresh % Close |

Time Trigger H Variables ‘| Versions |

— General

Name : stonebranch-timetrigger-02 Version :

Description : Run Every Two Hours During Business Hours except Holidays

Member of
Business [+
Semices

Calendar: ‘stonebranm—:alendar—m Time Zone : |System (AmericaMNew_York) [~ |

stonebranch-timertask-01

Task(s):

A

Purge By Retention O
Duration

— Status

Forecast: [] Status ‘Dlsamed |

Skip Count 0 Disabled By : | |
Skip Trigger if
Active

Simulate : — System Default — I~

— Time Details

Time Style . Time Interval »

Time Interval 2 Enable Offset: [7]

Time Interval
Units Hours v

— Day Details

Day Style : | Simple -

(O Dally ® Business Days (O Specific Day(s)

— Restrictions
Restrict Times

Hour Min
Enabled Start m m Adjust Interval Ta Enabled Start - [7]

Hour Min
Enabled End: @ @I

sSpecial
Restor Action :[Da Not Trigger [+]

Simple
Restriction :

Situation - [On Holiday [¥]

Complex Restriction: [7]

| [F] update || @ Enable ||(E TriggerNow..| [] ListQualifying Times...|| [ Copy || ¢if| Detete | [[% Refresh | 3§ Close

Step 13 Re-open stonebranch-timetrigger-02 and click the List Qualifying Times button. The Qualifying Times list displays the next scheduled 30 (by default) times when stonebranch-timetrigger-02 will launch stonebra
nch-timertask-01.
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Qualifying Times =

stonebranch-timetrigger-02

Run Every Two Hours During Business Hours except
Holidays

E Listing From: Friday, July 25, 2014 13:47:58 EDT -0400

UzerTrigger Timezone: US/Eastern

Friday, July 25, 2014 15:00:00 EDT -0400
Friday, July 25, 2014 17:00:00 EDT -0400
Saturday, July 26, 2014 09:00:00 EDT -0400
Saturday, July 26, 2014 11:00:00 EDT -0400
Saturday, July 26, 2014 13:00:00 EDT -0400
Saturday, July 26, 2014 15:00:00 EDT -0400
Saturday, July 26, 2014 17:00:00 EDT -0400
Sunday, July 27, 2014 09:00:00 EDT -0400
Sunday, July 27, 2014 11:00:00 EDT -0400
Sunday, July 27, 2014 13:00:00 EDT -0400
Sunday, July 27, 2014 15:00:00 EDT -0400
Sunday, July 27, 2014 17:00:00 EDT -0400
Monday, July 28, 2014 09:00:00 EDT -0400
Monday, July 28, 2014 11:00:00 EDT -0400
Monday, July 28, 2014 13:00:00 EDT -0400
Monday, July 28, 2014 15:00:00 EDT -0400
Monday, July 28, 2014 17:00:00 EDT -0400
Tuesday, July 29, 2014 09:00:00 EDT -0400
Tuesday, July 29, 2014 11:00:00 EDT -0400
Tuesday, July 28, 2014 13:00:00 EDT -0400
Tuesday, July 29, 2014 15:00:00 EDT -0400
Tuesday, July 29, 2014 17:00:00 EDT -0400

Al A s Al Lol S0 A4 4 AOGATA0 FET Admn
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YYELNIEDUAY, JUIY JU, £U 18 USULUY CL | -UsuY
Wednesday, July 30, 2014 11:00:00 ECT -0400
Wednesday, July 30, 2014 13:00:00 EDT -0400
Wednesday, July 30, 2014 15:00:00 EDT -0400
Wednesday, July 30, 2014 17:00:00 EDT -0400
Thursday, July 31, 2014 08:00:00 EDT -0400
Thursday, July 31, 2014 11:00:00 EDT -0400
Thursday, July 31, 2014 13:00:00 EDT -0400

For additional information, see:
® Triggers

® Time Trigger
® Calendars
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Tutorial - Launching Tasks at a Future Time

In this exercise, we will create a trigger that will launch multiple tasks at the same time in the future (in two minutes). For this exercise, we will use the SQL tasks created in the Running a Workflow with a
Conditional Path tutorial.

(A future date also can be selected, but to see now that the tasks have been launched, keep the current date.)

Create a Temporary Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Temporary Triggers. The Temporary Triggers list
displays.

Step 2 Click the New button to display Temporary Trigger Details for a new trigger and enter/select the following values:

Name = Launch Tasks

Tasks = stonebranch-timertask-01, stonebranch-timertask-02, and stonebranch-timertask-03 Timer tasks
Date = current date

Time = 5 minutes from the current time

Time Zone = your time zone

Step 3  Click the Save button.

Temporary Trigger Details —lolix
[E] save [E Save & New [ Save &View $£ Close

Temporary Trigger

— General

Name: Launch Tasks

Description
Member of "
Business Senvices
Calendar : | System Default ¥ : Time Zone : US/Eastern v
stonebranch-timertask-01
stonebranch-timertask-02 =)
Taskis): | sionepranch timertask 03 =

Purge By Retention B
Duration

r Status
Forecast: [7]
Skip Count 0
Task Launch Skip
Congition |~ Mon8 = -
Simulate : |- System Default — e

— Tempaorary Details
Date: 2019 |v|Sep |v |5 |v|=
Hour Min

Tme: g o] o5 |

[ save [ Save & New Save & View 3 Close

Step 4 Right-click Launch Tasks on the Temporary Triggers list and click Enable.

Step 5 Open the Activity Monitor to see that the three Timer tasks are run at the selected time.
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S
For additional information, see:

® Temporary Trigger
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Tutorial - Launching an Email Task Based on a File Monitor

Introduction

Create File Monitor Task
Create an Email Task

Create File Monitor Trigger
Test Your File Monitor Set-up

Introduction

In this exercise, we will monitor a machine for a specific file. When the file appears, we will send an email that uses variables to supply information about when and how the email was sent.
In order to set this up, we need the following:

Universal Agent

File Monitor task

File Monitor trigger

Email task being launched by the trigger.

File Manitor trigger

?}@Q’&'@

Universal Agent
Maonitors File Monitor task Task launches when
File being monitored for Trigger is satisfied

Prerequisites:

® In order to perform this exercise, you need a Windows, Linux/Unix, or z/OS Agent running on the machine that is being monitored for the file. Create a directory on the machine called cont r ol | er
tutorial . Later on, you will copy a text file to this directory to satisfy the File Monitor trigger.

Note

1
If you do not have a running Agent, you can bypass this step by manually satisfying the trigger, as per instructions in the tutorial. However, you do need an Agent defined in the database.
® Since we are going to generate an email when the trigger is satisfied, you will need an Email Connection defined.

Create File Monitor Task
The File Monitor task monitors the agent machine for the specified file.

Step 1 From the Automation Center navigation pane, select Tasks > File Monitors. The File Monitors list displays.
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Step 2 Click the New button to display an empty File Monitor Details.

Step 3 In the Task Name field, enter stonebranch-filemonitor-01.

Step 4 In the Task Description field, enter Demo File Monitor.

Step 5 In the Agent field, select an Agent.

Step 6 In the Monitor Type field, keep the default value, Create. (See File Monitor Task Details Field Descriptions for details about the other file monitor options.)

Step 7 In the Monitor File field, type filel.txt. Since we have not specified any directory, the Controller will search the root directory.

Step 8 ﬁnable the Recursive field. Since we are going to write our file to the control | er tutori al directory, we want the Controller to search all sub-directories for the
le.
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Step 9 In the Stable (seconds) field, enter 5. This tells the Controller to satisfy the trigger only when the file has not changed in 5 seconds.

File Monitor Details = ([=)/ET
[l save U5 Save & New Save &View 3£ Close

File Monitor

— General
Task Name : stonebranch-filemaonitar-01
Task Description . Demo File Monitor

Member of
Business Services
Resolve Name = Time Zone
Immediately Preference
Hald on Start: []

Virtual Resource 10 - Hold Resources on B
Priority Failure

— System Default — ~A

r— File Monitor Details
Agent : | gazstone.branch - ga, M= Agent Cluster v

Agent Cluster
’ &l

Agent Variable : [0] Variable

Credentials v || Cluster Broadcast v

Credentials Cluster Broadcast
Variable a Variable B

Trigger on

WMonitor Type * | Create h Edstence .

Monitor File(s) : file 1.5¢

Use Regular
Expression a

Recursive Maximum Files
File Owner
Stable (seconds) 5

Minimum File

Minimum File Size
Scale

KB ~

Scan Text

— WaitDelay Options
Wait To Start: |- None — .
Delay On Start: |~ None — 3

Workdlow Only : | — System Default — h

r— Time Qptions
Late Start: [7]

Late Finish: []

Early Finish : [7]

User Estimated  Day Hour Min Sec
Duration v v v -

Critical Path Options
’7 CP Duration CP Duration Unit: Minutes v

— Workflow Execution Options

Execution
Restriction : —MONe =

[E] Save [ Save & New Save & View # close

Step 10 Click Save.

Create an Email Task

Create the task that will run when the File Monitor is satisfied. In this case, we will generate an email, using the Email task:
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Step1  Fromthe Automation Center navigation pane, select Tasks > Email Tasks. The Email Tasks list displays.
step 2  Click the New button to display an empty Email task Details.

Step3  Inthe Task Name field, enter stonebranch-emailtask-01.

Step 4 In the Description field, enter Send Email When File Appears.

Step5  Inthe Email Connection field, select your Email Connection.

Step 6 In the To field, enter your email address. This is where the email will be sent.

Step 7 Inthe Subject field, enter filel.txt arrived.

Step 8 In the body field, enter the following Universal Controller variable and Universal Controller function:

Triggered by: ${ops_trigger_nane}
Date: ${_date}
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Step 9

When the email is generated, the variables will be substituted with the name of the trigger that launched the Email task,

along with the date and time the task was launched.

Email Task Details

Email Task

=|(3]

[E] save U3 Save & New Save &View $§ Close

— General
Task Name : stonebranch-emailtask-01
Task Description . Send Email When File Appears

Member of
Business Services

Resolve Name
Immediately B

Hold on Start: [7]

Virtual Resource
Priority

Time Zone

Preference - | System Default— 7

Hold Resources on &l
Failure

— Email Details
Email Template

Email Template
variaote -

Reply-To

stonebranch@email.com

Cc

Bee
Subject: file 1.b4 arrived

Date: ${_date}

Body

Report
Attach Local File: [

Triggered by: S{ops_trigger_name}

-

| Email Connection : | QAMAILER M=

Report Variable : [7]

— Wait/Delay Options
Walt To Start* | — None —

Delay On Start: — None —

Waorkflow Only ;| — System Default —

— Time Options
Late Start: []

Late Finish: [7]

Early Finish: []

Duration v v -

User Estimated  Day Hour Min Sec

Critical Path Options
’7 CP Duration

CP Duration Unit - |inutes v

‘Workflow Execution Options

Execution

Restriction : |~ None =

[E] save ) Save & New | | [f] Save & View

*

Step9  Click the Save button.
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Create File Monitor Trigger
Create the File Monitor trigger:
Step 1 From the Automation Center* navigation pane, select Triggers > File Triggers. The File Monitor Triggers list displays.
Step 2  Click the New button to display an empty File Monitor Trigger Details.
Step 3 Inthe Trigger Name field, enter stonebranch-filemonitortrigger-01.
Step 4 In the Description field, enter When File Arrives Send Email.
Step5  Inthe Task(s) field, select stonebranch-emailtask-01.)
Step 6 In the File Monitor field, select stonebranch-filemonitor-01.

Step 7 Click the Save button.

File Monitor Trigger Details B
] save Save & Mew Save & View $E Close

File Monitor Trigger

— General

Hame : stonebranch-filemonitortrigger-01

Description : When File Arrives Send Email

Member of
Business Senices

Calendar : | System Default M= Time Zone : | System (America/New_York) -

stonebranch-windowstask-01

He

Task(s):

Purge By Retention
Duration : a

— Status

Skip Count: 0

Skip Trigger if
Active © o

File Monitor Details
’7 File Monitor : | stonebranch-filemonitar-01 ¥

— Restrictions
Restrict Times : []
Special Restriction : [7]

[E] save [y save & New Save & View 3 Close

Test Your File Monitor Set-up
Test your File Monitor set-up.

Step 1 Enable the File Monitor trigger. This launches the File Monitor task. It will appear in the Activity Monitor with a status of Running.

239 / uc-73x-uext


https://docs.stonebranch.com/confluence/display/UC73/Enabling+and+Disabling+Triggers
https://docs.stonebranch.com/confluence/display/UC73/Monitoring+Activity+from+the+Activity+Monitor

Universal Controller 7.3.x General Information

Step 2 Do one of the following:
® |f you have a running agent, place a text file called fi | e1. t xt inthe control | er tutorial directory on the machine that is being monitored by the File Monitor task. When the file appears, the File Monitor
task waits five seconds, as specified, and then satisfies the trigger.
¢ |f you do not have a running agent but do have an agent connected to your instance, you can manually satisfy the trigger as follows:

1. From the Automation Center navigation pane, select Triggers > File Triggers to display the File Monitor Triggers list.
2. Right-click the stonebranch-file monitortrigger-01 trigger and select Trigger Now.

Step 3 When the trigger is satisfied, the Email is sent. Go to the Activity Monitor and note that the astonebranch-emailtask-01 Email task has been launched.

Step 4 Go to your email account where the email was sent and open the email. Note that the variables were resolved.

e ——————
For additional information, see:

® Email Task

® File Monitor Task

® File Trigger
® Variables
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Tutorial - Launching an Email Task Based on a Task Monitor

Introduction

Select the Activity Monitor Problem Filter

Create an Email Template

Creating an Email Task Using the Email Template
Creating a Task Monitor Task

Creating a Task Monitor Trigger

Running the Task Monitor

Introduction

In this exercise, we will set up a Task Monitor and Task Monitor trigger. The Task Monitor will monitor all tasks for a status that indicates some sort of problem. When the trigger is satisfied, Universal Controller
will launch an Email task that notifies a user that there is a problem. We will also create an Email template for use in our Email task and create an Activity Monitor filter that displays only problem tasks.

The following illustration shows the various components used to trigger tasks based on the status of other tasks.

| |
I l

Task Monitor

: Task Monitor .

Jjﬁ:ﬁrzzznﬁ“ task: Looks for ;:ff ;’Drﬂgr“ggi Tasks being
Windows tasks Failure status in when conditions ] trlgga-r"ad when | ]
whose name Windows tasks . ) conditions are | | |

met, triggers list of satisfiod

beginning with SF

begins with SF tasks.

Select the Activity Monitor Problem Filter

The first task we will do is select the Problem filter for the Activity Monitor. When the user receives an email indicating there is a problem, the user can view this Activity Monitor to find out more information.

Step 1 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

step2  Click the Click to start the Activity monitor button. All active task instances display.
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Step 3  From the Quick Filter drop-down list, select Status > Problem.

Dashboards Activity

“|Lastaghours ~ | [ Mo quickfilter = | Custom Filter|— None — v | B Filter
Instance Name E status » Active Type Status 7
-_——— Blocked
& Type » Completed

F’%msm
Status is one of Running/Problems,
Defined Cancel Pending, In Doubt, Start Failure,
- i Confirmation Required, Cancelled,
3 Waiting Failed

Held

Started/Finished Late

Exclusive Requested
Exclusive Wait
Resource Requested
Resource Wait
Execution Wait

(k) Undeliverable

(=)

Queued
Submitted
Action Required
Started
Running

Click to start the Activity monitor

Running/Problems
Cancel Pending

In Doubt

Start Failure
Confirmation Required
Cancelled

Failed

Skipped

Finished

1 I >
Success

%% Settings ~ v @] M q b W Page of

The Activity Monitor now will display only Problem task instances.

Create an Email Template

Email Templates allow you to create pre-defined Email task information that you refer to when creating an Email task. This is useful if you have a large number of common parameters on Email tasks but still
require separate tasks.

Step1  Fromthe Agents & Connections navigation pane, select System > Email Templates. The Email Templates list displays.

Step 2  Click the New button to display an empty Email Template Details and enter the following values:

Template Name = Notification based on status

Email Connection = (a valid email connection)

To = (a valid email account)

Subject = Task Failure Alert

Body = Task failure, see Activity Monitor for Problems
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Step 3  Click the Save button.

Email Template Details =115
[E] save [ Save&New [ Save &View $£ Close

Email Template:

— Details

Template Name : Notification based on status
Description :
Member of Business Senices v
Email Connection : | QA-MAILER v
Reply-To:

T suppont@sienahranch.com
0

Subject: TestFailure Alert

Task Failure: see Activity Monitor for Problems.

Body

[F] save I Save & New || [ Save & View 3 Close

Creating an Email Task Using the Email Template

Step 1 From the Automation Center navigation pane, select Tasks > Email Tasks. The Email Tasks list displays.

Step 2 Click the New button to display an empty Email Task Details and enter the following values:

® Task Name = Triggered by Task Status
® Email Template = Notification based on status

Leave the remaining fields blank, since we want to use the information from the template. (If you fill in any of the duplicate fields, the information from the task overrides the information from the template.)
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Step 3  Click the Save button.

Email Task Details

Email Task

— General

o )[=]
[E] save [F Save & New Save &View 38 Close

Task Name : Triggered by Task Status
Task Description

Member of
Business Semvices

Resolve Name
Immediately a

Hold on Start: []

Virtual Resource
Priority

Time Zone
Preference

Hold Resources on
Failure

— System Default — ¥

=]

— Email Details

Email Template : | Nofification based on status

Email Template
Variable a8

Reply-To

To

Subject

Body

Report
Attach Local File : [7]

[F=] Email Connection

Report Variable

=]

— WaitiDelay Options
Walt To Start: |- None —
Delay On Start . |- None —

Workflow Only : |- System Default -

— Time Options

Late Start: [7]
Late Finish: []
Early Finish : [7]

User Estimated __ Day Hour Min
Duration v v v

Critical Path Options
’7 CP Duration

CP Duration Unit

Minutes %

‘Worlkflow Execution Options

Execution

Resiriction ; ~Mone =

[E] save [iE) Save & New Save & View

3

Creating a Task Monitor Task

244 | uc-73x-uext




Universal Controller 7.3.x General Information

For this Task Monitor, we will monitor the status of all other tasks. If any task has a status that indicates there is some sort of problem, we will generate an email. Once the Task Monitor is launched by the Task
Monitor trigger, it remains active, launching an Email every time any of its conditions are met. The Task Monitor task remains active until the Task Monitor trigger is disabled or until a user manually stops it.

Step 1 From the Automation Center navigation pane, select Tasks > Task Monitors. The Task Monitors list displays.

Step 2 Click the New button to display an empty Task Monitor Details and enter the following values:

Task Name = Monitors for Problems
Status To Monitor = enable Running/Problems, Cancel Pending, In Doubt, Start Failure, Confirmation Required, Cancelled, and Failed. (For a description of each status, see Displaying Task Instance Status).

Monitoring Type = General Task(s)
Task Type To Monitor = enable all task types

L]
L]
L]
L]
Step 3 Click the Save button.
Task Monitor Details =X

[E] save [ Save & New Save & View $E Close

Task Menitor

— General

Task Name : Monitors for Problems

Task Description :

Member of "
Business Services |
Resalve Name Time Zone
Immediately - Preference | |~ SYStem Default s

Hold on Start: []

Virtual Resource 10

Hold Resources on
Priority a

Failure

— Monitor Details

Status To Monitor : Running/Problems, Cancel Pending, In Doubt, Start Failure, Confirmation Required, Cancelled, Failed v
Monitoring Type : | General Task(s) v
Task Mame
Condition : |~ 11018 = <
TaskType To
Monitor Workflow, Linux/Unix, Windows, Manual, File Monitor, Task Monitor, Email, ZOS, Timer, File Transfer, FTP File Monitor, SQL, Stored Procedure, Uni_.. | v
l
Workflow Name
Condition - |~ e~ hd
Time Scope : |- None — v
— Wait/Delay Options
Wait To Start : |- Mone — v
Delay On Start: |- Mone — ~
‘Workflow Only : |- System Default — ¥
— Time Options
Late Start: []
Late Finish: []
Early Finish: []
User Estimated __Day Hour, Hin Sec
Duration : > > v v
Critical Path Options
’7 CP Duration : CP Duration Unit: Minutes B

— Workflow Execution Options

Execution

Restriction - 0"~ b4

[ save [Z) Save & New Save & View 3L Close
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Creating a Task Monitor Trigger

As the last step in our set-up process, we will create the Task Monitor trigger, which controls when the Task Monitor task is started and stopped.

Step 1 From the Automation Center navigation pane, select Triggers > Task Monitor Triggers. The Task Monitor Triggers list
displays.

Step 2 Click the New button to display an empty Task Monitor Trigger Details and enter the following values:

® Name = Controls Monitors for Problems
® Task(s) = Triggered by Task Status
® Task Monitor = Monitors for Problems

Step 3  Click the Save button.

Task Monitor Trigger Details —l@lfx

[E] save [ Save&New [F] Save &View 3% Close
Task Wonitor Trigger

— General
Name : Controls Monitors for Problems
Description
Member of -
Business Services
Calendar : | System Default M= Time Zone : | System (AmericaMew_York) v

Triggered by Task Status

Task(s): D

Purge By Retention
Duration o

— Status

Skip Count 0

Skip Trigger if
Active a

Task Monitor Details
’V Task Monitor : |Monitors for Problems B

Restrict Times : [0]
Special Restriction : [7]

[E] save [ save & New Save & View 3 Close

Step 4 On the Task Monitor Triggers list, right-click Controls Monitors for Problems and then click Enable.

Running the Task Monitor

To test our set-up, we need to run a task to one of the failure statuses that will trigger the email. To do so, we will launch the Pause for Manual Manual task created in the Running a Workflow with a
Conditional Path tutorial and force it into Failed status.

Step 1 From the Automation Center navigation pane, select Tasks > Manual Tasks. The Manual Tasks list displays.
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Step 2

Step 3

Step 4

Step 5

Step 8

Right-click the Pause for Manual task and, on the Action menu, select Launch Task.

Display the Activity Monitor. It will list the Pause for Manual task instance, in Action Required status, and the Monitors for Problems Task Monitor task, which was launched when enabled the Controls Monitor for

Problems triggered

Dashboards Activity [ Manual Tasks
23 Task Instances || Last48 hours = [ No quick filter ~ || Custom Filter|— None —
Instance Name Type Status Invoked By Start Time:

[E] Pause for Manual
[Z] Monttors for Problems.

Manual Action Required Manually Launched 2014-08-05 14:09:26 -0400

Task Monitor Running Trigger: Controls Monitors for Problems 2014-09-05 14:08:57 -0400

End Time

| g Filter..
Updated ™ 7
2014-09-05 14:09:26 -0400
2014-09-05 14:08:57 -0400

Right-click on Pause for Manual to display an Action menu of actions currently available for this task instance.

Click Cancel. Pause for Manual goes to Cancelled status and an Email task is launched by the Task Monitor trigger.

Dashboards Activity Manual Tasks
24 Task Instances \.|Last48 hours = | [4No quickfiter » | Custom Filter —None —
Instance Name Type Status Invoked By Start Time

[] Triggered by Task Status Email Success Trigger: Controls Monitors for Problems 2014-08-05 14:19:31 -0400
[Z] Pause for Manual Manual Cancelled Wanually Launched 2014-09-05 14:09:26 0400
[=] wonttors for Problems  TaskMonftor  Running Trigger: Controls Montors for Problems 2014-08-05 14:08:57 -0400

End Time:
2014-09-05 14:19:32 -0400
2014-09-05 14:19:31 -0400

v | 5B Filter
Updated ™ A
2014-08-05 14:19:32 -0400
2014-09-05 14:19:21 -0400
2014-08-05 14:19:31 -0400

Check the Email account where you sent the notification.
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Step 9 Once the user receives the email, the user can quickly check for more information by looking at the Activity Monitor using the Cancelled Task Instances filter and clicking on the Instance Name of the problem task. As
shown in the illustration below, additional information about the issue is displayed in the Status Description field.

Manual Task Instance Details: Pause for Manual =63

[7] update & Re-run [ ViewParent ¢ Delete [[4 Refresh £ Close

Manual Task Instance Virtual Resources Exclusive Requests @ Notes
— General
Instance Name : | Pause for Manual Reference Id 1
Task: |Pause for Manual |j Invoked By : |Manually Launched

Task Description A Manual task run at 2014-09-05 14:09:26 -0400|

WMember of Execution User: |ops.admin
Business Semvices
= Time Zone

Calendar : | System Default
= Preference

- System Default—

Virtual Resource 10 - Hold Resources on o
Priority Failure

— Status

Status ;| Cancelled

. ... State was cancelled from ACTION REQUIRED to CANCELLED
Status Description :

Start Time : 2014-09-05 14:09:26 -0400 End Time : | 2014-09-05 14:19:31 -0400

Duration

— Wait'Delay Options
Wait Duration In

Wait To Start : | Seconds v 60
Seconds:
Delay On Start | Seconds v Delay Duration In
Seconds :
‘Workflow Only : No -
— Time Options
Late Finish : Late Finish Type : | Duration
Late Finish .
Finished Late : Duration 00 02 00 HH:MM:SS
Critical Path Options
’V CP Duration CP Duration Unit: |Minutes v

 Statistics
User Estimated Average Estimated 7 7
End Time End Time 2014-09-05 14:00:26 -0400
Shortest Estimated Longest Estimated
End Time End Time
[l Update 3 Re-run o View Parent & Delete 5| Refresh # Close

e
For additional information, see:

Email Task

Email Connections

Email Templates

Report Details

All Task Instances Table (ops_exec)
Activity Monitor

Task Monitor Task

Task Monitor Trigger
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® Command Quick Reference
® Cancelling a Task Run
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Tutorial - Launching Tasks Using a Cron Trigger

Create a Cron Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Cron Triggers. The Cron Triggers list displays.

Step 2 Click the New button to display Cron Trigger Details for a new trigger and enter/select the following values:

® Name = Launch Tasks Using Cron

® Task(s) = stonebranch-timertask-01, stonebranch-timertask-01=2, and stonebranch-timertask-03 Timer tasks

® Minutes = Number of minutes past the hour you want the tasks to run. For example, if you want the tasks to run at for 3:16, enter 16.

® Hours = Hour (in 24-hour time) that you want the tasks to run. For example, if you want the tasks to run at for 3:16, enter 15. Universal Controller uses the time zone of the Controller server.

Step 3 Keep the asterisks ( *) in the remaining fields and click the Save button.

F

Cron Trigger Details —lEl%
[E] save [R save&New [F] Save & View 8 Close

Cron Trigger

— General
Hame : Launch Tasks Using Cron
Description :

Member of
Business Services

Calendar: |System Default MBS Time Zone : | System (America/New_York) .
stonebranch-timertask-01
stonebranch-timertask-02 =

Task(s}: | stanebranch-timertask-03 D

Purge By Retention
Duration a

— Status

Forecast: [F]
Skip Count: 0

Skip Trigger if
Active a

Simulate : |- System Default — »

— Cron Details
Minutes: 50 Day Logic: And v
Hours: 16
Day of Month: *
Month: *
Day of Week: *
Cron Criteria: |50 16***

Restrictions
(Spema\ Restriction : [7]

[l save

I Save & New || [[5] Save & View & Close

Step 4 In the Cron Triggers list, right-click Launch Tasks Using Cron and click Enable.

Step 5 Open the Activity Monitor to see that three Timer tasks are run at the selected time.
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e
For additional information, see:

® Cron Trigger
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Tutorial - Aborting a Process Launched by a Task

You can use an Abort Actions to instruct Universal Controller to abort a process under certain conditions. For example, you may want to abort a task if it is running too long

In this tutorial, we will set a Timer task to run for 60 seconds and specify an Abort Action when the task runs 45 seconds.

Step 1 Open the Timerl task created in the Creating a Simple Workflow tutorial and enter / select the following values:

® Time in Seconds = 60

® Late Finish = enabled

® Late Finish Type = Duration

® Late Finish Duration = 00:00:45

Timer Task Details: Timer 1

= |ax
[E] update [l Launch Task g5 View Parents [y Copy (ff] Delete [[5 Refresh £ Close
Timer Task Variables Actions. Virtual Resources Mutually Exclusive | © Instances. Triggers Notes | @ Versions
— General
Task Name : Timer 1 Version : 2
Task Description
Member of
Business Senvices Operations, Tech Support ~
Resolve Name Time Zone
Immediately : 0 Preference ; - SYStem Default— e

Hold on Start: [

Virtual Resource - Hold Resources on
Priority

Failure : a

— Timer Details

Timer Type . Seconds

Timer Duration In

Seconds: 50

— Time Options
Late Start: [

Late Finish  Day Hour Min Sec

Duration | Duration:[00 [+ |[00 [v[[o0 [« [[45 [+

Late Finish : Late Ell;;zh
Early Finish : [T

User Estimated __Day Hour Hin Sec
Duration : v v v v

CP Duration

Critical Path Options
’7 CP Duration Unit : | Minutes

— Workflow Options
Execution
Restriction : 1%~ hd
— Statistics
First Time Ran :|2017-05-05 15:23:18 0400 Lowestinetance [+ inute 0 Seconds
Last Time Ran - |2017-05-05 16:23:18 -0400 Average '"ST'fm"Ze 1 Minute 0 Seconds
Last\nsta_nce 1 Minute 0 Seconds Highest Instance 1 Minute 0 Seconds
Duration Time
Number of 1
Instances
o pdate aunch Tas| lew Parents opy :| Delete % Refres 0se
] Updat Launch Task | || View Parent [ Delet Refresh ¥ cl

Step 2  Click the Actions tab to display the Actions list.
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Step 3  Click Abort Action to display the Abort Action list.

Step 4  Click New to display Abort Action Details for a new Abort action, enable On Late Finish, and click Save.

Abort Action Details B
[E] save [ saveaNew [f] Save&view 3 Close

Abort Action

[ Action Criteria

Status : -
Exit Codes :
On Late Start: [
On Late Finish :
On Early Finish - [5]

Description :

[ Action Details

Cancel Process I! &} Override Exit Code

Halt On Force Finish : [7]

[ save [ Save & New Save & View 3 Close

Step 5 Click the Timer Task tab and then click the Update button.
Step 6  Right-click Timer1 in the Timers Tasks list and click Launch Task.

Step 7 Navigate to the Activity Monitor and verify that after running for 45 seconds, the task instance status changes from Running to
Finished.
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Step 8

Open the task instance Details and note the status description indicates:

Fi ni shed due to abort action on Tiner 1

F

Timer Task Instance Details: Timer 1

=3[

‘H Update 0@ Re-run c§i] Delete ||% Refresh 3£ Close ‘

Timer Task Instance H Virtual Resources |

— General

Exclusive Requests H

Notes |

Instance Name |T\mer1

Task |T\mer1

Invoked By |Manua|\y Launched ‘

Task Description

Member of

Business Services |Dperatmns‘ Tech Support

Execution User |ups admin ‘

Calendar |Syslem Default

Virtual Resource

Priority |10

f]

Jime Z0N | System Deautt -
Preference :
Hold Resources an
Failure a

- Status

status : [Finished

Status Description

Finished due to abort action on Timer 1. {Last Status=Running, Cancel Process If Acive=false, Halt On Force Finish=false} ‘

Operational Memo

Trigger Time |

Launch Time : [2017-10-26 15:43:17 -0400 |

Start Time |2017—10—26 15:43:17 -0400

End Time : [2017-10-26 15:44:02 -0400 |

Duration |4559:unds

Run Until Time |2017—10—26 15:44:17 -0400

— Timer Details

Timer Type |Seconds

Timer Duration In 50
Seconds :

— Time Options
Late Finish

Finished Late

Late Finish Type |Duralmr|

Late Finish _ Day Hour Hin Sec
Duration : |00 00 00 45

— Statistics
User Estimated Average Estimated e
S T | g Time. |2017-10-26 15:43:17 0400 |
Shortest | ‘ Longest | ‘
End Time End Time
| Update || @@ Rerun || ¢ Delete || [ Refresh || 3§ Close |

For additional information, see:

® Setting Up Abort Actions
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Tutorial - Force Finishing, Force Finish-Cancelling, and Cancelling a Task

In this exercise, we will force finish, force finish/cancel, and cancel tasks within a workflow from three areas:
® Workflow Monitor
® Activity Monitor
® Task Instances list
You can run any of these three commands from any of these three areas. For stand-alone tasks, you can run these commands only from the Activity Monitor and Task Instances list.

Note

1
You can force finish, force finish/cancel, and cancel any task in Running status, but you only can force finish a task in Waiting status. See Manually Running and Controlling Tasks for a complete list of task
statuses for each command.

Step 1  Fromthe Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks list displays.

Step 2 Create a Workflow with an Agent-based task, such as a File Monitor task, that can be Force Finished, Force Finish / Cancelled, and Cancelled. (See the Creating a Simple Workflow tutorial for help on creating the
Workflow.)

Step 3  Click Launch Task to run the Workflow.
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Step 4 Force Finish a task from the Workflow Monitor:

1. From the Automation Center navigation pane, select Task Instances > Task Instances to display the Activity Monitor which displays, by default, a list of Active Task Instances.

2. Open the running Workflow and click the View Workflow button to display its Workflow Monitor.

3. Right-click a Waiting task and, from the list of Commands on the pop-up menu, click Force Finish. The status of the task changes from Waiting to Finished, and all successor task instances waiting for successful
completion of this task instance will start.

View/Edit
View/Edit In Tab

Commands Clear All Dependencies
Clear Predeceszors
View Predecessors/Successors Force Finish

Force Finish (Halt)
Insert Task As Predecessor... Hold

Inzert Task As Successor.. Skip

Details

Properties

Step 5 | Force Finish/Cancel a task from the Activity Monitor:

1. Return to the Activity Monitor.
2. Right-click a Simple Workflow task that is in the Running status and, on the Action menu, click Force Finish/Cancel. The status of the task changes from Running to Finished, and all successor task instances
waiting for successful completion of this task instance will start.

23 Task Instances
Instance Name Type Status
Danstonebi File Monitor Running

FOREVER |

#2 Force Finish Force Finish Timer

ecu-sleep-; & cancel Force Finish (Halt) Timer

stonebrang - Workflow Runnin
Force Finish/Cancel 2

workflaw-1 ) Force FinishiCancel (Halt) Workfiow Suscess

sysmon-dis — System Monitor SUCCESS
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Step 6  Cancel atask from the Task Instances list:

1. From the Automation Center navigation pane, select Task Instances > Task Instances to display the Task Instances list.
2. Right-click a Simple Workflow task in the Running status and, on the Action menu, click Cancel. The status of the task changes from Running to Cancelled, and all successor task instances waiting for successful
completion of this task will remain in the Waiting status. The status of Simple Workflow changes from Running to Running/Problems.

¥ Z3 Task Instances

Instance Name v | Type Status

Danstonebranch-filemonitnr-ni File Monitor Running

FOREVER Timer

3 -
ecu-sleep-30 @i Force Finish Timer

stonebranch-workflo @ ancs Workflow Running

e
For additional information, see:

Force Finishing a Task

Cancelling a Task

Force Finish / Cancelling a Task

Monitoring Activity from the Activity Monitor
Monitoring Activity from the Task Instances List
Monitoring Workflows
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Tutorial - Accessing Task Instance Details

Step 1 From the Automation Center navigation pane, select Task Instances > Activity to display the Activity Monitor.

Step 2  Click the Instance Name of any task instance to display its Task Instance Details. For example:

15
Timer Task Instance Details: Timer 1 =/alx
[F] Update [ Re-un (ff] Delete | % Refresh 3 Close
Timer Task Instance Virtual Resources Exclusive Requests Notes
— General
Instance Name ;| Timer 1 Reference Id 1
Task: |Timer 1 = Invaked By - |Manually Launched
Task Description
Member of
Business Services Operations, Tech Support Execution User : |ops.admin
Time Zone
Calendar : | System Default Preference - System Default —
Virtual Resource Hold Resources on
Priority o e Failure O
— Status
Status : | Finished
Status Description Finished due to abort action on Timer 1. {Last Status=Running, Cancel Process If. , Halt On Force Fi }
Operational Memao
Trigger Time Launch Time : |2017-10-26 15:43:17 -0400
Start Time © |2017-10-26 15:43:17 -0400 End Time : |2017-10-26 15:44:02 -0400
Duration : |45 Seconds
Run Until Time ;| 2017-10-26 15:44:17 -0400
— Timer Details
Timer Type . | Seconds »
Timer Duration In
60
Seconds :
— Time Options
Late Finish Late Finish Type : | Duration
Late Finish _ Day Hour Win Sec
Finished Late Duration - [00 00 00 45
— Statistics
User Estimated Average Estimated
End Time End Time 2017-10-26 15:43:17 -0400
Shortest Estimated Longest Estimated
End Time End Time
[E] update @ Re-run & Delete 5| Refresh 3 Close

Task Instance Details contain many fields not displayed in the Task Details for this task that provide information about this run (instance) of the task and all runs of the task, including the first time it was run; the
last time it was run; the number of times it has run; and the least, average, and most amount of time it has ever taken to run. |

Step 3 To view all details stored in the All Task Instances table (ops_exec) for this task instance, right-click anywhere in the Task Instance Details to display an Action menu and then click Details > Show Details.
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[Dashbuams E:i][ Activity Ei][TmTasm E:i][ Timer 1 [

Agent:

Agent Acquired:

Agent Acquired Hame:

Agent Cluster Acquired:

Agent Cluster Acquired Name:

Agent Hame:
All Dependencies Cleared: | falze
Attempt: 1
Average Estimated End Time: | 2017-05-05 15:32:03 -0400
Calendar: | 77171434c0a801c50168d5b62b5d 1 7ddee
Calendar Hame: | System Default
Can Delete: | true
Can Update: | true

Class: | ops_exec_sleep

CP Duration:

CP Duration (Resolved):
CP Duration Unit: | Minutes

CPUTime: | 0
Created: | 2017-05-05 15:31:02 -0400
Created By: | ops.admin
Credentials:
Credentials Name:
Credentials Unresolved:
Credentials Variable: | false
Critical: | false
Current Retry Count: |0
Delay Duration: | 00:00:00:00
Delay Duration In Seconds:
Delay On Start: | — None —
Duration: | 45 Seconds
Duration In Seconds: | 45
Early Finish: | false
Early Finish Duration: | 00:00:00:00
Early Finish Time: | 00:00
Early Finizh Type: | Time
End Time: | 2017-05-05 15:31:48 -0400
Exclude Backup: | false
Exclusive State: | Initial

Execution User: | ops.admin
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Exit Code:

Finished Early:

falze

Finished Late:

true

Forced Finished:

true

Hold on Start:

falze

Hold Reason:

Hold Resources on Failure:

false

Instance Hame:

Timer 1

Invoked By:

Manually Launched

10 Other:

0

10 Reads:

]

10 Writes:

]

Is Version:

falze

Late Finish:

true

Late Finish Duration:

00:00:00:45

Late Finish Time:

0000

Late Finizh Type:

Duration

Late Start:

falze

Late Start Duration:

00:00:00:00

Late Start Time:

0000

Late Start Type:

Time

Launch Time:

2017-05-05 15:31:02 -0400

Longest Estimated End Time:

2017-05-05 15:32:03 -0400

Maximum Retries:

]

Member of Business Services:

Operations, Tech Support

Member of Business Services:

3fal1cTd335a44f0a83c85855c833aac, 209586acia4f4eacbedBieBa3T48ceb?

Memory Peak:

]

Memory Used:

0

Next Retry Time:

Operational Memao:

Predecessors Satisfied Time:

Progress:

Projected End Time:

Queued Time:

Reference Id:

Resources Consumed:

false

Resources State:

Initial

Retention Time:

Retry Indefinitely:

falze

Retry Interval (Seconds):

60

Run Called:

true

D Critoria Do Timoe

faloa
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Run Criteria Trigger Time:

false

Run Until Time:

2017-05-05 15:32:03 -0400

Security Name:

Timer 1

Shortest Estimated End Time:

2017-05-05 15:32:03 -0400

Start Time:

2017-05-05 15:31:03 -0400

Started Late:

falze

State Changed Time:

2017-05-05 15:31:43 -0400

Status:

Finished

Status Description:

Finizhed due to abort action on Timer 1. {Last Status=Running, Cancel Process
If Active=falze}

Status History:

2017-05-05 15:31:0Z -0400: Defined
2017-05-05 15:31:03 -0400: BRunning
2017-05-05 15:31:48 -0400: Finished

Suppress Intermediate Failures:

false

Tab Hames Containing Data:

Table Hame:

ops_exec_sleep

Task:

6fb0f88152a7488ab7 3485847 c5f53e5

Task Description:

Task Hame:

Timer 1

Task Priority:

WMEDIUM

Time Wait State:

Initial

Timer Day Constraint:

— None —

Timer Duration:

00:00:00:00

Timer Duration In Seconds:

60

Timer Time (HH:MM):

0000

Timer Type:

Seconds

Trigger:

Trigger Hame:

Trigger Time:

Type:

Timer

Universal Template:

Universal Template Hame:

Updated:

2017-05-05 15:31:48 -0400

Updated By:

ops.system

User Defined Field 1:

User Defined Field 2:

User Estimated End Time:

uuiD:

145374909626278454885Y UYMISTOCZ

Vertex Id:

Virtual Resource Priority:

10

Wait Day Constraint:

— None —

Wait Duration:

00:00:00:00
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Wait Duration In 3econds:

Wait Time (HH:MM): | 00:00
Wait To Start: | — None —
Wait Until Time:
Waited for Exclusive: | false
Waited for Resources: | false
Workflow:
Workflow Definition:
Workflow Definition Hame:
Workflow Name:
Workflow Only: | Yes

Workflow Start Time:

Print |

® Left column shows each field in the All Task Instances table for this task instance.
® Right column shows the current value for each field for this task instance.
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Tutorial - Monitoring Task Activity

® Starting and Stopping the Activity Monitor
® Apply Time Constraints and Filters to the Activity Monitor
* Apply Display Settings to the Activity Monitor

In this tutorial, we will monitor task activity from the Activity Monitor.

We will start and stop the Activity Monitor, apply time constraints and filters to the task instances displayed on the Activity Monitor, and apply display settings to the Activity Monitor.

Starting and Stopping the Activity Monitor

By default, the Activity Monitor does not automatically monitor Universal Controller activity when you log in. You must start the Activity Monitor to see task activity.

(You can allow the Activity Monitor to automatically monitor Controller activity when you log in by changing the Activity Monitor Automatically user preference.)

Step 1 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Dashboards Activity
7|Last48 hours » | [ No quickfilter ~ | Custom Filter — None — v | B Fiter..| &
Instance Name = Type Status. Invoked By Start Time End Time Updated =
B)
Click to start the Activity monitor
Start Stop

1 m ~
5 Seftings ~ ng H 4 b B Page of
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Step 2 To start the Activity Monitor, either:

1. Click the Click to start the Activity monitor button in the middle of the Activity Monitor.
2. Click the Start Activity monitor button at the bottom of the Activity Monitor.

The Activity Monitor then displays a list of all current activity.

Dashboards Activity 3
646 Task Instances || Last48 hours « @Nu quickfilter =  Custom Filter —None — v ‘@ Filter. &
Instance Name Type Status Invoked By Start Time End Time Updated ¥ -
tecu-wkfl-sleep Workflow  Success  Manually Launched 2014-09-02 12:57:55 0400 2014-09-02 12:58:36 0400 2014-09-02 12:58:36 -0400
sleep 10 Timer Success Workflow: 'ecu-wkfl-sleep 2014-08-02 12:58:26 -0400  2014-09-02 12:58:36 -0400  2014-08-02 12:58:36 -0400
Sleep 30 Timer Success Workflew: lecu-wkfl-sleep 2014-09-02 12:57:56 -0400  2014-09-02 12:58:26 -0400  2014-09-02 12:58:26 -0400

Skeep 0 Timer Success  Workflow: lecu-wkfl-sleep 2014-09-02 12:57:5 20140902 12:57:56 0400  2014-09-02 12:57:56 -0400
Sleep 60 Timer Skipped Workflow: 'ecu-wkfl-sleep 2014-08-02 12:57:55 0400  2014-08-02 12:57:55 -0400
Sleep 60 Timer Skipped Workflow: lecu-wkfl-sleep 2014-09-02 12:57.55-0400  2014-09-02 12:57.55 -0400
Sleep 80 Timer Skipped Workflow: 'ecu-wkfl-sleep 20140902 12:57:55 0400  2014-09-02 12:57:55 -0400
Sleep 30 Timer Skipped Workflow: 'ecu-wkfl-sleep 20140902 12:57:55 0400  2014-09-02 12:57:55 -0400
Sleep 30 Timer Skipps Workflow: lecu-wkfl-sleep 2014-09-02 12:57.55-0400  2014-09-02 12:57.55 -0400
win-exit-code Windows Failed Manually Launched 20140902 12:44:03 0400 2014-09-02 12:44:03 0400  2014-09-02 12:44:03 -0400
z0s-workflow-regrassion-test Workflow Success  Manually Launched 2014-08-02 11:52:47 0400 2014-09-02 12:10:30 -0400  2014-08-02 12:10:30 -0400

zos-workflow-simple-load-test-01  Workflows Success Workflow: zos-workflow-regression-test ~ 2014-09-02 11:56:39-0400  2014-09-02 12:10:30 -0400  2014-09-02 12:10:30 -0400

zos-task-load-simple-01 2/0S. Success  Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:28 0400 2014-09-02 12:10:29 -0400  2014-09-02 12:10:30 -0400
z0s-task-load-simple-01 /05 Success  Workflow: zos-workflow-simple-ioad-test-01 2014-08-02 12:10:25 0400 2014-09-02 12:10:26 -0400  2014-09-02 12:10:27 -0400
zos-task-load-simple-01 zI0S Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:23 -0400  2014-09-02 12:10:23 -0400  2014-09-02 12:10:24 -0400
2z0s-task-load-simple-01 /03 Success  Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:20 -0400  2014-09-02 12:10:20 -0400  2014-09-02 12:10:21 -0400

zos-workflow-simple-load-test-02  Workflow Success  Workflow: zos-workflow-regression-test  2014-08-02 11:56:39 -0400  2014-08-02 12:10:19-0400  2014-09-02 12:10:19 -0400

zos-task-load-simple-02 zI0S Success Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:17 -0400  2014-09-02 12:10:17 -0400  2014-09-02 12:10:19 -0400
2z0s-task-load-simple-01 ELES Success  Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:15-0400  2014-09-02 12:10:15 -0400  2014-09-02 12:10:19 -0400
z0s-task-load-simple-02 /05 Success  Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:12 0400 2014-08-02 12:10:12-0400  2014-09-02 12:10:15 -0400
zos-task-load-simple-01 zI0S Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:11 -0400  2014-09-02 12:10:11 -0400  2014-09-02 12:10:14 -0400

zos-workflow-simple-load-test-03  Workflow Success  Workflow: zos-workflow-regression-test  2014-09-02 11:56:39-0400  2014-09-02 12:10:13-0400  2014-09-02 12:10:13 -0400

i s e s B s B s v B O s s o T

z0s-task-load-simple-03 zi0S Success Workflow: zos-workflow-simple-load-test-03 2014-08-02 12:10:08 -0400  2014-08-02 12:10:09 -0400  2014-09-02 12:10:13 -0400

zos-task-load-simple-02 zI0S Success Workflow: zos-workflow-simple-load-test-02 2014-03-02 12:10:07 -0400  2014-03-02 12:10:03 -0400  2014-03-02 12:10:11 -0400

zos-task-load-simple-01 zI0S Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:06 -0400  2014-09-02 12:10:06 -0400  2014-09-02 12:10:10 -0400
5 m >
{85 Settings ~ |[(0) | @ M q Next B Last Page 1 i 26

Step 3 To stop the Activity Monitor, click the Stop Activity monitor button at the bottom of the Activity Monitor.

Apply Time Constraints and Filters to the Activity Monitor
(You can select apply any time constraint for any combination of multiple filters for the list of task instances on the the Activity Monitor.)

Step 1 Select a time frame of task activity to display on the Activity Monitor by clicking the Time Constraint button and selecting a time fame from the menu. The default is Last 48 hours, which means that the Activity Monitor
will display only task activity that occurred in the last 48 hours.

Step 2 Click the Quick Filter button to display a menu of simple, pre-defined filters that you can apply to the list, such as a specific task type of specific task instance status. You can apply as many Quick Filters as you like to
the list.

Step 3 Click the Clear button at the bottom of the Quick Filter menu to remove all Quick Filters from the list.

Step 4 Click the Filter button to select a Custom Filter of complex, user-defined filter that you can apply to the list, such as only task instances that belong to a specific Business Service.
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Apply Display Settings to the Activity Monitor

Step 1 Click the Settings button at the bottom of the Activity Monitor to select:
® Number of task instances to display on each page of the Activity Monitor.
® Refresh rate for the dynamic data displayed on the Activity Monitor.
Step 2 Click the First, Prev, Next, and Last buttons at the bottom of the Activity Monitor to navigate through multiple pages of
activity.

Step 3 Click the ellipse ( ... ) button at the bottom of the Activity Monitor to select a specific page of activity to display.
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Tutorial - Creating a Simple Workflow

® Introduction

® Create and Copy Tasks

® Creating a Simple Workflow
® Running the Workflow

Introduction

In this tutorial, we will learn how to copy tasks, create a simple Workflow of Timer tasks, and use the tools available in the Workflow Editor.

Create and Copy Tasks

Create a Timer task and make five copies for use in the Workflow. Use the names Timer1 through Timer6, and assign each task a time of 10 seconds.

Note
1
You can copy tasks using different methods. One method is provided below.

Step1  From the Automation Center navigation pane, select Tasks > Timer Tasks. The Timer Tasks list displays.

Step 2  Inthe Timer Task Details below the list, create Timerl and click Save.
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Step 3 Change the Task Name from Timer1l to Timer2, right-click the Details to display an Action menu, and click Insert to make a copy of the Timerl task named Timer2.

Timer Task Details: Timer 1 =]
[ Update [} Launch Task [& ViewParents [ Copy ¢ Delete | % Refresh &£ Close
Timer Task Variables Actions Virtual Resources Mutually Exclusive Instances Triggers Notes Versions
[ General [E) Launch Task
Task Name : Timer 2 Version : 1 [Z] Launch Task with Variables
Task Description
Member of [Z openinTan "
Business Services
Resolve Name Time Zone
Immediately a Preference . — Ststem Default — [E] Update
Hold on Start: [ Update & View
Virtual Resource - Hold Resources on ] #l Insert
Priarity | 10 Failure - B Insert & View
Copy —
— Timer Details —
Timer Type - | seconds s &4 ViewBundles
Timer Duration In @) Add To Bundle
Seconds:
= Promote
r— Time Qptions —
Late Start [7] Reset Statistics
Late Finish: [] [
Early Finish : [ __'ﬂ Set Execution Restriction
User Estimated _ Day Hour Min Sec b
Duration v . 03 3
&y View Parents
Critical Path Options
’7 CP Duration P Duration Unit- [1inutes | Delete
— Workflow Execution Options 3 Close _—
Execution N . e
Restriction : ~Mone = @ Details .
[F] Update | |[5) Launch Task |[&5 View Parents Ll Copy ci#] Delete 5| Refresh 3 Close %l Refresh
£

Step 4 Repeat Step 3 for Timer3 through Timer6.

Creating a Simple Workflow

Now that we have six Timer tasks, we are ready to create a simple workflow.

(See Creating and Maintaining Workflows for detailed information on the tools and icons used in this procedure.)
Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks List displays.

Step 2 In the Workflow Task Details below the list, enter Simple Workflow in the Task Name field and then click the Save button.
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Step 3  Right-click Simple Workflow in the Workflow Tasks list and click Edit Workflow in the Actions menu to display the Workflow Editor.

Administrator » 53 2]
Workflow Tasks Workflow Editor

ClodSIBIRMr Ao +BaX|Aad8d|Es|Be0E

By default, the Workflow Editor displays in Select mode, which lets you select tasks for the Workflow.

(See Workflow Editor Icons for a description of each icon on the toolbar.)
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Step 4
Click the Add Task

[a

icon. The Task Find pop-up dialog displays.

Task Find

(=)<

Task Name:

All Task Types

j Search |

| | Task Type

Task Name

al

Step5  Select Timer in the drop-down list and click the Search button. A list of all Timer tasks displays.
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Step 6 Drag and drop the icon for Timerl onto the Workflow Editor canvas, and repeat for Timer2 through Timer6.

C e

Timert

© ¢

Timer5

Timer2

Workflow Tasks ] | Workflow Editor ]

oS BRIFM. /o +BEXAAAAA |54 BSE

Task Find ]|
Task Hame: Timer Timer ~| Search
G [ TaskType Task Name
QO Timer Timer1
Timer3 Q Timer Timer2
Q Timer Timer3
Q Timer Timerd
QO Timer Timers
G O Timer Timers
Timerg
q | I
Workflow Name: Simple Workflow

Step 7 Close the Task Find pop-up dialog.
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Step 8 Click and drag the tasks so that Timerl is at the top of the canvas; Timer2, Timer3, and Timer4 are below Timerl; and Timer 5 and Timer6 are below Timer2, Timer3, and Timer4.

Workflow Tesks [£] | Workflow Editor [

Gl S IBIROS A on+BaX|Aaaaad|44|BSE

\C)

Timer1
Timer2 Timer3 Timerd

@ ©

Timers Timerf
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Step 9 Click a Connect Icon to connect the tasks so that Timerl is the top-level predecessor task; Timer2, Timer3, and Timer4 are successor tasks to Timerl; and Timer5 and Timer6 are successor tasks to Timer3.

Workflow Tasks Workflow Editor

ClORSIBIFM S A 0a¢BEXAA43 (446 BSB

)

Timeri

f
¢ © ¢

Timer2 Timer3 Timerd
Timers Timer6
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Step 10 The default condition (or dependency) for connectors is Success. That is, a successor task runs if its predecessor task goes to Success. To view the conditions for a successor task, right-click the connector between it
and its predecessor task, and then click Conditions. The Conditions pop-up displays.

Workflow Tasks Workflow Editor

GIOHBIBIFM T /o b@EXA8a8dlds BS&E

o

Timeri

I
¢ © ©

Timer2 Tgner} Timer4
Conditions
& success
e T Faiure
 successiFaiure
© Exit Codes)
Timer5s Tim
OK | Cancel

Note

1
Since a Timer task cannot go to Failure, the Failure and Success/Failure conditions are grayed out.

septt | ) | =M. |
P Click the Cancel button on the Conditions pop-up, and then click the Save icon in the Workflow Editor task bar to save the Workflow.

Running the Workflow

Now we will manually launch the Workflow and view it from the Activity Monitor.
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Step 1 Right-click anywhere in the Workflow Editor canvas and, on the pop-up menu that displays, click Launch Workflow.
Workfiow Tasks [ | Workflow Editor [
Tl S FOr/oms@BaXxadaaalds BSR
/ Tmer1\
Timer2 Timer3 Timer4
/ \ VigwEdit
G G | Paste
Timers Timers
Find In Graph
Pan To Top
Workflow Name: Simple Workfiow
Step 2  Fromthe Automation Center navigation pane, select Task Instances > Activity. You will see six task instances: the Simple Workflow task, and the six Timer tasks.
Home [ | Workflow Tasks [ | Workflow Editor 3 | Activity [
|--|Last48 hours ~  Custom Filter — none — ~ \@ Filter...
Instance Name Type Status Invoked By Start Time End Time ¥
E| Timers Timer Success Workflow: Simple Workflow — 2014-07-28 11:38:54 -0400  2014-07-28 1
E| Timers Timer SUCCess Workflow: Simple Workflow  2014-07-28 11:38:54 -0400 2014-07-28 1
El Simple Workflow Workflow Success Manually Launched 2014-07-28 11:38:34 -0400  2014-07-28 1
E| Timer2 Timer SUCCESS Workflow: Simple Workflow — 2014-07-28 11:38:44 -0400 2014-07-281
E| Timer3 Timer SUCCESS Workflow: Simple Workflow  2014-07-28 11:38:44 -0400 2014-07-281
El Timer4 Timer Success Workflow: Simple Workflow  2014-07-28 11:38:44 -0400  2014-07-28 1
E| Timer1 Timer SUCCESS Workflow: Simple Workflow  2014-07-28 11:38:34 -0400 2014-07-281

For additional information, see:

® Saving, Updating, Deleting, and Copying Records
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® Creating Workflows
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Tutorial - Running a Workflow with a Conditional Path

® [ntroduction
® Prerequisite
Create a Timer Task
Create SQL Tasks
Create a Manual Task
Create a Workflow
Run the Workflow to Success
Run the Workflow Down the Conditional Path

Introduction

In this exercise, we will create a short workflow of SQL tasks. We will begin with a two-minute Timer task so that we will have enough time to see what the Workflow looks like on the Activity Monitor when we
launch it. We will also create a conditional path, as follows:

* The Workflow runs seven days a week and creates a new database table. If that is successful, additional SQL tasks run that insert a value, select a count, and delete a value. Each subsequent task
runs if the previous is successful.
® |[f the first (table creation) task fails, the Workflow goes to a Manual task instead of the regular flow. This is the conditional path. The Manual task creates a pause in the Workflow and sends an Email

Notification. A user is expected to check the database and fix the problem that caused the first task to fail. If the Manual task is set to a Complete status, it goes to Success and the Workflow then
returns to the remaining SQL tasks. While the Manual task remains in the Action Required status, the successor tasks have a Waiting status.

We will also add an Email Notification and a Note to this Workflow.

Prerequisite

Since we are using SQL tasks in this exercise, you will first need to create a SQL Database Connection.

Create a Timer Task

We will add a Timer task at the beginning of our Workflow so that we will have a chance to view it when Universal Controller loads it into the Activity Monitor.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Tasks. The Timer Tasks list displays.
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Step 2 Click New to display an empty Timer Task Details and enter / select the following values:

® Task Name = Two Minute Timer
® Timer Type = Secocnds
® Time Duration in Seconds = 120

Timer Task Details =114
[E] save 03 Save & New [[j Save & View $§ Close

Timer Task

— General

Task Name : Two Minute Timer

Task Description
Member of
Business Services
Resolve Name B Time Zone
Immediately Preference :
Hold on Start: []

Virtual Resource Hald Resources on B
Priority Failure :

— System Default - v

— Timer Details
Timer Type * Seconds >

Timer Duration In

Seconds: 120

— Time Options
Late Start: []

Late Finish: [7]

Early Finish: []

User Estimated  Day Hour Min Sec
Duration v v v -

Critical Path Options
’7 CP Duration CP Duration Unit : Minutes .

— Workflow Execution Options

Execution

Restriction : [~ Nene = X

[ save I3 Save & New | | [f] Save & View 3 Close

Step 3  Click the Save button.

Create SQL Tasks

In this exercise, we will create SQL tasks that execute the following SQL commands:
® Create a new table in the database.
® Insert a value into the table.
® Select a count value from the table.
® Delete the value from the table.

Perform the following steps to create the SQL tasks:

Step 1 From the Automation Center navigation pane, select Tasks > SQL Tasks. The SQL Tasks list displays.
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Step 2 Click New to display an empty SQL Task Details and enter / select the following values:
® Task Name = SQL Create Table
® Database Connection = (the database connection you created as a [prerequisite|#Prerequisite])
® SQL Command = CREATE TABLE opswise_tut${ date("yyyyMMdd",5)} (name varchar(128), value varchar(128));

=3[

P
5QL Task Details
[E] save [ Save &New [[) Save &View 3£ Close |

| SOL Task

— General
Task Name : SQL Create Table

Task Descripfion

Member of
Busmess‘ |v|
Senvices
Resolve Name Time Zane
Immediately O Preference |— System Default — ‘v ‘
Hold on Start: []
Virtual Resource Hold Resources on
Priority ‘1[] ‘v ‘ Failure B
— SOL Details
o Da'ab.‘""“"‘_‘m Ms3ql Connection — Credentials :|
Database
Connection [ Credentials B
Variable
Variable
Maximum Rows : Aute Cleanup: [7]

CREATE TABLE gpswise_tuts{_dateCywyyMMdd™ 51} (name varchar(128), value varchar(128));

SQL Command :

esult
Fracessing : 5P Result Pracessing M

— Retry Options
Maximum Retries : 0 Retry Indefinitely : [7]

Suppress
Retry Interval
(Seconds) G0 Intermediate [7]
Failures

— Wait/Delay Options
Wait To Start — None — [v]

Delay On Slan.‘—Nune— ‘v‘

Workflow Dmy"— System Default — M

— Time Options
Late Start: [
Late Finish: [7]
Early Finish - [
User Estimated _ Day Hour Min Sec

Duration : E E/ |I/ E

’7 Critical Path Options

CP Duration CP Duration Unit - |Minutes [«

| [Jsave || save&New | [f) Saveaview|| & Close

[Em

Step 3  Click the Save button.
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Step 4  Create a SQL task called SQL Insert Value with this value:

® SQL Command = INSERT INTO opswise_tut${_date("yyyyMMdd",5)} (name, value) values (A', 'F'), (B, 'S"), (C'", 'F");

Step5  Create a SQL task called SQL Select Count with this value:

® SQL Command = SELECT count (*) as count FROM opswise_tut${ date("yyyyMMdd",5)} WHERE value = 'F

Step 6  Create a SQL task called SQL Delete with this value:

® SQL Command = DELETE FROM opswise_tut${_date("yyyyMMdd",5)};

Create a Manual Task

A Manual task is used within a Workflow to create a pause in processing, during which the user must perform some task. When the user task is complete, the user sets the Manual task to a completed state and
processing continues.

For our Manual task, we are also going to request a warning if the user takes too long to complete it.

Step 1  Fromthe Automation Center navigation pane, select Tasks > Manual Tasks and click New.
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Step 2

® Task Name = Pause for Manual
® Task Description = A Manual task run at

${_date()}

In the Manual Task Details, enter / select the following values:

(a variable that indicates the date and time the Manual task launches)
® Late Finish = enabled

® Late Finish Type = Duration
® Late Finish Duration = Hours 00 02 00 (2 minutes)

Manual

Wan

—G

B

| Task Details

ual Task

= [=)[E3

[E] save U3 Save &New [[] Save &View 3£ Close

eneral

Task Name : Pause for Manual

Task Description : AManual task run at ${_date()}

Member of
usiness Senices
Resolve Name ]
Immediately :
Hold on Start: [

Virtual Resource
Priority :

Time Zone
Preference :

Hold Resources on
Failure :

=}

— System Default — ~

— Wait'Delay Options

Wait To Start 1 | — None —
Delay On Start: | — None —

Workflow Only © | — System Default -

— Time Options

Late Start: [7]
Late Finish

Early Finish = [

UserEstimated __ Day
Duration v

Late Finish Type
Late Finish

Duration : |00

Min Sec

v v v

Hour

Duration
Day

¥ [[00 |+

Hour Hin Sec

02 |~

’7 Critical Path Options

CP Duration

CP Duration Unit | Minutes

’7 Workflow Execution Options

Execution

Restriction |~ None =

[F] save

[y save & Mew

Save & View

% Close

Step 3
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Step 4 Add a Note:

1. Click the Notes tab and then click New to display Note Details.
2. Enter the following values:

* Title = Probable database problem

® Text = Make sure database is running.

3. Click Save.
Note Details BEE
[] save g Save & New [fj Save & View 3% Close
Note
— Details =

Title : Probable database problem

Make sure database is running

Text

[ save I Save & New | | [y Save & View 3 Close
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Step 5 Add an Email Notification:

1. Click the Actions tab.
2. Click Email Notification in the list of Action types.
3. Click the New button to display Email Notification Details for a new Email Notification.
4. Enter / select the following values:
® Status = ACTION REQUIRED
® Email Connection = (the Email Connection you created earlier)
® To = (your Email address)

® Subject = Issue with Workflow
* Body = ${_date} workflow failure; notification triggered by $\{ops_task_name} |
F
Email Notification Details =/alx

[E] save [ Save & New Save & View £ Close

Email Notification

— Action Criteria

Status : |Action Required -
Exit Codes
On Late Start: [7]
On Late Finish: [F]
On Early Finish : [7]

Description

— Action Details

Email Template v |[= Email Connection | QA-MAILER v

Email Template
Variable a

Reply-To

support@stonebranch.com
To

Bee

Subject: Issue with Workflow

§{_date} workflow failure; notification triggered by ${ops_task_name}

Body

Report v\ Reportvariasle [

[l save I3 Save & New Save & View 3 Close

Step 6  Click the Save button.

Create a Workflow

Create a Workflow containing the Timer, SQL, and Manual tasks that you just created.
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Step1  Fromthe Automation Center navigation pane, select Tasks > Workflow Tasks and click New.
Step 2 In the Workflow Task Details, enter the following value:
® Task Name = SQL Workflow
Step 3 Click the Save button, right-click SQL Workflow on the Workflow Tasks list, and then click Edit Workflow on the Action menu.
Step 4 In the Workflow Editor, use the Add Task tool to drag the tasks you just created onto the canvas.

Step 5 Organize the tasks and create connections as shown in the following illustration. The Success connectors tell the Controller that if SQL Create Table goes to Success, run Insert SQL Value and the other SQL
tasks.

Step 6 Create a conditional path specifying that if SQL Create Table fails, the Controller should run the Pause for Manual task:
1. Right-click the connector between SQL Create Table and Pause for Manual.

2. On the pop-up menu, click Conditions.
3. On the Conditions pop-up dialog, enable Failure and click the OK button. Note that the connector is a dotted line, which indicates a Failure connection.

Step 7 On the Workflow Editor toolbar, click the Save icon.

\C

Two Minute Timer

5aL saL 5aL
5QL Create Table SQL Insert Value 5qL Select Count SQL Delete

1?_,

Pause for Manual

Run the Workflow to Success

We are going to launch our Workflow and view it from two different perspectives: from the Activity Monitor and the Workflow Monitor.
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Step 1 Launch the workflow manually.

Display the Activity Monitor. Because the Two Minute Timer task is still running, your display should look similar to this:

Step 2
Dashboards [] | Activity [J | Workflow Tasks ]
639 Task Instances |.|Last48 hours » | [ No quickfilter « | Custom Filter — None — v | 3 Filter.
Instance Name Type Status Invoked By Start Time: e
E‘ SQL Select Count saL ‘Workflow: SQL Workflow
E S0L Create Table saL ‘Workfiow: SQL Workflow
E Pause for Manual Manual Workflow: SQL Workflow
E‘ SQL Delete saL ‘Workflow: SQL Workflow
E SOL Insert Value saL ‘Workfiow: SQL Workflow
E Two Minute Timer Timer Running ‘Workfiow: SQL Workflow 2014-08-2215:42:21 -0
E‘ SQL Workflow Workflows Running Manually Launched 2014-08-22 15:42:20 -0
Step 3 Right-click SQL Workflow on the Activity Monitor list to display an Action menu and select Workflow Task Commands > View Workflow. The Workflow Monitor opens and shows progress on the task. The Workflow

Monitor updates automatically with each status change.

Two Minute Timer
Success

sSaL 5aL

SQL Create Table SQL Insert Value SQAL Select Count S5QL Delete
Finished

i

Pause for Manual
Action Required
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When the Timer task finishes, the SQL tasks execute. All tasks go to Success and the workflow goes to Success. The only task that did not run is the conditional task, Pause for Manual.

Sleep 2 Minutes

Success
e [54 s o
s5QL)———» saLl——m» saL)}——m@38 50L
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Success Success Success Success

Pause for Manual
Skipped

Run the Workflow Down the Conditional Path

Recall that we inserted a date variable into the INSERT TABLE command. Thus, you can run this workflow every day and get a new table name each day, based on the date. For the purposes of our exercise,
assuming you are performing it on the same day you did the previous exercise, the SQL Create Table task will fail this time because the table already exists.

Step 1 Return to the Bigger Workflow task and launch it again.
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From the Activity Monitor, click the Workflow name to view it from the canvas. This time, the workflow goes down the conditional path. Note that when you set up a conditional path, what would normally be a Failure status for the SQL Create Table

SiEp2 task becomes a status of Finished. If you ran this task as a standalone task or without the conditional path, its status would say Failed.
Sleep 2 Minntes
Success
SQL{————» (] R — s5QL ———————» SOL
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Finished
-
Pause for Manual
Action Reguin
Step 3 When the Pause for Manual task launches, it generates the Email Notification we added earlier.
from  opswise.test@gmail.com hide details 5:32 PM (0 minutes ago) | € Reply | ¥
to @ canneturn@grmail. com
date  Mon, Aug 17, 2009 at 5:32 PM
subject  lssue with Bigger Workflow
mailed-by  gmail.com
signed-by  gmail.com
2009-08-17 16:31:55 -0700 workflow failure; notification triggered by Pause far Manual
©Reply = Forward 2 jruite opswise testf@gmail.corn to chat
Step 4 The user receives the email, which provides the name of the task that generated it (Pause for Manual in our case). The user might also be running a special Activity Monitor that displays only Manual tasks in the Action Required status. According
to our scenario, the user opens the Pause for Manual task and checks the Notes to find out what action he or she is supposed to take. In our case, the Notes say to check the database and bring it back up.
Step 5 At this point, the workflow processing could continue in either of two ways:
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1. Re-run the task that failed and send the workflow down the success path.
2. Set the Pause for Manual task to Completed status and continue the workflow from there.

We will try both methods.
3. Re-run the failed task; right-click the task and select Commands > Re-run. In a real processing situation, this is the method you would use because you need to create the table before you can continue.

a. Right-click the task that failed and select Commands > Re-run.

Sleep 2 Mimnes
Success

—
]
_ - 5GL » 50L
SOL Cre T Insert Value SOL Select Count SOL Delete

Pause for Manual

Note that we are still on the same day so the task fails again because the table already exists. In a real processing situation, the task would go to Success and the subsequent tasks would run as expected.
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4. Set the Manual task to Complete status. For the purposes of our exercise, we will get the workflow going again by setting the Manual task to complete.
a. Right-click the Manual task.
b. Select Commands > Set Completed.

Cancel
Opswike - Force Finish
Agiian B Properties Set Started
|  Setcompleted
The Manual task goes to Success and the rest of the workflow runs.
Sleep 2 Minutes
Success
i
5L — sQL SOL sQL
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Finished Success Success Success
E Console | o | 4 |
E Monday, August 17, 2009 1:09:31 PM: Command Set Completed executed
. successfully against task instance Pause for Manual.
Pau:se for Mallnual
gougessy
Clear |
: 4

c. Because we set a two-minute Late Finish flag on our Manual task and we (presumably) took more than two minutes to complete it, the Manual task has been flagged as a late finish. To view the flag, go to the Activity Monitor and click
the Manual task name. In the task instance Details, an enabled Finished Late field now displays, and the Duration field indicates the duration of the task.
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For additional information, see:

Activity Monitor

Monitoring Workflows
Database Connections
SQL Task

Manual Task

Email Notification Actions
Creating Notes

Creating Conditional Paths
Adding Skip/Run Criteria
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Tutorial - Running a Workflow with Multiple Conditional Paths

In this tutorial, we will create a Workflow containing tasks with multiple predecessors and multiple successors, and specify different conditional paths for those tasks.
The Workflow will show that:

® A successor task with multiple predecessor tasks needs only one of the predecessor tasks to be Successful in order to run.
® Tasks are skipped if they are in conditional paths not taken.

Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks and click New.
Step 2 In the Workflow Details, name the Workflow Multiple Paths and click the Save button.

Step 3 Click the Edit Workflow button to display the Workflow Editor.
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Step 4 Add 10 tasks to the Workflow and specify connections for them, as shown below. (In this example, Email tasks have been added, but you can add any type of task except Timer tasks, since they have only one type of
Conditional path: Success.)

By default, all connections define a Successful condition; if the predecessor task runs to Success, the successor task will run.

Email #2 Email #3

Email #1

Email #5

Email #6

Email #7 -
Email #9

Email #8 Email #10
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Create a Failure condition between tasks #2 and #6, #3 and #6, and #6 and #9, as shown below:

Step 5
1. Right-click the connection between them,.
2. Click Conditions on the pop-up menu.
3. Select Failure.
4. Click OK.
Connections with Failure conditions displays as dotted lines.
\ (o 3 oG 3 —_— 3
Email #2 Email #3 Email #4
Email #1 / é
; 5 Email #5
Email #6
Conditions
 Success
._‘ i) ( 0 Failure
o Success/Failure
Email #7 — € Exit Code(s)
Email :
l 0K | Cancel |
Email #3 Email #10
Step 8 Launch the workflow.
Step 9 In the Automation Center navigation pane, select Task Instances > Activity to display the Activity Monitor.

292 | uc-73x-uext



Universal Controller 7.3.x General Information

Step 10  From the list of Task Instances, click Multiple Paths. The Workflow Monitor for that Workflow displays.

Email #2 Email #3 Email #4
Success Success Success
. B

Email #1
Success

Email #5
Success

Email #6
Success

Email #7

Success Email #9

Skipped

Email #8 Email #10
Success Skipped

The Workflow Monitor shows that task #6 ran even though the conditions for two of its predecessor tasks (#2 and #3) specified that it was to run only if those two tasks failed, because the condition for its #5
predecessor task specified that it was to run if #5 ran successfully, which it did.

It also shows that tasks #9 and #10 were Skipped because the Controller took the Success path for task #6 and ran Tasks #7 and #8.
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Tutorial - Running a Workflow with Skipped Criteria

® Introduction

® Create the Daily Workflow

® Run the Daily Workflow

® Check the Skipped Workflow's History

Introduction

In this exercise, we will create a daily Workflow that includes a task that we want to skip on Fridays. We will also include a Workflow within a Workflow and later check the skipped status of the skipped
Workflow.

Create the Daily Workflow

Step 1 Create a Workflow named Workflow with Skipped and add the following tasks created in the Creating a Simple Workflow tutorial:

® Four Timer tasks: Timerl, Timer2, Timer3, Timer4.
® One Workflow task: Simple Workflow.
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Step 2 Organize the tasks in the Workflow as shown in the following illustration (using all Success conditions) and click the Save icon.
Home [ | Workflow Tasks [] || Workflow Editor []
GRS |RIEM Al +sBEXA0aadl|es BSE
C—0—=2 00
Timer1 Timer2 Simple Workflow N N
Timer3 Timerd
Workflow Mame: Workflow with Skipped, Last Saved: 7/28/2014, 2:23:27 PM
Step 4 Right-click Simple Workflow and, on the pop-up menu, click View/Edit Run Criteria. The Task Run Criteria list for Simple Workflow
displays.
Step 5 Click New to display Task Run Criteria Details.
Step 6  Inthe Type field, select Skip Criteria.
Step 7 Select Specific Day(s).
Step 8 Select the current day (that is, if today is Friday, select Fri).

(See Task Run Criteria Field Descriptions for more details.)
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Step9  Click Save.

Task Run Criteria Details =|alx
5] Save [ Save & New [fj Save & View 3£ Close

Task Run Criteria

Type : | Skip Criteria v
Task: Simple Workflow «[F] Vertex1d: 6 | Simple Workfiow e
Business Day: [7]
Haliday : [[]
Specific Day(s) Sunday [] Monday Tuesday [[] Wednesday [[] Thursday [[] Friday [] Saturday []
Custom Day: []
Complex: [[]
Variable : [0]

[ save 5y Save & New | | [ Save & View ¥ Close

Run the Daily Workflow

Step 1 Right-click anywhere in the Workflow Editor and select Launch Workflow.

Step 2 Display the Activity Monitor and note that the sub-workflow (Simple Workflow) and all its sub-tasks have been skipped, as shown in the following example. Note also that this did not impact subsequent tasks, which ran

as usual.
Home Activity Workflow Tasks
6658 Task Instances |Last48 hours + | [ No quickfilter = | Custom Filter|— None — v | S Filter.
Instance Name Type Status Invoked By Start Time End Time Updated ™ ~
El Workflow with Skipped Workflow Success Manually Launched 2014-07-28 15:07:42 -0400  2014-07-28 15:08:23 -0400  2014-07-28 15:08:23 -0400
El Timerd Timer Success ‘Workflow: Workflow with Skipped 2014-07-28 15:08:13-0400  2014-07-28 15:08:23 -0400  2014-07-28 15:08:23 -0400
E Timers Timer Success WWorkflow: Workflow with Skipped 2014-07-28 15:08:02 0400 2014-07-28 15:08:12 -0400  2014-07-28 15:08:12 -0400
E Timer2 Timer Success Workflow: Workflow with Skipped 2014-07-28 15:07:52 0400 2014-07-28 15:08:02 -0400  2014-07-28 15:.08:02 -0400
] Timert Timer Success Workflow: Workflow with Skipped 2014-07-28 15:07:42 0400  2014-07-28 15:07:52 -0400  2014-07-28 15.07:52 -0400
El Simple Workflow Workflow Skipped ‘Workflow: Workflow with Skipped 2014-07-28 15.07.42 -0400  2014-07-28 15.07.42 -0400
El Timer2 Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15.07.42-0400  2014-07-28 15.07.42 -0400
El Timer3 Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15:07:42 -0400  2014-07-28 15:07:42 -0400
El Timer Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15:07:42 -0400  2014-07-28 15:07:42 -0400
El Timers Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15:07:42 -0400  2014-07-28 15:07:42 -0400
E Timers Timer Skipped Workflow: Simple Workflow 2014-07-28 1507:42 -0400  2014-07-28 15.07:42 -0400
] Timers Timer Skipped Workflow: Simple Workflow 2014-07-28 15.07:42 -0400  2014-07-28 15.07:42 -0400

Check the Skipped Workflow's History

You can view a task instance Details to find out why it has a status of Skipped. On the Activity Monitor, click the Details icon in the first column for any task instance to display its task instance Details.

For example:
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Workflow Task Instance Details: Simple Workflow

Workflow Task Instance

=|| 3|

[F] Update [58, Unskip | View Parent |z View Workflow &) Delete |/% Refresh 3£ Close

— General

Virtual Resources Exclusive Requests Step Conditions Notes
Instance Mame : |Simple Workflow Reference |d: 2
Task : |Simple Workflow D Invoked By  Workflow: Workflow with Skipped

Task Description

Member of
Business Services :

Calendar : | System Default

Virtual Resource
Priority :

Execution User : |ops.admin

prm— Time Zone

== Preference - | System Default —

— Status
Status : |Skipped

Status Description - Skipped due to runiskip criteria.

Operational Memo :
Start Time :
Duration :

Progress : |6/6

End Time : | 2014-07-28 15:07:42 -0400

— Workflow Details

Show/Hide Skipped

Tasks - Show Skipped

— Wait'Delay Options

Wait To Start: |Seconds

Delay On Start: |Seconds

Workflow Only . |No

\Wait Duration In
Seconds:

Delay Duration In 5
Seconds:

— Statistics
Lser Estimated Average Estimated
End Time : End Time:
Shortest Estimated Longest Estimated
End Time : End Time :
[E] update [% Unskip [ View Parent | | [2 ViewWorklow| | ] Delete 4| Refresh # close

Note that the Status Description field indicates that Simple Workflow was skipped due to run/skip criteria.
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For additional information, see:
® Activity display

® Monitoring Workflows
® Adding Skip/Run Criteria
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Tutorial - Finding and Inserting Tasks in an Active Workflow

In this exercise, we will run a workflow and:

® Find a specific task within the workflow. (You also can find a task in a workflow that has not yet been launched or one that has run and completed.)
® |nsert a task as a predecessor to another task in the workflow.
® Insert a task as a successor to another task in the workflow.

Note
!
You may find it easier to run a workflow three different times, once for each step in this exercise.

Step 1 Create a workflow so that all of its tasks cannot display on the Workflow Editor/Monitor at the same time.
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Step 2 Launch the workflow and right-click in the Workflow Monitor canvas. A pop-up menu displays.

stonebranch-timertask-01
Success

/
Bo— |

stonebranch-f
Run

View/Edit
View/Edit In Tab

View Children
View Tree

Commands

Show Skipped/Restore
Hide Skipped

Find In Workflow...
Pan To Top

Inzert Task...

Details

.

stonebranch-timertask-02

Email Tutorial
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Step 3 Click Find in Workflow... to display the Find in Workflow dialog.

o

stonebranch-timertask-01
Success

stonebranch-filemonitor-02
Running Email Tutorial

stonebranch-timertask-02

Find In Workflow [

Tt e

Nex‘tl Previousl starts with ( - Z
- eguals p

Email Tutorial
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Step 4 Select an operator for the search (contains, starts with, or equals), enter the full or partial name of the task(s) that you want to find, and click OK. The Controller locates and displays the first task within the Workflow
that matches the search criteria. Click the Next and/or Previous buttons to find any other tasks that match the search criteria.

o

stonebranch-timertask-01
Success

/

stonebranch-filemonitor-02
Running

Email Tutorial

|
stonebranch-timertask-02

Email Tutorial
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Step 5

Right-click the found task (stonebranch-timertask-02) to display a menu of actions available for that task.

stonebranch-timertask-01

Success

[
stonebranch
Ru

View/Edit
View/Edit In Tab

Commands

View Predecessors/Successors

Insert Task As Predecessor..

Insert Task Az Successor..

Detailz

Properties

stonebranch-timertask-01

()
b

Email Tutorial
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Step 6 Click Insert Task As Predecessor.... The Task Insert > Task Selection dialog displays.
Task Insert > Task Selection =10
Task Name: stonsbranch-manuahtask-01 Manual j Search |
| | Tazk Type Tazk Name

4| | i

Step 7 Find a task you want to insert and drag the task's icon to the workflow canvas. In this example, we have selected stonebranch-manualtask-01.
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Step 8 The Controller inserts stonebranch-manualtask-01 as a precedent to the Waiting stonebranch-timertask-02 task, and stonebranch-manualtask-01 begins running (as a Manual Task, it requires a user action).
When stonebranch-manualtask-01 completes, stonebranch-timertask-02 begins running.

\C

stonebranch-timertask-01
Success

stonebranch-manualtask-01
Action Required

L
0

/

stonebranch-filemonitor-02
Running Email Tutorial

stonehr;; rTc-h:ti-n;erta sk-02

|

Email Tutorial
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Step 9 Once again, right click stonebranch-timertask-02 to display a menu of actions available for that task.

16

stonebranch-timertask-01
Success

stonebranch-manualtask-01
Action Required

View/Edit
View/Edit In Tab

2

D

stonebranch-filemonitor-02
Running

. . Commands 3
Email Tutorial e
stonebranch-tir|

View Predecessors/Successors

Insert Task As Predecessor..

Detailz 3

Properties

Email Tutorial
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Step 10 Select Insert Task As Successor.... The Task Insert > Task Selection dialog displays.

Task Insert > Task Selection =I5
Task Name: stonebranch-filemonitor-03 File Monitar j Search |
| | Task Type Task Name

1| | i

Step 11  Find the task you want to insert and drag the task's icon to the workflow canvas. In this example, we have selected stonebranch-filemonitor-03.
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Step 12 The Controller inserts stonebranch-filemonitor-03 as a successor to stonebranch-timertask-02. When stonebranch-timertask-02 completes successfully, the inserted stonebranch-filemonitor-03 task begins
running.

S

stonebranch-timertask-01
Success

stonebranch-manualtask-01
Action Required

|
B

) —_—
stonebranch-filemonitor-02 G

Running Email Tutorial

stonebranch-timertask-02

stonebranch-filemonitor-03

|

Email Tutorial

For additional information, see:
® Finding a Task in a Workflow

® |nserting a Task in a Workflow
® Searching for and Adding Tasks
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Tutorial - Skipping, Unskipping, and Showing-Hiding Skipped Task Instances

You can skip (and unskip) individual task instances and task instances within a workflow that have been launched but have not yet started to run. For skipped tasks within a workflow, you can choose to show or
hide those tasks in the Workflow Monitor.

You also can skip a task instance so that all dependent task instances of that task instance automatically are skipped as well.
Although there are several methods for skipping, unskipping, and showing/hiding skipped task instances, in this exercise we will:
® Skip a task instance in a workflow.
® Unskip a previously skipped task instance in a workflow.

® Show and hide a skipped task instance in a workflow.

Note
1
There also are methods for skipping a task and showing/hiding a skipped task before it becomes a task instance (that is, before it or the workflow in which it resides has been launched). See the links at the

bottom of this page.

Step 1  Fromthe Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks list displays a list of all workflow tasks.
Step 2 Right-click Simple Workflow (created in the Creating a Simple Workflow tutorial), and on the Action menu, click Launch Task.
Step 3 On the Activity Monitor, select Active Workflow Task Instances from the drop-down list.

Step4  Click Simple Workflow. The Workflow Monitor displays for this running workflow.
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Step 5 Right-click the Sleep3 task while it is in Waiting status and, from the pop-up menu that displays, click Commands / Skip.

Note

1
If you wanted to skip the Sleep3 task and its dependent Sleep5 and Sleep6 tasks, you would click Commands / Skip Path.

"

Opswise - Test Email
Success

QA

View/Edit
View/Edit In Tab

Commands 3 Clear All Dependencies

o
. Clear Predecessors
View Predecessors/SuUccessors Force Finish
=]

Farce Finizh (Halt)
Sleep? Ingert Tagk Az Predecessor... Hold

[m ] Insert Task As Successor..

/ Details 3

o Properties

Sleeps Sleept

The Sleep3 status changes from Waiting to Skipped. When Sleepl completes successfully, Universal Controller will skip Sleep3 and start running Sleep5 and
Sleep6.

310 / uc-73x-uext



Universal Controller 7.3.x General Information

Step 6 To un-skip Sleep3, right-click it and, from the pop-up menu that displays, click Commands / Unskip.

Opswise - Test Email

SUCCESS
|-
View/Edit
5| View/Edit In Tab
S

View Predecessors/SUCCEsS0rs

Sleep2
Running

3t Inzert Task As Predecessor...
Sk

Ingert Task As Successor...

Details k

Properties

Sleeps Sleepb
Running Running

The task status changes from Skipped to Waiting. When Sleepl completes successfully, the Controller will not skip Sleep3.
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Step 7 To hide the skipped Sleep3 task in the Workflow Editor, right-click in the Workflow Monitor canvas and click Hide Skipped.

Opswise - Test Email
Success
View/Edit
View/Edit In Tab
Sleept View Children
Success
Commands 4
Show Skipped/Restore
Sleep? Sleepl Hide Skipp
Success Skipped
Find In Workflow...
Pan To Top
Insert Task...
Sleeps Sleept Details 3
Success Success
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Step 8 To show the skipped Sleep3 task in the Workflow Monitor, right-click in the Workflow Editor canvas and click Show Skipped/Restore.

Opswise - Test Email
Success

View/Edit
View/Edit In Tab

Sleep1
Success View Children

Commands k

ped/Restore
Hide Skipped

Sleep2
Success

Find In Workflows...
Pan To Top

Insert Task...

Sleepb Sleepb _
Success Success Details

For additional information, see:

Skipping a Task

Unskipping a Task

Showing or Hiding Skipped Tasks

Adding Skip/Run Criteria for Specific Tasks
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Tutorial - Using Variables in a Simple Task

Introduction

Resolving Variable Using Value from Global Variable Table
Resolving Variable Using Value from Task

Resolving Variable Using Value from Trigger

Introduction

Note
!
You need an Email Connection to perform this exercise.

In the Launching an Email Task Based on a File Monitor tutorial, a built-in variable called ${ ops_t ri gger _nane} and a system variable called ${ _dat e} were included to pass information into an Email
message. Those variables were resolved using system information when the email task instance was created.

In this exercise, we will create a new user-defined variable, use it in a task, and run the task both manually and via a trigger to illustrate how such variables are resolved.

Resolving Variable Using Value from Global Variable Table

Step 1 Create a Variable with the following values:

® Name = Tutorial
® Value = Global

Step2  Click the Save button.

==

[F] save [ Save &New [ Save &View $% Close

Variable Details

Variable

— Details

MName: Tutorial

Glabal

Value

Description

Member of -
Business Senices

[E] save [ Save & Mew Save & View 3 Close
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Step 3 Create an Email task with the following values:
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To = your Email address

Subject = Variable demo

Body=${Tutorial}
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Step 4 Click the Save button, re-open the task, and click th

e Launch Task button.

Email Task Details: Email Tutorial

=[=]%

| [E] Update [5) Launch Task g5 View Parents [Ty Copy g Delete [ Refresh 3% Close ‘

Email Task H @ Variables H . Actions ‘l . Virtual Resources H © Wutually Exclusive ||  Instances ‘l . Triggers ||

~ Motes | ¢ Versions |

— General

Task Name : Email Tutorial

Task Description

Member of

Busmess|

Senvices :

Resolve Name
Immediately :

Hold on Start :

Time Zone

Preference - |— System Default —

Virtual Resource |1U

Hold Resources on
Failure

Priority :

— Email Details

Email Template : |

=]

[T £mail Connection : QA-HALER

Email Template
Variable

Reply-To :

daran@stonebranch.com

Ce:

Bece

Subject: Variable Demo

${Tutorial}

Body:

Repon:l

E Report Variable

— Wait'Delay Options

Wait To Start : |— Mone —

ke

Delay On Start |— Mone —

bl

‘Workflow Only : |— System Default —

ll

— Time Options
Late Start

Late Finish
Early Finish

User Estimated _ Day
Duration

Critical Path Options

CP Duration :

(

CP Duration Unit: |Minutes

— Workflow Execution Options

Execution

Restriction |7 None —

B

| [Flupdate | [ LaunchTask] | g, ViewParents|| [ Copy

& Close

|| [ Refresh ||

|| difl Detete

(=
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Step 5  You should receive an email with Global in the body of the email.

Resolving Variable Using Value from Task

Step 1 Open the Email Tutorial task and click the Variables tab.

Step 2 Click the New button to display Variable Details for a new Variable and enter the following values:

® Name = Tutorial
® Value = Task

Step 3  Click the Save button.

Variable Details B
[E] save [ save & Mew Save & View 3¢ Close

Variable

Details

Name : Tutorial

Task

Value

Description

[E] save I save & New Save & View # close

Step 4 In the Email Tutorial Details, click the Update button and then click the Launch Task button.

Step 5  Youshould receive an email with Task in the body of the email.

Resolving Variable Using Value from Trigger

Step 1 Create a Time trigger with the following values:
® Trigger Name = Variable Demo

® Tasks = Email Tutorial
® Time = (Five minutes from the present time.)
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Step 2  Click the Save button.

Frime Trigger Details

=|[=][

‘H Save [3) Save &New [f] Save&View 3§ Close ‘

Time Trigger

— General

Name: Variable Demo

Description :

Member of
Business Services :

Time Zone : | System (America/New_York)

Calendar : |System Default

Email Tutorial

B®

Task(s):

Purge By Retention

Duration :
— Status
Forecast: [
Skip Count: 0
Skip Trigger if
Active : a8
Simulate : |—Sy5tem Defauli — M
— Time Details
Hour Hin
Time:
» v
— Day Details

@ Daily (O Business Days () Specific Day(s)

Restrictions
IVSDECIEU Restriction : [7]

| [ save || save&nNew| [ saves&view|| 3 Close

Step 3 Re-open the Variable Demo trigger and click the Variables tab.

Step 4  Click the New button to display Variable Details for a new Variable and enter the following values:

® Name = Tutorial
® Value = Trigger
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Step5  Click the Save button.

Variable Details B
[l save [ Save & New Save &View $€ Close

Variable

Details

Name : Tutorial

Trigger

Value

Description

[E] save [ Save & Mew Save & View 3 Close

Step 6  Inthe trigger Details, click the Update button and then the Enable button.

Step 7 You should receive an email with Trigger in the body of the email.

e
For additional information, see:

® User-Defined Variables
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Tutorial - Using Variables in a Workflow

Note

1
You need a working Database Connection for this tutorial.

For tasks executing within a Workflow, the order of precedence for resolving user-defined variables differs.

As the following procedure demonstrates, the variable definition in the task takes precedence, then Universal Controller looks within the Workflow or parent Workflow(s), with the global variable coming last.

Step 1  Create a SQL task called SQL with Variable with the following SQL command:

CREATE TABLE ${tutorial }${_date("yyyyMwd",5) } (name varchar(128), value varchar(128));

Step 2  Click the Save button and then re-open the task.

Step 3  Click the Variables tab and create a Variable with the following values:

® Name = tutorial
® *Value+ = task

Step 4  Click the Save button and in the task Details, click the Update button.
Step4  Create a Workflow called Variable Workflow.
Step 5  Addthe SQL With Variable task to the Workflow and save it.

Step 6 Launch Variable Workflow. and open the SQL With Variable task instance on the Activity Monitor. Note that the SQL command resembles the following, with the value from the task variable.

CREATE TABLE t ask20090913 (nane varchar (128), val ue varchar(128));

Step 7 Open the task and delete the task variable.

Step 8 Go back to Variable Workflow and add the following variable:

tutorial /workfl ow
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Step 9 Open the task instance. The SQL command used the variable from the workflow because the task no longer had a variable.

CREATE TABLE wor kf | ow20090913 (nane varchar(128), val ue varchar(128));

e
For additional information, see:

® User-Defined Variables

321 / uc-73x-uext


https://docs.stonebranch.com/confluence/display/UC73/User-Defined+Variables

Universal Controller 7.3.x General Information

Tutorial - Creating Custom Days and Periods

Introduction

Create a Custom Day

Create a Custom Period

Assigning Custom Day and Custom Period to a Calendar
Creating a Local Custom Day for a Calendar

Selecting a Custom Calendar for a Trigger

Introduction

In this tutorial, we will create a Custom Day and period for a Calendar, and assign that Calendar to a Trigger.

Create a Custom Day
In this procedure, we will create a Custom Day, which can be applied to any Calendar.
Step 1 From the Automation Center navigation pane, select Other > Custom Days. The Custom Days list displays.

Step 2 Click the New button to display Custom Day Details for a new Custom Day and enter/select the following values:

Name = Thanksgiving

Holiday is enabled

Type = Relative Repeating Date
When = 4th

Day of Week = Thu

Month = Nov
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Step 3  Click the Save button.

Custom Day Details = =63

[l save [ Save & New Save & View 3£ Close
Custom Day

— Details

Name : Thanksgiving
Description

Category: (O Day () Business Day ® Haliday () Period

Type : Relative Repeating Date v
When : 4th ~
Day Of Week : | Thu .
Month © | Nov v
Adjustment: |- None — -
9@

Actual Day Of Week Observed Day Of Week

Observed Rules

No items to show.

] save I Save & New Save & View 3 Close

Create a Custom Period
In this procedure, we will create a custom period of days, which can be applied to any calendar.

Step 1 Click the New button on the Custom Days list and to display Custom Day Details for a new Custom Day and enter/select the following values:

Name = 4th Quarter

Period is enabled.

Type = List of Dates

Dates = 2017-10-01 and 2017-12-31.

Step 2  Click the Save button.

Custom Day Details mISE

[E] save [ Save & New [[] Save &View §£ Close

Custom Day

— Details
Name : 4th Quarter
Description

Category: (O Day (OBusiness Day (O Holiday @ Period

Type : List of Dates .
Ee o=
Dates  *
Dates
2017-10-01
2017-12-31

[l save I Save & New || [ Save & View # Close
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Assigning Custom Day and Custom Period to a Calendar

In this procedure, we will assign the custom day and custom period to a new Calendar.
Step1  Fromthe Automation Center navigation pane, select Other > Calendars. The Calendars list displays.

Step 2  Click the New button to display Calendar Details for a new Calendar and enter/select the following values:

® Name = Custom Calendar #1

Step 3  Click the Save button.

Calendar Details ) (=)

[E] save [ Save & New Save & View 3£ Close
Calendar

Details
Name: Custom Calendar#1
Description
Member of Business Senvices v

Business Days: [7]Sunday [¥]Monday [¥]Tuesday [¥]Wednesday [V]Thursday [¥]Friday [ Saturday

First Day Of Week | Sunday h

[l save [ save & New Save & View 3% Close

Step 4 Re-open Custom Calendar #1 and click the Custom Days tab. The Custom Days list for this Calendar displays.

Step 5 Click the Edit button to display an Edit Members pop-up dialog of all Custom Days.

Edit Members =|3][x
Collection Custom Day List
kd Custom Calendar #1

Name * - Name * -
stonebranch-customday-01 4th Quaretr
stonebranch-customday-02 Thanksgiving
stonebranch-customday-03
stonebranch-customday-04
stonebranch-customday-05 |:|

[+]

[»]

[«]

Save Cancel
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Select Thanksgiving and 4th Quarter, and then click the Save button. Those two Custom Days now appear on the Custom Days list for Custom Calendar #1.

Step 6
Calendar Details: Custom Calendar #1 m(=E3
Calendar Local CustomDays | @ CustomDays | © Triggers | @ Versions
2 Calendar Custom Days New Edit el
Custom Day Description Category  Updated By  Updated
[E] hanksgiving Holiday ops.admin 2017-05-25 16:21:29 -0400
El 4th Quaretr Period ops.admin 2017-10-27 15:39:31 -0400

Step 7 In the Calendar Details, click the Update button.

Note
1
You also can assign a Custom Day to a Calendar by clicking the Calendars tab in the Custom Day Details.

Creating a Local Custom Day for a Calendar

In this procedure, we will create a local custom day for an existing Calendar.

Step | Open Custom Calendar #1 that you created in the previous procedure.
1

Calendar Details: Custom Calendar #1 =i=E3

[l Update [] Calendar Preview [y Copy ¢ Delete [ Refresh 3£ Close

Calendar Local Custom Days. Custom Days Triggers Versions
Details
Name : Custom Calendar #1 Version : 1
Description

Member of Business Services
Business Days: [7|Sunday [#]Monday [V]Tuesday [V]Wednesday [¥|Thursday [¥]Friday [7]Saturday

First Day Of Week : |Sunday M

[ Update | [z=| Calendar Preview Ef copy i Delete % Refresh 32 Close

Step | Click the Local Custom Days tab to display an empty Local Custom Days list.

Step Click the New button to display Local Custom Details for a new Local Custom Day, and enter the following values:

® Name = Local Custom Day #1
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Step | Click the Save button.

F
Local Custom Day Details M =S
[E] save R save & New Save &View £ Close

Local Custom Day

Details

Name : Local Custom Day #1

Description
Category: ® Day (O Business Day (O Holiday () Period
Type : Single Date v
Date: 2017 |+ |[oat |+ |[30 [+ |

[E] save Save & New Save & View ¥ Close

Local Custom Days #1 now appears on the Local Custom Days list.

Calendar Details: Custom Calendar #1 -lEl*
Calendar © LocalCustomDays | © CustomDays | © Triggers | © Versions
1 Local Custom Day New =
Name Description Category  Type Updated By Updated
Local Custem Day #1 Day Single Date ops.admin 2017-10-30 11:05:50 -0400

Selecting a Custom Calendar for a Trigger

In this procedure, we will assign the custom calendar to a trigger.
Step 1 From the Automation Center navigation pane, click Triggers > Time Triggers. The Time Triggers list displays.

Step 2 Click the New button to display Time Trigger Details for a new Time Trigger and enter/select the following values:

Name = Custom Trigger

Calendar = Custom Calendar #1

Task(s) = (any task)

Day Style = Complex

Date Noun = Thanksgiving (a Custom Day created for Custom Calendar #1)
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Step 3  Click the Save button.

F
Time Trigger Details —olx
| [E] save [ save&New [ Save &View 3£ Close ‘

Time Trigger

— General

Name : Custom Trigger

Description :

Member of
Business | ‘v |
Services

Calendar:lcustom Calendar #1 ‘v

.“-' Time Zone : System (America/Mew_York) ‘vl

- clonestonebranch-windowstask-01

)

Task(s):

Purge By Retention

Duration :
— Status
Forecast:
Skip Count : 0
Skip Triggerif —
Active ©
Simulate |- System Defaull - [v] =
— Time Details

Time Style : Time

!

Hour Min
Time :

— Day Details
Day Style : |Complex

.

Date Adjective : Every

Date Noun : Thanksgiving ME

fe]

Date Qualifier :

Date Adjustment : |- None — »

— Restrictions

special —
Restriction

=
| |§

| save | [ Save &New ||[Fp Save &View|| §§ Close

il

Step 4 Re-open Custom Trigger and click the List Qualifying Times button to see that the trigger will run the task every year on Thanksgiving.
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Qualifying Times
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Custom Trigger

Listing From: 2017-10-27 13:54:31 -0400

UserTrigger Timezone: America/Mew _York

Thursday, Movember 23, 2017 00:00:00 EST -0500
Thursday, Movember 22, 2018 00:00:00 EST -0500
Thursday, Movember 28, 2019 00:00:00 EST -0500
Thursday, Movember 26, 2020 00:00:00 EST -0500
Thursday, Movember 25, 2021 00:00:00 EST -0500
Thursday, Movember 24, 2022 00:00:00 EST -0500
Thursday, Movember 23, 2023 00:00:00 EST -0500
Thursday, Movember 28, 2024 00:00:00 EST -0500
Thursday, Movember 27, 2025 00:00:00 EST -0500
Thursday, Movember 26, 2026 00:00:00 EST -0500
Thursday, Movember 25, 2027 00:00:00 EST -0500
Thursday, Movember 23, 2028 00:00:00 EST -0500
Thursday, Movember 22, 2029 00:00:00 EST -0500
Thursday, Movember 28, 2030 00:00:00 EST -0500
Thursday, Movember 27, 2031 00:00:00 EST -0500
Thursday, Movember 25, 2032 00:00:00 EST -0500
Thursday, Movember 24, 2033 00:00:00 EST -0500
Thursday, Movember 23, 2034 00:00:00 EST -0500
Thursday, Movember 22, 2035 00:00:00 EST -0500
Thursday, Movember 27, 2036 00:00:00 EST -0500
Thursday, Movember 26, 2037 00:00:00 EST -0500
Thursday, Movember 25, 2038 00:00:00 EST -0500
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I NUrsaay, MOVeMmDer £4, U3y UUUUU ES | -Usuy
Thursday, Movember 22, 2040 00:00:00 EST -0500
Thursday, Movember 28, 2041 00:00:00 EST -0500
Thursday, Movember 27, 2042 00:00:00 EST -0500
Thursday, Movember 26, 2043 00:00:00 EST -0500

Thursday, Movember 24, 2044 00:00:00 EST -0500
Thursday, Movember 23, 2045 00:00:00 EST -0500
Thursday, Movember 22, 2046 00:00:00 EST -0500

Step5  Inthe Custom Trigger Details, change the following values:

® Date Noun = Business Day.
® Date Qualifier = 4th Quarter (a Custom Day period created for Custom Calendar #1)

Step 6 Click the Update button.

Step 7 Re-open Custom Trigger and click the List Qualifying Times button to see that the trigger will run the task every business day during the custom period, October 1 to December 31.
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Qualifying Times

Custom Trigger

Listing From: 2017-10-27 15:57:36 -0400

330 / uc-73x-uext

UserTrigger Timezone: America/Mew _York

Maonday, October 30, 2017 00:00:00 EDT -0400
Tuesday, October 31, 2017 00:00:00 EDT -0400
Wednesday, Movember 01, 2017 00:00:00 EDT -0400
Thursday, Movember 02, 2017 00:00:00 EDT -0400
Friday, Movember 03, 2017 00:00:00 EDT -0400
Maonday, Movember 06, 2017 00:00:00 EST -0500
Tuesday, Movember 07, 2017 00:00:00 EST -0500
Wednesday, Movember 08, 2017 00:00:00 EST -0500
Thursday, Movember 09, 2017 00:00:00 EST -0500
Friday, Movember 10, 2017 00:00:00 EST -0500
Maonday, Movember 13, 2017 00:00:00 EST -0500
Tuesday, November 14, 2017 00:00:00 EST -0500
Wednesday, Movember 15, 2017 00:00:00 EST -0500
Thursday, Movember 16, 2017 00:00:00 EST -0500
Friday, Movember 17, 2017 00:00:00 EST -0500
Maonday, Movember 20, 2017 00:00:00 EST -0500
Tuesday, Movember 21, 2017 00:00:00 EST -0500
Wednesday, Movember 22, 2017 00:00:00 EST -0500
Thursday, Movember 23, 2017 00:00:00 EST -0500
Friday, Movember 24, 2017 00:00:00 EST -0500
Monday, Movember 27, 2017 00:00:00 EST -0500
Tuesday, Movember 28, 2017 00:00:00 EST -0500
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YWEanesaay, NOVEMDEr LY, U717 UUUWUY B35 1 -UsUu
Thursday, Movember 30, 2017 00:00:00 EST -0500
Friday, December 01, 2017 00:00:00 EST -0500
Maonday, December 04, 2017 00:00:00 EST -0500
Tuesday, December 05, 2017 00:00:00 EST -0500

Wednesday, December 06, 2017 00:00:00 EST -0500
Thursday, December 07, 2017 00:00:00 EST -0500
Friday, December 08, 2017 00:00:00 EST -0500

e
For additional information, see:
® Triggers Overview

® Creating Calendars
® Creating Custom Days
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Tutorial - Generating Forecast Data

In this exercise, we will:

® Add a workflow and its tasks to the Forecast calendar.

® Run the workflow and display its forecast information.

® Update a task in the workflow and then re-run the workflow.
® Recalculate the forecast information for the workflow.

Step 1 Create a Time trigger and enter/select the following values:

Name = Simple Workflow Trigger.
Task(s) = Simple Workflow
Forecast = enabled

Business Days = enabled

Time Trigger Details —[@x
[E] save [ Save & Mew Save & View S Close
Time Trigger
— General
Hame : Simple Workflow Trigger
Description
Member of -
Business Senvices
Calendar : | System Default = Time Zone - |System (America/New_York) v
Simple Workflow
Taskis): L%
Purge By Retention
Duration al
— Status
Forecast:
Skip Count 0
Skip Trigger if
Active a
Simulate : |— System Default —
— Time Details
Time Style : | Time .
. Hour Win
Time: g0 [w/foo [w
— Day Details
Day Style : | Simple ~
(O Daily @ Business Days () Specific Day(s)
Restrictions
’VSpecialRestri:tian: (=]
] save Ry Save & New | | [ Save & View
Step 2 Save the trigger and then enable it. A trigger must be enabled in order to generate forecast data for it.
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From the Automation Center navigation pane, select Triggers > Forecast Calendar. The Forecast Calendar identifies Simple Workflow on the days in the forecast period, for the current month, when it will be

Step 3
launched by Simple Workflow Trigger. (By default, tasks within a Workflow are not displayed.)
“ Home [ || Forecast Calendar [ |
4a Apr2015 &
Sun Mon Tue Wed Thu Fri Sat
1 2
3 4 5 6 7 8 9|
12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
10/ " 12, 13 14, 15, 16
12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
17 18 19| 20 21 22 23|
12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflows
24 25| 26 27 28/ 29 30
12:00am Simple Workfiow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
31
12:00am Simple Workflow
Step 4 Click any Simple Workflow link in the Forecast Calendar to display a Forecast Details pop-up. Note that the Launch Time and End Time are identical; since the workflow has never been run, there is no data to support
estimated times.
Forecast Details =||3][%
| # Close |
Forecast H . Child Forecast
Details
Task |S|mp\eWorkﬂow E Trigger ‘S\mpleWorkﬁuangger E
Task Type : [Workllow | Launch Time : | 2014-08-18 00:00:00 -0400 |
Worklow : | =] End Time - |2014-08-18 00:00:00 -0400 |
Member of Run Cr\teria‘Run |
Business Services : 1
Simulation : [[]
| 3 close |
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Step 5 From the Automation Center navigation pane, select Triggers > Forecasts. The Forecasts list identifies Simple Workflow and every task in Simple Workflow, as well as their Launch Times and End Times, for every
day in the forecast period when Simple Workflow will be launched by Simple Workflow Trigger.
Home Forecasts.

~ 31 Forecasts. Custom Filter _ pone — ~ | T Filter &
Trigger Task TaskType  Workfiow Launch Time * End Time Run Criteria Evaluation Simulation Updated By — *

D Simple Workflow Trigger ~ Simple Workflow Workflow 2014-08-04 00:00:00 -0400  2014-08-04 00:00:00 -0400 Run No ops.admin k-

El Simple Workflow Trigger  Timerl Timer Simple Workflow  2014-08-04 00:00:00 -0400  2014-08-04 00:00:10-0400  Run No ops_ admin 5

D Simple Workflow Trigger ~ Timeré Timer Simple Workflow  2014-08-04 00:00:00 -0400  2014-08-04 00:00:00-0400  Run No ops.admin

B Simple Workflow Trigger ~ Timer2 Timer Simple Workflow  2014-08-04 00:00:10 -0400  2014-08-04 00:00:21-0400  Run No ops.admin

D Simple Workflow Trigger ~ Timer3 Timer Simple Workflow ~ 2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin

El Simple Workflow Trigger ~ Timerd Timer Simple Workflow  2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin

D Simple Workflow Trigger ~ TimerS Timer Simple Workflow  2014-08-04 00:00:20 -0400  2014-08-04 00:00:31 -0400  Run No ops.admin

B Simple Workflow Trigger ~ Timerl Timer Simple Workflow  2014-08-05 00:00:00 -0400  2014-08-0500:00:10-0400 Run No ops.admin

B Simple Workflow Trigger ~ Simple Workflow Workflow 2014-08-05 00:00:00 -0400  2014-08-05 00:00:00 -0400 Run No ops.admin

El Simple Workflow Trigger ~ Timeré Timer Simple Workflow ~ 2014-08-05 00:00:00 -0400  2014-08-05 00:00:00 -0400 Run No ops.admin

D Simple Workflow Trigger ~ Timerd. Timer Simple Workflow  2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400  Run No ops.admin

B Simple Workflow Trigger ~ Timer2. Timer Simple Workflow  2014-08-05 00:00:10 -0400  2014-08-05 00:00:21-0400 Run No ops.admin

B Simple Workflow Trigger ~ Timer3 Timer Simple Workflow ~ 2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400 Run No ops.admin

D Simple Workflow Trigger ~ TimerS Timer Simple Workflow ~ 2014-08-05 00:00:20 -0400  2014-08-05 00:00:31 -0400 Run No ops.admin

El Simple Workflow Trigger ~ Timer§ Timer Simple Workflow  2014-08-06 00:00:00 -0400  2014-08-06 00:00:00 -0400  Run No ops_ admin =

v Forecast Details

Step 6 Re-display the Time Triggers list, right-click Simple Workflow Trigger, and then click Trigger Now to launch Simple Workflow.

Step 7 When Simple Workflow has completed, re-display the Time Triggers list, right-click Simple Workflow Trigger, and then click Recalculate Forecast.

Note

1
You'also can recalculate the forecast by right-clicking Simple Workflow on the Workflow Tasks list and then clicking Recalculate Forecast.

Step 8 Re-display the Forecast Calendar and click any Simple Workflow link in the Forecast Calendar to display a Forecast Details pop-up, which now contains estimated Launch Time and End Time information based on
the Workflow run just completed.
Forecast Details =Olx
3 Close
Forecast Child Forecast
Details
Task: Simple Workflow D Trigger - Simple Workflow Trigger D
Task Type | Workflow Launch Time : | 2014-08-11 00:00:00 -0400
‘Workflow D End Time : 2014-08-11 00:02:21 -0400
Member of Run Criteria Run
Business Senices Evaluation :
Simulation : [[]
& Close
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Step 9 Open the Timer Task and change the Timer Duration in Seconds value from 10 to 50, and then click Update.
Timer Task Details: Timer 2 BEIR
[5] Update [5) LaunchTask gy ViewParents [Ty Copy i) Delete & Refresh £ Close
Timer Task Variables Actions Virtual Resources Mutually Exclusive Istances Triggers. Notes Versions
— General
Task Name : | Timer 2 Version 1

Task Description

Member of
Business Services

Resolve Name Time Zone
Immediately : O Preference - System Default — v

Hold on Start: [[]

Virtual Resource 10 - Hold Resources on &
Priority : Failure :

— Timer Details

Timer Type : |Seconds -

Timer Duration In
50
Seconds:

— Time Options
Late Start: []

Late Finish Late Finish __ Day Hour Min Sec
Late Finish Type: Duralon v Duration:[00 |~ |00 |« |[00 [v|[45 |+

Early Finish: [[]

User Estimated __Day Hour Hin Sec
Duration v v » v

Critical Path Options
’7 CP Duration : CP Duration Unit: | Minutes B

— Workflow Execution Options

Execution

Restriction = 218~ ad

[E] Update | [E) LaunchTask [ View Parents Cry copy & Delete % Refresh 3 Close

Step 10 Re-run Simple Workflow.

Step 11 When Simple Workflow has completed, re-calculate its Forecast; since the updated time for the Timerl task affected the Simple Workflow End Time (the time it took to run the Workflow), the Forecast information for
Simple Workflow is now obsolete.

Step 12 Re-open the Forecast Calendar and click any Simple Workflow link to see that 20 seconds has been added to the End Time.

e
For additional information, see:
® Creating and Maintaining Workflows

® Triggers Overview
® Displaying Trigger Forecast Information
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Tutorial - Setting Up a Virtual Resource

In this exercise, we will set up an imaginary resource and three imaginary tasks.

In this scenario, two of our tasks are resource-intensive, and they run on the same machine. Therefore, if one is already running when the other is launched, we want the second task to wait until the first is
finished before running. However, our third task is not so resource-intensive, so we will allow this one to run at the same time as either of the other two.

To simplify the exercise, we will use Timer tasks.

Step 1 From the Automation Center navigation pane, click Other > Virtual Resources. The Virtual Resources list displays.

Step 2 Click the New button to display an empty Virtual Resource Details and enter the following values:

® Resource Name = Resource A
® ResourceLimit=5

Step 3 Click the Save button.

Virtual Resource Details B
[l save [ save & Mew Save & View 3¢ Close

Virtual Resource

Details
Resource Hame : Resource A
Resource Type : |Renewable v Resource Limit: 5

Resource
Description :

Member of
Business Senices

[l save ) save & New Save & View 3 close
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Step 4 Update the Timerl, Timer2, and Timer3 tasks that you created in the Creating a Simple Workflow tutorial.

For Timer1:

1. Change Time in Seconds to 60.

2. Click the Virtual Resources tab to display the Virtual Resources list for Timer1:
a. Click the Edit button, add Resource A to the Virtual Resources list, and click Save.
b. Click the Details icon for Resource A to display its Task Virtual Resource Details.

Task Virtual Resource Details =163
[F] Update (ff| Delete | s Refresh 3£ Close

Task Virtual Resource
Task: |Timer1

Virtual Resource : |Resource A

I | T

Amount 1

[FZ] Update 5 Delete % Refresh 3 Close

c. Change the Amount (number of resource units required from the virtual resource) from 1 to 4 and click the Update button.

For Timer2:

1. Change Time in Seconds to 30.
2. Add Resource A and change the Amount to 4.

For Timer3:

1. Change Time in Seconds to 20.
2. Add Resource A and keep the Amount at 1.

Step 5 Open Resource A and click the Tasks tab to see that Timerl, Timer2, and Timer3 are listed.

Virtual Resource Details: Resource A

) |[=] 1B,
Virtual Resource @ Tasks Currently In Use By Outstanding Requests Versions.
3 Task Virtual Resources Edit &
Task Amount | Updated By | Updated
[E] Timert 4 ops.admin
= Timera 1 ops admin
E Time2

4 ops.admin

Step 6 Create a Time Trigger called Trigger A, and select Task1, Task2, and Task 3 in the Task(s) field, and enter a Time three minutes from the current time

Step 7 Click the Save button, right-click Trigger A on the Triggers list, and click Enable.
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When the trigger is satisfied, only Timerl or Timer 2 will run, along with Timer3. When Timer1 or Timer 2 finishes, the other will run run. Display the Activity Monitor and note that Timerl or Timer 2 is waiting in Resourc

Step 8 !
e Wait status.
Home [ | actvity [
|-7|Last48 hours « @ No quickfilter « | Custom Filter — None — v @ Filter..
Instance Name Type Status Invoked By Start Time: End Time Updat ™
E Timer3 Timer Success Trigger: Trigger A 2014-08-12 10:58:00 -0400 2014-08-12 10:56:10 -0400  2014-08-
[E Timert Timer source Wai Trigger: Trigger & 2014-08-
E Timer2 Timer Running Trigger: Trigger A 2014-08-12 10:56.00 -0400 2014-08-
Step 9 In the Virtual Resource Details, click the Currently In Use By tab and observe which tasks are running on this virtual resource. Note that this display does not automatically refresh.

For additional information, see:

Virtual Resources
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Tutorial - Creating a Widget

There are three types of Widgets, all of which can be placed on one or more Dashboard Details:
® System
® Activity
® Report

In this exercise, we will create an Activity Widget that identifies any failed task instances in the past week.

(You cannot create, modify, or delete a System Widget; they are provided by the Controller.)

Step 1 From the Reporting navigation pane, select Widgets. The Widgets list displays.
Step 2 Click the New button and then click Activity Widget. An Activity Widget Details pop-up displays.

Step 3 Enter / select the following values:

Name = Failed

Refresh Rate (Seconds) = 900 | 15 minutes
Status(es) = Failed

Time Constraint = Last week

Composite Color = Red

Activity Widget Details —lEx
[ save [ Save & New Save & View 3£ Close
Activity Widget

— General

Name : Failed
Description

Refresh Rate (Seconds): |900 | 15 minutes v

— Details
Status(es): Failed Time Contraint: |Last week .

Composite Color: #FFO000

|

No items to show.

Composite Status(es)

OBE®

[E] save IE) Save & New | | [ Save & View 3 Close

Step 4 Click the Save button. This Widget can now be added to any Dashboard and can be selected for any Composite Widget.

S
For additional information, see:

® \Widgets
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Tutorial - Creating a Dashboard and Adding Widgets
Creating a Dashboard and Adding Widgets

Universal Controller provides a default Dashboard containing multiple Widgets that displays as the Home Dashboard when you log in to Universal Controller.
You can create your own Dashboards containing any available Widgets.

In this exercise, we are going to create a Dashboard and select Widgets for the Dashboard.

Step 1 Click the Home icon in the top right corner of any page to display the Home dashboard.

| Dashocarss [ |
Active Task Instances By Status 2 System Details 2
R [Agents: 84/5000] [Triggers: Unlimited] [Tasks: Unlimited] [Days:
License:
13/365]
Waiting 13 Node Id: opswise8:8080-0pswise620b54
MNode Mode: Active
e
Held 7 Node Uptime: 11 Days 21 Hours 0 Minute 21 Seconds
I ) )
. — Mode Time: 2015-07-14 11:05:27 -0400
Resource Wait _4 Release: 6.2.0.0
N N Build: build.54
Action Required 1
I Build Date: 06-30-2015_1252
Started It Database Type: MYSQL
Database MName: opswise620
Running _ 13 Database URL: jdbe:mysql://ga-stone branch/
. Database Connections:  In Use: 0, Total: 3
Failed -3 Memary Maximum: 989.88 MB
Memory Used: 103.49 MB (10.45%)
Memory Free: £86.38 MB (89.55%)

Agent Status

w

Cluster Node Status 2 OMS Server Status

Y

W Offline (1) I Active (2) I Active (1) Passive/Unavailable (1) I Connected (1)

| administrators Home | Dashboard#1 | | & Refresh |

Step2  Onthe Customize drop-down list at the bottom of the Home Page, click New.

Step 3  Selectaname for the new Dashboard on the New Dashboard pop-up and click OK. A new, empty Dashboard displays.
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Step 4 From the list of Widgets to the left of the Dashboard, drag and drop any of the Widgets into either column. (If you want to add more columns, click either Column Properties drop-down list and then click Add Column.)

@) Select 2 Widget Column Properties - Column Properties. -
9 Spacer Active Task Instances By Status Active Task Instances By Type
@) Active nstances

Defined
@) active Task Instances By Status Waiting
@) Active Task instances By Type Held
@ Agent Status Undeliverable
@) Cluster Node Status Running
@) Heldraction Reguired % Start Failure
@) OMS Server Status Cancelled

Failed
@) pending
@ Probiem
: z:m: Agent Status

]
@) success/Finished
@) system Detais
@9 Task Activity Status
1 Workdlow (8) [ Timer (25) I 2/0S (6)
M offine (5) I Active (3) M File Transfer (1)
l J{ J{ New J ] save m Cancel H @) Hide Widget Picker H Customize ;l
|
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Step 5 After you have added Widgets to your new Dashboard, you can click the x icon in the top right corner of any Widget to remove it from the Dashboard, or drag and drop any Widget to a new location in the Dashboard.

om0 oo 3|

@) select a Widget Column Properties - Column Properties -
@ spacer [ Active Task Instances By Type <) Cluster Hode Status <1|

@) Active nstances

@) Active Task Instances By Status
@) Active Task Instances By Type
— |
@) Agent Status
@ Cluster Node Status

@) HeldiAction Required

@) OMS Server Status
@) Pending [ Workflow (8) [/ Timer (25) Il 2/0S ()
@ Probiem M File Transfer (1)
@ Running Active Task Instances By Status ||
@ skipped
@) successiFinished Defined
@) system Detais Waiting
. Held
@ Task Activity Status Undeliverable
Runnin
Running/Problems
Start Failure
Cancelied
Failed
Agent Status x|
W offine (8) B Active (9) W Active (1)
{ ﬂ" H New J [ save I[ € cancel H @Y Hide Widget Picker H Customize ~

Step 6  Click the Save button to add the Dashboard.

For additional information, see:
® Home Dashboard

® Dashboard Details
® Widgets
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Tutorial - Creating Business Services

Business Services are used to group records into business functions.

In this exercise, we will create two hypothetical Business Services: Tech Support and Operations.
Step 1 From the Administration navigation pane, select Security > Business Services. The Business Services list displays.
Step 2  Click the New button to display an empty Business Service Details.

Step 3 Enter the following values:

®* Name = Tech Support
® Description = This is the Tech Support business service.

Step 4  Click the Save button.

Business Service Details i(=1{E3
[F] Save [ Save &New [[ Save & View 3 Close

Business Service

Details

Hame : Tech Support

Description: This is the Tech Support business semice.

[ save ) Save & New | | [ Save & View 3 Close

Step 5 Repeat steps 2 to 4 for a Business Service called Operations.

e
For additional information, see:

® Business Services
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Tutorial - Assigning Records to Business Services

In this exercise, we will assign the Timer and Simple Workflow tasks created in the Creating a Simple Workflow tutorial to the Operations Business Service, and the SQL task and Bigger Workflow tasks created
in the Running a Workflow with a Conditional Path tutorial) to the Tech Support Business Service.

See the Creating Business Services tutorial to see how these Business Services were created.

Step 1 Open the Timer task called Timer1, which you created in the Creating a Simple Workflow tutorial.

Step 2  Fromthe Member of Business Services drop-down list, select Tech Support and Operations.

Timer Task Details: Timer 1 = (=1{F=3

[] update [Z) Launch Task View Parents Iy Copy i) Delete |5 Refresh 32 Close

Timer Task Variables @ Actions @ Virtual Resources Mutually Exclusive Instances Triggers Notes @ Versions
— General
Task Name : Timer 1 Version 4

Task Description :

Member of

Business Senvices Operations, Tech Support v

Resolve Name =

Immediately

a
Accountin
Hold on Start E b o

Virtual Resource | [] ¢
Priority: | [C] IT
L[] MikeD_BusSenices L
— Timer Details Operations —
[C] QADepartment

TimerType | [7] stonebranchbusinessservice 01
Timer Duration In| || stonebranchbusinessserice 02
Seconds: || stonebranchbusinessservice 03
stonebranchbusinessservice 04
N 7] stonebranchbusinessservice 05

— Time Options ——— Tech Support

Late Start: [

Late Finish @[]
Early Finish: []

UserEstimated  Day Hour Win Sec
Duration v ~ ~ v

Critical Path Options
’V CP Duration : CP Duration Unit: |Minutes v

— Workflow Execution Options

Execution
Restriction ||~ "oN2— A
] Update | |[E! Launch Task View Parents Cry Copy & Delete 4| Refresh 3 Close

Step3  Click the Update button.

Step 4 Repeat steps 1 to 3 for the Timer2 and Timer3 tasks and the Simple Workflow Workflow, all of which you also created in the Creating a Simple Workflow
tutorial.

e
For additional information, see:

® Business Services
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Tutorial - Viewing Activity by Business Service

® [ntroduction

Introduction

In this exercise, we will launch the Simple Workflow Workflow (created in the Creating a Simple Workflow tutorial and, on the Activity Monitor, display only tasks assigned to the
Operations Business Service (see Assigning Records to Business Services|Tutorial - Assigning Records to Business Services] tutorial.

Step1  Runthe Simple Workflow Workflow.

Step 2 Display the Activity Monitor, which will list the Simple Workflow and all of its tasks.

Home Reports. Business Sarvices Activity
858 Task Instances \-|Last48 hours ~ [ Mo quickfilter ~ | Custom Filter — None — ~ | S Filter..
instance Name ™ Type Status invoked By Start Time End Time Updated "
F Timers Timer Success Workflow: Simple Workflow 2014-08-11 14:53:25 0400 2014-08-11 14:55:25-0400  2014-08-11 14:55:25 -0400
E Timers Timer Success Workflow: Simple Workflow 2014-08-11 14:53:25 0400 2014-08-11 14:53:35-0400  2014-08-11 14:53:35 -0400
F Timerd Timer Success Workflow: Simple Workflow 2014-08-11 14:53:114 0400 2014-08-11 14:53:24 -0400  2014-08-11 14:53:25 -0400
F Ttmer3 Timer Success Workflow: Simple Workflow 2014-08-11 1455314 -0400  2014-08-11 14:53:25-0400  2014-08-11 14:53:25 -0400
F Ttmerz Timer Success Workflow: Simple Workflow 2014-08-11 1453114 -0400  2014-08-11 14:54:04 -0400  2014-08-11 14:54:05 -0400
E Tmert Timer Success Workflow: Simple Workflow 2014-08-11 14:53:04 -0400  2014-08-11 14:53:14 -0400  2014-08-11 14:53:14 -0400
[E simple Workflow Workfiow Success Wanually Launched 2014-08-11 14:53:04 -0400  2014-08-11 14:55:25-0400  2014-08-11 14:55:25 -0400

Step 3 Apply the following Filter to the list of tasks:
® Member of Business Services
® contains
® Operations

The Activity Monitor now displays only tasks assigned to Operations Business Service.

Home Reports. Business Services Activity
688 Task Instances |-|Last 48 hours = Eﬁ Mo quickfilter « | Custom Filter — Unsaved 2 — v
Instance Name ~ Type Status. Invoked By Start Time End Time Updated -.d
E Timers Timer Success Workflow: Simple Workflow 2014-08-11 14:53:14-0400  2014-08-11 14:53:25 0400 2014-08-11 14:53:25 -0400
E Timerz Timer Success Workflow: Simple Workflow 2014-08-11 14:53:14-0400  2014-08-11 14:54:04 0400 2014-08-11 14:54:05 -0400
= Timert Timer Success Workflow: Simple Workflow 2014-08-11 14:53:04 0400  2014-08-11 14:53:14 0400 2014-08-11 14:53:14 -0400
[E simple Workflow Workflow Success Wanually Launched 2014-08-11 14:53:04-0400  2014-08-11 14:55:25 0400 2014-08-11 14:55:25 -0400
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Tutorial - Creating a Report

In this exercise, we will create a report for Widgets.

Step 1 From the Reporting navigation pane, select Reports. The Reports list displays.

Step 2 In the empty Report Details below the list, enter / select the following values:

® Title = All Widgets
® Table = Widgets (ops_widget)

® Field(s) = (pre-selected fields display when you click Edit Fields)

Step 3  Click the Save button.

Report Details

Report

=/[O]X

[E] save [F save & Mew Save &View 3¢ Close

— General
Title : All Widgets

Description :
Type : |List
Table : | Widgets (ops_widget)

Visible To : |Me ¥

— List Fields and Ordering

Field Title
Name
Widget Type
Description
Field(s) : \Updated By
Updated

Edit Fields..

Field Title

Sort By :

Order

Mo order

Edit Sort...

— Scheduled Options

PDF
Orientation - |~ SYStEm Default— v

FPDF 3ize . — System Default— ~

— Filter
(@ Match Al () Match Any

4]

Advanced..
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Step 4  Click the Run button to run the report, which displays under a new tab.

Dashboards [ | Reports

14 Widgets
Name

Skipped

Problem
Success/Finished
Task Activity Status
Failed

Agent Status
Held/Action Required
Cluster Node Status
OMS Server Status.
System Details
Pending

Running

Active Task Instances By Status

6 i A M e W s

Active Task nstances By Type

Al Widgets report [

Widget Type:
Activity
Activity
Activity
Activity
Activity
System
Activity
System
System
Systsm
Activity
Activity
System
Systsm

Description
Activity - Skipped

Activity - Problem
Activity - Success/Finished
Task Activity by status

Pie chart for agent statuses.
Activity - Held/Action Required

Pig chart for cluster node statuses.

Pie chart for OMS server statuses.

Displays a number of system details including version, database, and memory information
Activity - Pending

Activity - Running

Bar chart for active task instances grouped by task instance status.

Bar chart for active task instances grouped by task instance type.

Updated By
ops.admin
ops.admin
ops.admin
ops.admin
ops.admin
ops.system
ops.admin
ops.system
ops.system
ops.system
ops.admin
ops.admin
ops.system

ops.system

Updated

2014-07-17 11:57:26 -0400
2014-08-12 15:54:55 -0400
2014-08-07 17:13:39 -0400
2014-08-18 23:28:05 -0400
2014-08-11 13.43:50 -0400
2014-06-24 20:00:00 -0400
2014-07-17 11:41:46 -0400
2014-06-24 20.00.00 -0400
2014-06-24 20:00:00 -0400
2014-06-24 20:00:00 -0400
2014-07-17 11:56:46 -0400
2014-07-17 11:38:20 -0400
2014-06-24 20:00:00 -0400
2014-06-24 20:00:00 -0400
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Step 5

* Widget Type
® equals
® Activity

Return to the Report Details and select the following Filter for the report:

Report Details: All Widgets

= O]|X

[E]l Update Save As.. ol Run ¢ Delete ||| Refresh 3£ C\ose‘

Report

— General

Title : All Widgets

|V|

Visiole To: |Me

Description :

|V|

Type : |List

Table :| Widgets (ops_widget)

— List Fields and Ordering

Field Title
Name
Widget Type
Description
Updated By
Updated

Field{s) :

|EditFields...|

Field Title Order

Mo order

Sort By

Edit Sort...

— Scheduled Options

PDF — System Default— n

Crientation

POF Size : |- System Default— |+ |

— Filter

® Match Al O Match Any

Advanced..

@ |Widget Type

|v||aquals |v|ActN'rty

©

| [ upoate || [ savehs. || i Run

|| [5/ Refresh H ¥ Close |

|| ¢ Delete
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Step 6  Click the Update button, and then click the Run button to display the report under a new tab.

Dashboards [1] | Reports [] | Allwidgets report [
8 Widgets =)
Name widget Type Description Updated By Updated

Skipped Activity Activity - Skipped elenulich  2014-07-17 11:57:26 -0400
Froblem Activity Activity - Problem ops.admin 2014-08-12 15:54:55 -0400
Success/Finished Activity Activity - Success/Finished  ops.admin 2014-08-07 17:13:32 -0400
Task Activity Status Activity Task Activity by status elen.ulich  2014-08-18 23:28:05 0400
Failzd Activity ops.admin 2014-08-11 13:43:50 -0400
HeldiAction Required Activity Activity - Held/Action Required ellen.ulich  2014-07-17 11:41:46 -0400
Pending Activity Activity - Pending elenulich  2014-07-17 11:56:46 -0400
Running Activity Activity - Running elen.uiich  2014-07-17 11:38:20 -0400

e
For additional information, see:

® Report Details
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Tutorial - Creating a Report Based on Business Services

In this exercise, we will create two Activity reports so that users from our hypothetical Operations and Tech Support departments (see the Creating Business Services tutorials) can view activity related to their
organizations.

Step 1 From the Reporting navigation pane, select Reports. The Reports list displays.
Step 2 Click the New button to display empty Report Details.

Step 3 Enter / select the following values:
® Title - Business Services

® Table = Business Services (ops_generic_group)
® Field(s) = (pre-selected fields that display when you click the Edit Fields button)

Step 4  Click the Save button.

Report Details ] | =] |4
] save [ Save & Mew Save &View 3£ Close

Report
— General El
Title : Business Senices Visible To : |Me v
Description :
Type : |List 3
Table : | Business Services (ops_generic_group) -

— List Fields and Ordering

Field Title Field Title Order
Name
No order
Description
Updated By
Field(s) : | Updated Sort By :
Edit Fields... Edit Sort.

— Scheduled Options

PDF_ — System Default - v PDF Size - — System Default — v
Orientation :
— Filter
(® Match Al (O Match Any Advanced
o

3 close

[ save Save & Mew Save & View
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Step 5  Click the Run button. A Business Services report displays under a new tab.

Dashboards [] | Reports [ | Business Services report [

5 Business Services &
Name Description Updated By  Updated -
stonebranchbusinessservics 02 ops.admin 2014-06-13 15:19:47 0400
stonebranchbusinessservice 03 ops.admin 2014-06-13 15:19:51 -0400
'stonebranchbusinessservice 05 ops.admin 2014-06-13 15:20:00 -0400
’stonebranchbusinessservice 01 ops.admin 2014-06-13 15:19:37 -0400
stonebranchbusinessservice 04 ops.admin 2014-06-13 15:19:56 -0400

e
For additional information, see:

® Report Details
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Tutorial - Scheduling a Report

In this exercise, we will schedule a report by triggering an Email Task that specifies the report.

To simplify this exercise, we will manually trigger the Email task. However, you can schedule a report using several methods.

Step 1 Create a Report with the following values:

Title = Scheduled Activity Report

Visible to = Me

Type = List

Table = All Task Instances (ops_exec)

Field(s) = Instance Name, Type, Status

In Scheduling Options, select any PDF Orientation and PDF Size.

Step 2 From the Automation Center navigation pane, select Email Tasks. The Email Tasks list displays.

Step 3 Click the New button and enter / select the following values in the empty Email Tasks Details:
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7
Email Task Details

=|[=]fx

Email Task

‘ Save 3y Save & Mew Save &View $E Close ‘

— General

Task Name : Schedule a Report

Task Description
Member of

Busmess‘

Senices

Resolve Name
Immediately

Hold on Start

Time Zone
Preference

Virtual Resource

Hold Resources on

— System Default —

Priority ‘1[] |v| Failure
— Email Details
Email Template - [+|[ Emailc ;| QA-OPSWISE-MAILER
Email Template
Variable
Reply-To
suppori@stonebranch.com
Cc
Beo
Subject . Activity Report
Body
Report \s:nedu\edmivity Report |v|@ Report Variable
— Wait'Delay Options
WaltTo Start: ~ None — [+
Delay On Start ‘— None — |v|
Workflow Only \7 System Default — |-.|
— Time Options
Late Start
Late Finish
Early Finish
User Estimated
Duration
Critical Path Options
’7 CP Duration CP Duration Unit: |Minutes
‘Workflow E: tion Options
Execution
Restriction ‘7 Nene = ‘vl
| [Flsae | [ SavesaNew||[F]Save&View | 3§ Close |

Step 4 Click the Save button.
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Step 5 From the Automation Center navigation pane, select Manual Triggers. The Manual Triggers list displays.
Step 6 Click the New button and enter / select the following values in the empty Manual Trigger Details:
® Name = Scheduled Report Trigger
® Tasks(s) = Schedule a Report
Manual Trigger Details —[Ex
[l save [ Save &New [[f] Save &View 3£ Close
Manual Trigger
— General
Name : Scheduled Report Trigger
Description
Member of
Business Senices s
Calendar : System Default w :
Schedule a Report
Task(s): G
Purge By Retention
Duration al
[E] save [ save & New | | [y Save & View 3 Cclose
Step 7 Click the Save button.
Step 8 In the Time Triggers list, right-click the Schedule Report Trigger to display an Action menu.
Step 9 Click Trigger Now... and then, on the Trigger Now... pop-up dialog, click Submit.
Step 10 Open the email sent to the recipient selected in Step 3 and double-click the attached Scheduled Activity Report.pdf to see the report.
Scheduled Act Report (17 Task Instances)
Instance Name Type Status
waorkflow-regression-one-of-each-tasks Workflow Success
sap-task-simple-variable SAP Success
Taskmon-workflow-simple Task Monitor Success
sql-task-mysql-sproc Stored Procedure Success
email-task-builtin-variables Email Success
udm-task-simple-variable File Transfer Success
Pause for Manual Manual Success
ftp-filemon-simple-variable FTP File Monitor Success
nix-filemon-simple-variable File Monitor Success
Linux check for vsFTP #QUERY# Application Control Finished
win-task-launch-simple-variables Windows Success
nix-task-launch-simple-vanables Linux/Unix Success
sysmon-diskspace-simple-variable System Monitor Success
Sleep Variable Timer Success
sql-task-mysqgl-select-all saL Success
Indesa-task-simple-variables Universal Command Success
Scheduled Activity Report Email Running
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S
For additional information, see:

® Report Details
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Tutorial - Creating Users and Assigning Roles and Permissions

® Introduction
® Create New Users
® Assign Permissions to Groups of Users

Introduction

In this exercise, we will create some users related to the Operations and Tech Support departments created in the Creating Business Services tutorial.
We also will assign access and management rights via user roles and Universal Controller permissions:

® Roles are pre-defined groups of permissions that control access to users, reports (filters), gauges, bundles, and promotions.
® Permissions control who can add, change, delete and control Controller tasks, task instances, triggers, Agents, calendars, and credentials.

Create New Users

In this exercise, we will create a new user and assign different permissions to it.

Step 1 From the Administration navigation pane, click Security > Users. The User list displays.

Step 2 Click the New button to display empty User Details for a new user and enter / select the following values:

® User Id = userl

® First Name = User
® Last Name = One
® Password =123

User betails BEE
[ save (@ Save & New Save & View 3¢ Close
User
 Details
Userld: Usert Time Zone : |Server (America/New_York) v
Password: wes Tite B
First Name : User Department
Middle Name Manager v :
LastName: One Business Phone
Email Mobile Phone
Password Re&l:\sr:‘s B Web Browser Access : |- System Default — %
Locked Out: [7] Command Line Access : |- System Default — v
. Web Service Access |~ System Default — v
Login Method Single Sign-on petve
B save () Save & New Save & View # close
Step 3 Click the Save button, log out of the Controller and then log in as user1.
Step 4 Click on several areas of the user interface. Since userl has not been assigned any permissions, userl can view only a limited number of lists and records, and cannot create, modify, or delete any records.

Step 5 Log out of the Controller and log in as ops.admin.
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Step 6 Open the userl record and click the User Roles tab.

Step 7 Click Edit.

Step 8 Move the ops_admin role to the Roles List and click Save to provide userl with full administrative permissions.

Edit Members

Name =

ops_agent_cluster_admin
ops_bundle_admin
ops_dba
ops_email_admin
ops_fiter_global
ops_fiter_group
ops_imex
ops_multi_update
ops_premotion_admin
ops_report_admin
ops_report_global
ops_report_group
ops_report_publish
ops_report_schedule

ops_report_widget_create

Collection

]

Save

B
[«
»]
[«

Cancel

groupa

=

Roles List

X

Step 9 Click the User tab and then click the Update button.

Step 10 Log out and log back in as userl to verify that userl has the same permissions as ops.admin.

Step 11 Log out and log back in as ops.admin, open the userl record, and remove the ops.admin role.
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Step 12 Click the Permissions tab, click the New button, and in the Permissions Details select the following values:

Type = Task

Create = enabled

Read = enabled

Update = enabled

Commands = Launch

Unassigned to Business Service = disabled
Member of Business Services = Tech Support

Permission Details =/alx

[7] save [y Save & New [fj Save & View 3£ Close

Permission

— Details

Type : Task .
Create
Read
Update
Delete: [7]

Commands : |Launch »
Name: *

Member of Any Business

Senvice or Unassigned :

Member of Business Tech Support -
Sernvices

Unassignedto Business
a8 Senvice : a8

H Save ’-E-_] Save & New Ej Save & View ¥ Close

Step 13 Click Save, log out of the Controller, and log in as userl.

Step 14 userl now will be able to see the tasks assigned to the Tech Support group, and launch those tasks. However, userl cannot see them on the Activity Monitor because userl was not given permissions on Task
Instances.

Assign Permissions to Groups of Users

In this exercise we will assign our last user to a group, then assign permissions to the group instead of to the user.

Step1  Open the userl record .

Step 2 Click the Member of Groups tab to display a list of groups that userl belongs to.

Step 3 Click the New button to display Group Details for a new group.

Step 4  Inthe Name field, enter Group1, and then click the Save button. The Member of Groups list now shoes Group1.

Step 5 Open Groupl and click the Permissions tab to display the list (currently empty) of permissions for Group1l.
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Step 6  Click the New button and on the Permissions Details, enter / select the following values:

Type = Task Instance

Read, Update, Delete = enabled
Commands = All

Business Services = Operations
Unassigned to Business Service = disabled

These permissions provides all users in the Group1 full permissions on all activity (task instances) related to the Operations Business Service. Any users you assign to Groupl will inherit these permissions.

Permission Details [|(=]]B33

[7] save [ Save & New Save & View 3£ Close

Permission

r— Details

Type : TaskInstance -
Read:
Update
Delete :

Commands : |ALL v

Name: *

Member of Any Business B Unassigned to Business B
Senvice or Unassigned : Service :
Member of Business

Operations v
Senvices | "

H Save ’-l__m Save & New Save & View x Close

Step 7  Click Save, log out, and then log in as userl to check the permissions.

e
For additional information, see:

® Users and Groups
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Tutorial - Creating User Groups and Assigning Permissions

In this exercise, we will create users and user groups, then assign permissions to the groups instead of directly to the users.

Step 1 Create the following three users:

® stonebranch-user-01
® stonebranch-user-02
® stonebranch-user-03

Step 2 Select Users > Groups and create a group called stonebranch-group-01.

1. Click the Permissions tab
2. Click the New button and add the following permission:
® Type = Task Instance
® Read = enabled
* Member of Any Business Service or Unassigned = enabled
3. Click the Group Members tab and click Edit.
4. Add stonebranch-user-01 to the group.

Step 3 Create a group called stonebranch-group-02.

1. Add the following two permissions:
® Type = Task Instance
Read = enabled
Update = enabled
Commands = None
Business Services = stonebranchbusinessservice 01
Unassigned to Business Service = disabled

and

Type = Task Instance

Read = enabled

Update = enabled

Commands = All

Business Services = stonebranchbusinessservice 02
Unassigned to Business Service = disabled

Group Details: stonebranch-group-02 —|Ex
Group Group Roles Group Members Child Groups Permissions
2 Permissions New =
Type Operaions ~ Commands  Name  Unassigned to Business Service Business Services Updated By  Updated
[5] Taskinstance Read, Update ALL * No stonebranchbusinessservice 02 ops.admin 2014-08-07 16:12:04 -0400
[E] Task Instance Read, Update 5 Ho stonebranchbusinessservice 01 ops.admin 2014-08-07 16:08:14 0400

2. Click the Group Members tab and Edit button to add stonebranch-user-02 to the group.
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Step 4  Create a group called stonebranch-group-03.

1. Add the following two permissions:
® Type = Trigger
Create = enabled
Read = enabled
Update = enabled
Delete = enabled
Commands = None
Member of Any Business Service or Unassigned = enabled

and

Type = Task

Create = enabled

Read = enabled

Update = enabled

Delete = enabled

Commands = None

Member of Any Business Service or Unassigned = enabled

Group Details: stonebranch-group-03 =63

Group Group Roles Group Members Child Groups Permissions

2 Opswise Permissions New =)

Type | Operations Commands  Name  Unassigned to Business Service Business Services Updated By  Updated
[E] Task  Creste, Read, Update, Delete o Yes o ops.admin 2014-08-07 16:18:42 0400
[=] Trigger Creste, Read, Update, Delste & “Yes & ops.admin 2014-08-07 16:18:32 0400

2. Add stonebranch-user-03 to the group.

Step 5 Log in as each user and note that each is limited to those functions assigned to the user's group.

S
For additional information, see:

® Users and Groups
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Tutorial - Creating and Promoting a Bundle

In this exercise, we will create a bundle (group) of Controller records and promote (copy) them from a source machine (a Controller cluster node) to a target machine.

Specifically, we will:

Create a Bundle.
Add records to a Bundle.
Create a promotion target record for the bundle promotion.

Map Agents on the source machine to Agents on the target machine.
Promote the bundle to the target.

Create a Bundle

In this procedure, we will create a Bundle record to which other records can be added.
Step 1 From the Bundles & Promotion navigation pane, select Bundles. The Bundles list displays.

Step 2  Click the New button to display Bundle Details for a new Bundle.

Enter a Bundle Name.

Bundle Details BEIES
[ save [ save & New Save &View 3¢ Close
Bundle e

r— Details

Bundle Name

Description
Member of Business
Senices
Default Pramotion =
Target =
Exclude on .
Existence . EMail Templates
Fallow References = [

Promote Bundle
Definition a

— Promote By Business Service
Promote Members of
Business Senvices

Visible To

7] Save I3 Save & New Save & View & Close

step 3  Click the Save button to create (and close) the Bundle record, which now appears on the Bundle list. You now can add records to the
Bundle.

Add Records to the Bundle

In this procedure, we will add records to the Bundle record that you just created.

Step 1 Open the Bundle record you just created.
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Step 2 Click the Triggers tab to display an empty Triggers list.

Bundle Details: Demo Bundle #1 =163
Bundle Triggers Tasks Calendars Custom Days Variables Business Services Credentials Agent Clusters VirtualR| 4 | » | =
0 Triggers Edit &
Name Type Descripon | Added By  Updated

No items to show.

Step 3  Click the Edit button to display a list of all Trigger records.

Edit Members =/ |=][%:

Collection Trigger List

Demo Bundle #1

4‘

»

Name * Name * -

™

'stonebranch-applicationmonitortrigger-01
— None —

stonebranch-applicationmonitertrigger-02

'stonebranch-applicationmonitertrigger-03

stonebranch-applicationmonitortrigger-04

stonebranch-applicationmonitortrigger-05 ‘T‘
B
| [
[]

stonebranch-compositetrigger-01
stonebranch-compositetrigger-02
stonebranch-compositetrigger-03
stonebranch-compositetrigger-04
stonebranch-compositetrigger-05
stonebranch-crentrigger-01
stonebranch-crontrigger-02
stonebranch-crontrigger-03
'stonebranch-crentrigger-04
stonebranch-crentrigger-05

stonebranch-filemenitortrigger-01

[En|

Save Cancel
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Step 4 Select the Trigger records that you want to add to the Bundle and click the Save button. Those records then display in the Triggers list under the Triggers tab.

Bundle Details: Demo Bundle #1

7| [=] 1B,
Bundle @ Triggers Tasks Calendars Custom Days Variables Business Services Credentials Agent Clusters VitualR «  » | ¥
5 Triggers. Edit @
Name Type Description  Added By  Updated
D stonebranch-taskmonitortrigger-01 Task Monitor ops.admin 2015-08-29 18:50:51 -0400
D stonebranch-taskmenitortrigger-03 Task Monitor ops.admin 2015-08-29 18:50:51 -0400
D stonebranch-taskmonitortrigger-05 Task Monitor ops. admin 2015-08-23 16:50:51 -0400
D stonebranch-taskmenitortrigger-04 Task Monitor ops.admin 2015-08-29 18:50:51 -0400
D stonebranch-taskmenitortrigger-02 Task Monitor ops.admin 2015-08-29 18:50:51 -0400

Step 5 Repeat Steps 2-4 for any other record types you want to add to the Bundle.

Step 6 Click the Bundle tab, the Update button, and the Close button. You now must create a record identifying the target (Controller cluster node) to which the Bundle will be
promoted.

Create a Promotion Target Record for the Bundle

In this procedure, we will create a record identifying the target machine (a Controller cluster node) to which you will promote the Bundle.
Step 1 From the Bundles & Promotion navigation pane, select Promotion Targets. The Promotion Targets list displays.

Step 2 Click the New button to display Promotion Target Details for a new promotion target.
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Step 3 Enter a name and the URI for the promotion target.

Note
1
By default, the URI of the cluster node that you are logged into displays. You must change this to the URI of a target cluster node, using the default URI
format.
Promotion Target Details =|[3][%

[] save [ Save & New [[j] Save &View 3£ Close
Promotion Target

Details

Hame : stonebranch-promotiontarget-01

Description

Member of
Business Services

URI:

QA Department n

hitpi/stonebranch 123Universal

User: ops.admin

Password . sssssssss

[l save I3 Save & New Save & View # Close

Step 4 Click the Save button. You now must map Agents on your source machine to Agents on the target machine.

Map Source Machine Agents to Target Machine Agents

In this procedure, we will map Agents on your source machine to Agents on the selected target machine.
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Step 1 From the Bundles & Promotion navigation pane, select Promotion Targets. The Promotion Targets list displays.
Dashboards [1] | Promotion Targets [
' & Prometion Targets Custom Filter ~| 5% Fiter.. [E GoTo.. | [ MNew | &
Name User URl Description Updated By Updated -
E' stonebranch-promotiontarget-01 http:/Mocalhest:8080/opswise: ops.admin 2014-08-13 15:37:58 -0400
El stonebranch-promotiontarget-02 http:/Mlocalhost:3080/ops wise ops.admin 2014-06-13 15:38:04 -0400
E stonebranch-promotiontarget-03 http:/focalhost:8080/opswise ops.admin 2014-06-13 15:38:07 -0400
El stonebranch-promotiontarget-04 http:/Mocalhest:8080/opswise ops.admin 2014-08-13 15:38:12 -0400
El stonebranch-prometiontarget-05 http:/Mlecalhost. 3080/ops wise ops.admin 2014-08-13 15:38:17 -0400
V' Promotion Target Details [] save ) Save & New [T] New
Promotion Target
Details
Name :
Description ©
Member of
Business Senices : (94 Department e
URI:
User:
Password . » s
] save [ Save & New [ New
Step 2 Right-click the Promotion Target record that you just created to display an Action menu.
Step 3 Click Refresh Target Agents to display a Refresh Target Agents pop-up dialog.
Refresh Target Agents - %
Promotion Target : | stonebranch-promotiontarget-01
Override User/Password :
User:
Password
Step 4 Enter the User and Password credentials for the target machine (if they are not provided) and click Submit.
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Step 5 Open the Promotion Target record and click an Agent Mappings tab for which there are Agents listed.

Promotion Target Details: stonebranch-promotiontarget-01 =[E[x
v
Promotion Target | ® Linwe/Unix Agent Mappings Windows Agent Mappings 2/0S Agent Mappings.
0 Linux/Unix Agent Mappings =
Target Agent Source Agent

[F] stonsbranch-inuxunixagent-03

Step 6 Click the Details icon next to a Target Agent name to display Agent Mapping Details for that Target Agent.

LinuxiUnix Agent Mapping Details =[E][*
[E] Update ff] Delete 1% Refresh 3 Close

Linux/Unix Agent Wapping

Promotion Target: stonebranch-linuxunix-01 D
Target Agent: stonebranch-linuxunixagent-01

Type . Linux/Unix

a

No items to show. —
L_J
Source Agent lj_%

@

v

[E] update ] Delete 5| Refresh 3 Close
Step 7  Click the Add-Remove Multiple icon next to the Source field to display a list of all Agents on the source machine.
LinuxiUnix Agent Mapping Details =[x

[E] Update (i) Delete [[% Refresh 3% Close

Linux/Unix Agent Wapping

Promotion Target: stonebranch-linuxunix-01 D
Target Agent: stonebranch-linuxunixagent-01

Type . Linux/Unix
No items to show.

Source Agent

© FEm

[E] update ] Delete 5| Refresh 3 Close

Step 8 Select the source machine Agent(s) that you want mapped to the selected target machine Agent, and then click Save.
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Step 9 Repeat Steps 6 to 8 for every Target Agent under all Agent Mappings tab(s) for which there are Agents listed.

Promote the Bundle
In this procedure, we will promote the Bundle that you created to the selected Promotion Target machine.
Step 1 On the Bundles list, right-click the Bundle to be promoted and click Promote Bundle... on the Action menu to display a Promote Bundle... pop-up dialog.
Promote Bundle...

Promaotion Target : | stonebranch-promotiontarget-01
Override User/Password :

User: ops.admin

Password: essssssss

Allow Universal Template Changes : [7]

Schedule . [

Submit Cancel

Step 2  Click Submit. The source machine Controller logs in to the target machine specified in the URI field of the Promotion Target record and copies the bundled records to the target machine Controller. Based on the
specified Agent mapping, the target Agent replaces the source Agent where required.

e
For additional information, see:

® Bundles and Promotion
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Tutorial - Scheduling the Promotion of a Bundle

In this exercise, we will select a date and time for the automatic promotion of the Bundle that was created in the Creating and Promoting a Bundle tutorial.

Schedule a Bundle Promotion
In this procedure, we will schedule the promotion of a Bundle to a target machine.
Step 1  Fromthe Bundles & Promotion navigation pane, select Bundles. The Bundles list displays.
Step 2 Right-click the Bundle to be scheduled for promotion and click Promote Bundle... on the Action menu to display a Promote Bundle... pop-up dialog.

Promote Bundle...

Promotion Target : | stonebranch-promotiontarget-01
Override User/Password :

User: ops.admin

Password: essssssss

Allow Universal Template Changes : [7]

Schedule . [

Submit Cancel
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Step 3

Promote Bundle...

Promotion Target :

Override User/Password :

User:

Password :

Allow Universal Template Changes :
Schedule :

Date :

Time :

Create Snapshot :

System Notification :

Step 4  Selecta Date and Time for the promotion.

Step 5

stonebranch-promotiontarget-01
ops.admin

]
2017

v [|[May |w |30

Hour Win
T w |00 |w

]

Operation Failure

Submit

Click the Schedule field check box to display additional fields for specifying a promotion schedule.

Click the Submit button. The Bundle is listed on the Promotions Schedules list and will be promoted automatically at the scheduled date and time.

Dashboards [1] ‘ Prometion Schedules [ ‘
¥ 2 Promotion Schedules
Bundle

pundie 01
pundie 02

Promotion Target Status

02 Scheduled

v Promotion Schedule Details

Custom Filter — Mone —

Status Description

01 Cancelled Scheduled promotion cancelled by user "ops.admin”.

~| @ Filter
Scheduled Time Use Snapshot
2015-05-23 00:00:00 -0400 Yes
2015-05-24 00:00:00 -0400 No

&
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S
For additional information, see:

® Bundles and Promotion
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